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1. Training Salient: 
Entry Requirements Minimum Qualification: Middle 

Prerequisite: Basic Computer Literacy 
Total Training Hours 45 Hours 
Training Methodology Theory: 9 Hours (20%) 

Practical: 36 Hours (80%) 
Medium of Instruction & Assessment English, Urdu, & Pushto 

 
2. Training Objectives: 
Upon completion, trainees will be able to: 

• Use essential Microsoft Office applications (Word, Excel, PowerPoint). 
• Handle email communication and internet browsing professionally. 
• Manage files, folders, PDF, printing, scanning, and media files. 
• Conduct virtual meetings using tools like Zoom, Microsoft Teams, and Google Meet. 
• Format documents, analyze data in Excel, and prepare presentations. 
• Perform basic database operations using MS Access. 

 
3. Training Learning Outcomes (TLOs): 

• TLO 1: Use essential Microsoft Office applications (Word, Excel, PowerPoint) and 
handle email communication professionally. 

• TLO 2: Conduct virtual meetings using tools like Zoom, Microsoft Teams, and Google 
Meet. 

 
4. Job Opportunities: 
After completing the training, trainees can pursue roles such as: 

• Office Assistant / IT Assistant 
• Data Entry Operator 
• Front Desk Officer / Admin Support 
• Computer Operator 
• Virtual Assistant 
• Customer Support Executive 
• Documentation Assistant 
• Online Freelancer (Upwork, Fiverr) 

 
5. Training Materials / Resources: 
Category Items 
Consumables - A4 paper, folders, USBs, printed 

handouts, stationary 
Non-Consumables - Desktop PCs/Laptops with MS Office, 

Zoom, Google Chrome, Google Meet, 
Microsoft Teams  

- High-resolution projector & screen 
- Whiteboard & markers 
- Internet access (Wi-Fi) 
- Printer, scanner 
- Evaluation setup 

 
 
  



6. Training Curriculum / Schedule: 

Sr. 
No. Training Module Learning Units 

Theory/ 
Practical 

(Hrs) 
1 M 1.1:  

Health & Safety  
 
Objective: Develop 
awareness and 
practices to 
ensure personal 
and workplace 
safety, recognize 
hazards, and 
respond effectively 
to emergencies. 

LU 1.1.1: Introduction to Safety 
 
Learning Objectives 
Trainee will be able to: 

• Explain why safety is important in every 
environment, including training rooms and 
workplaces. 

• Recognize that safety is a shared 
responsibility of everyone. 

• Follow safety instructions, signs, and rules 
effectively. 

 
Knowledge / Content 
Safety is about preventing accidents before they 
happen. In a training room, this means ensuring 
that simple practices—like keeping cables 
untangled, not eating or drinking near laptops, and 
using equipment properly—help avoid major risks. 
Safety is not just physical but also digital. Just as 
helmets protect motorcyclists, strong passwords, 
and safe browsing protect digital environments. 
Key messages to emphasize: 

• Why Safety Matters: Protects people, 
equipment, time, and builds confidence. 

• Shared Responsibility: Everyone, not just 
the trainer, must stay alert and proactive. 

• Rules & Instructions: Signs, rules, and 
trainer guidance exist to prevent harm. 

 
Skills / Practical Tasks 

• Activity 1 (Observation Walk): Trainees walk 
around the room and identify at least 3 
safety risks (e.g., loose wires, spilled water, 
overloaded sockets). 

• Activity 2 (Discussion): Each trainee shares 
one unsafe practice they have seen and 
describes its possible consequences. 

• Activity 3 (Digital Safety Demo): Show a 
phishing email or suspicious link and ask 
trainees to point out warning signs. 

 
Trainer’s Notes 

• Start with an icebreaker: “What is the most 
dangerous accident you’ve ever seen at 
school, work, or home?” 

• Show visuals: compare a messy desk vs. an 
organized desk. 

• Reinforce the core message: “Safety = 
Prevention.” 

• Make a clear analogy: physical helmets = 
digital strong passwords. 

1 Hr 
(Th/Pr) 

 



• Encourage trainees to take initiative—
remind them safety is everyone’s duty. 

 
Assessment Criteria 

• Trainee can define safety in their own 
words. 

• Trainee identifies at least 2 unsafe 
practices in the classroom. 

• Trainee explains why safety is important in 
both physical and digital environments. 
 

LU 1.1.2: Personal Safety Practices 
 
Learning Objectives 
Trainee will be able to: 

• Describe the importance of personal 
hygiene and cleanliness in a workplace or 
training setting. 

• Identify appropriate clothing and protective 
items required for safe participation. 

• Demonstrate how to maintain a clean, 
organized, and safe workspace. 

 
Knowledge / Content 
Personal safety practices are the foundation of 
workplace readiness. They protect not only the 
individual but also others around them. Trainers 
should stress that being mindful of clothing, 
hygiene, and workspace cleanliness reduces risks 
and increases productivity. 
Key principles include: 

• Clothing & Protective Gear: Wear suitable 
clothes (e.g., avoid loose sleeves near 
machines, use protective glasses if 
needed). 

• Personal Hygiene: Good hygiene prevents 
illness and maintains a professional 
environment. 

• Workspace Cleanliness: An organized desk 
reduces accidents, keeps equipment safe, 
and supports efficiency. 

 
Skills / Practical Tasks 

• Activity 1 (Demonstration): Trainer 
demonstrates correct sitting posture at the 
workstation (chair height, screen distance, 
wrist angle). Trainees practice adjusting 
their setup. 

• Activity 2 (Group Checklist): In groups, 
trainees create a checklist of personal 
safety habits (e.g., washing hands, keeping 
water bottles away from laptops, not 
cluttering desks). 

• Activity 3 (Case Review): Show photos of 
safe vs. unsafe clothing/equipment and ask 
trainees to identify the differences. 



Trainer’s Notes 
• Link personal safety to professional image: 

clean, organized trainees are more 
confident and respected. 

• Use visual aids: posters showing “Do’s and 
Don’ts” for clothing and hygiene. 

• Encourage trainees to remind each other—
peer responsibility builds safer habits. 

• Highlight real-life examples: how ignoring 
simple safety practices led to accidents or 
health issues. 

 
Assessment Criteria 

• Trainee lists at least 3 personal safety 
practices. 

• Trainee explains why clothing and hygiene 
matter in a training/workplace 
environment. 

• Trainee demonstrates correct workstation 
posture and desk setup. 

 
LU 1.1.3: Hazard Awareness 
 
Learning Objectives 
Trainee will be able to: 

• Define what a hazard is in workplace and 
training environments. 

• Identify common hazards such as slips, 
trips, electrical risks, tools, and stress. 

• Demonstrate how to report unsafe 
conditions immediately. 

 
Knowledge / Content 
A hazard is anything with the potential to cause 
harm — whether to people, equipment, or the 
environment. Trainers should stress that 
recognizing hazards early prevents accidents and 
costly mistakes. 
Types of hazards to highlight: 

• Physical Hazards: Slips, trips, falls, sharp 
edges, exposed wires. 

• Electrical Hazards: Overloaded sockets, 
damaged cables, wet areas near 
equipment. 

• Tool Hazards: Misuse of design tools (e.g., 
paper cutters, printers). 

• Ergonomic Hazards: Poor posture, 
prolonged sitting, eye strain. 

• Psychological Hazards: Stress, fatigue, or 
lack of attention. 

Reporting hazards is not about blame — it is about 
prevention. Encourage trainees to immediately 
inform the trainer/supervisor when they notice 
unsafe conditions. 
 
 



Skills / Practical Tasks 
• Activity 1 (Hazard Hunt): Divide trainees into 

pairs. Ask them to identify at least 3 
hazards in the training room and suggest 
solutions. 

• Activity 2 (Case Study): Present a short 
accident scenario (e.g., a spill near a 
socket). Ask: What went wrong? How could 
it have been avoided? 

• Activity 3 (Stress Awareness): Lead a short 
discussion on how mental stress can also 
be a hazard (e.g., rushing through tasks 
leads to mistakes). 

 
Trainer’s Notes 

• Reinforce that hazards are not always 
obvious — sometimes they are hidden or 
develop slowly (like eye strain). 

• Use real-life examples from workplaces 
(e.g., stories of accidents caused by ignored 
hazards). 

• Encourage a “See something, say 
something” culture. 

• Remind trainees that hazard awareness 
applies both in physical spaces and digital 
workspaces (e.g., downloading unsafe files 
is also a hazard). 

 
Assessment Criteria 

• Trainee can define a hazard in their own 
words. 

• Trainee identifies at least 3 different 
hazards from a list or real environment. 

• Trainee explains the importance of 
reporting hazards promptly. 

 
LU 1.1.4: Emergency Preparedness 
 
Learning Objectives 
Trainee will be able to: 

• Explain the importance of staying calm 
during emergencies. 

• Identify exits, safe areas, and emergency 
equipment in the training environment. 

• Follow trainer/supervisor guidance during 
emergencies. 

• Demonstrate basic response steps in case 
of fire, electrical failure, or other incidents. 

 
Knowledge / Content 
Emergencies are unexpected situations that 
require quick, organized responses to minimize 
harm. Preparedness means knowing what to do 
before an emergency happens. 
Key areas to emphasize: 



• Stay Calm: Panic causes confusion and 
increases risks. 

• Know Escape Routes: Always be aware of 
nearest exits and assembly points. 

• Emergency Equipment: Fire extinguishers, 
alarms, and first-aid kits should be located 
and understood. 

• Follow Guidance: Always follow the 
instructions of trainers or supervisors who 
are responsible for leading evacuation. 

• Types of Emergencies: Fire, power failure, 
natural disasters, medical emergencies, 
digital security breaches. 

 
Skills / Practical Tasks 

• Activity 1 (Evacuation Drill): Conduct a mock 
drill where trainees practice leaving the 
room quickly, calmly, and assembling at a 
safe point. 

• Activity 2 (Equipment Familiarization): 
Show trainees where the fire extinguisher, 
alarm, and first-aid kit are located. Explain 
their basic use. 

• Activity 3 (Scenario Role-Play): Present a 
scenario (e.g., sudden blackout or a laptop 
catching fire). Trainees discuss step-by-
step how they would respond. 

 
Trainer’s Notes 

• Keep a floor map handy with exits and safe 
areas clearly marked. 

• Reinforce that preparedness is about 
prevention and practice, not panic. 

• Use real stories of workplace emergencies 
to highlight the importance of readiness. 

• Involve trainees actively — let them lead 
parts of the drill to build confidence. 

• Connect digital emergencies (e.g., 
cyberattacks) with physical emergencies — 
both require calm and planned responses. 

 
Assessment Criteria 

• Trainee identifies at least 2 exit routes or 
safe areas in the training facility. 

• Trainee demonstrates knowledge of 
emergency equipment location and 
purpose. 

• Trainee explains why calmness and 
following instructions are critical in 
emergencies. 

LU 1.1.5: Basic First Aid Awareness 
 
Learning Objectives 
Trainee will be able to: 

• Identify the location and importance of the 
first aid kit in the training environment. 



• Provide simple care for minor injuries such 
as cuts, burns, or sprains. 

• Recognize when and how to seek 
professional medical help. 

 
Knowledge / Content 
First aid is the immediate care given to someone 
who is injured or suddenly ill before professional 
medical help is available. Trainers should 
emphasize that basic awareness saves lives and 
prevents minor injuries from becoming serious. 
Key points to cover: 

• First Aid Kit: Location, contents, and basic 
uses (e.g., bandages, antiseptic, scissors, 
gloves). 

• Minor Injuries: Cleaning and covering small 
cuts, treating minor burns with cool water, 
resting sprained joints. 

• When to Seek Help: For major injuries, 
breathing difficulties, unconsciousness, or 
heavy bleeding, call emergency services 
immediately. 

• Personal Safety: Always protect yourself 
(e.g., wear gloves) before helping others. 

 
Skills / Practical Tasks 

• Activity 1 (Kit Familiarization): Show 
trainees the actual first aid kit, explain each 
item, and its use. 

• Activity 2 (Role-Play): Simulate a minor cut 
or burn and let trainees practice the steps: 
clean, cover, and comfort. 

• Activity 3 (Decision-Making Game): Give 
different scenarios (e.g., nosebleed, 
fainting, deep cut) and ask trainees 
whether to treat onsite or call for medical 
help. 

 
Trainer’s Notes 

• Keep demonstrations simple and safe — 
avoid complex medical techniques. 

• Stress that trainees are not doctors: their 
role is to provide temporary, safe care until 
help arrives. 

• Use visuals, props, or even sample first aid 
kits for practical engagement. 

• Remind trainees about digital first aid too 
— e.g., how to react when encountering 
malware or phishing (disconnect, report, 
seek expert help). 

• Encourage calmness and teamwork in 
emergencies. 

 
Assessment Criteria 

• Trainee can identify at least 3 items in a 
first aid kit and their uses. 



• Trainee demonstrates the correct
procedure for treating a minor cut or burn.

• Trainee explains when professional
medical help must be called.

M 1.2:  
Computer & Digital 
Essentials 

Objective: Gain 
essential digital 
literacy by 
learning the basics 
of computers, file 
and folder 
management, 
cloud storage, and 
using common 
devices like 
printers and 
scanners. 

LU 1.2.1: Introduction to Computers & Peripherals 

Learning Objectives 
Trainee will be able to: 

• Define a computer and explain its basic
functions.

• Identify different types of computers
(desktop, laptop, tablet).

• Recognize common peripherals and their
purposes.

• Understand the role of computers in office
and professional environments.

Knowledge / Content 
• Introduction to Computers:

o Definition: Electronic devices that
process data into information.

o Functions: Input, process, output,
and storage.

o Types: Desktop, laptop, tablet,
server, mainframe.

• Computer Components:
o Hardware: CPU, RAM, motherboard,

storage devices.
o Software: System software (OS),

application software (office apps,
browsers).

• Peripherals:
o Input Devices: Keyboard, mouse,

scanner, webcam.
o Output Devices: Monitor, printer,

speakers.
o Storage & Other Devices: USB

drives, external HDD, network
devices.

• Computer Use in Offices:
o Data management, documentation,

communication, presentations,
online research.

Skills / Practical Tasks 
• Activity 1 (Icebreaker): Identify all parts of a

desktop/laptop in the classroom.
• Activity 2 (Hands-On): Connect and test

peripherals like printer, scanner, and USB
drives.

• Activity 3 (Discussion): Trainees explain
scenarios where each peripheral is used in
daily office work.

2 Hrs (Th) 
6 Hrs (Pr) 



Trainer’s Notes 
• Use actual devices for demonstration 

whenever possible. 
• Relate peripherals to practical office tasks 

(e.g., scanning documents, printing 
reports). 

• Highlight the difference between input and 
output devices. 

• Encourage trainees to ask questions about 
unfamiliar components. 

 
Assessment Criteria 

• Trainee identifies at least 3 types of 
computers. 

• Trainee lists at least 5 common peripherals 
with their functions. 

• Trainee demonstrates basic connection and 
use of at least 2 peripherals. 

 
LU 1.2.2: Folder Management, File Formats, PDF, 
ZIP, Cloud Storage (Google Drive/ OneDrive) 
 
Learning Objectives 
Trainee will be able to: 

• Understand folder and file organization 
principles. 

• Identify common file formats and their uses 
(e.g., DOCX, XLSX, PDF, JPG, PNG, ZIP). 

• Learn how to compress files into ZIP 
format. 

• Understand the basics of cloud storage and 
use Google Drive / OneDrive for file 
management. 

 
Knowledge / Content 

• Folder & File Management: 
o Creating, renaming, moving, and 

deleting folders and files. 
o Best practices: hierarchical 

structure, descriptive file names, 
version control. 

• Common File Formats: 
o Document: DOCX, TXT, PDF. 
o Spreadsheet: XLSX, CSV. 
o Image: JPG, PNG, GIF. 
o Compressed: ZIP, RAR. 

• PDF & ZIP Files: 
o PDF: Read-only format for 

documents, ensures consistent 
layout. 

o ZIP: Compression format to combine 
multiple files and reduce size. 

• Cloud Storage: 
o Google Drive / OneDrive: Upload, 

download, share, and collaborate on 
files. 



o Access from multiple devices and 
platforms. 

o Setting permissions (view, edit, 
comment). 

 
Skills / Practical Tasks 

• Activity 1: Create a folder structure for a 
mock office project. 

• Activity 2: Save documents in different file 
formats (DOCX, PDF, XLSX). 

• Activity 3: Compress files into a ZIP folder 
and extract them. 

• Activity 4: Upload files to Google Drive / 
OneDrive, share with peers, and set 
permissions. 

 
Trainer’s Notes 

• Emphasize consistent and logical folder 
naming conventions. 

• Demonstrate converting documents to PDF 
and compressing multiple files. 

• Show cloud storage features like sharing 
links and access levels. 

• Encourage trainees to practice uploading 
and organizing files in cloud storage. 

 
Assessment Criteria 

• Trainee creates organized folder structures 
with descriptive names. 

• Trainee identifies at least 5 common file 
formats and their uses. 

• Trainee successfully compresses files into 
ZIP and extracts them. 

• Trainee uploads and shares files in Google 
Drive / OneDrive with correct permissions. 

 
LU 1.2.3: Printer, Scanner, Screenshot 
 
Learning Objectives 
Trainee will be able to: 

• Understand the basic functions of printers 
and scanners. 

• Learn how to operate a printer and scanner 
in an office environment. 

• Capture screenshots and use them in 
documents and presentations. 

• Recognize practical use cases for printing, 
scanning, and screenshots. 

 
Knowledge / Content 

• Printers: 
o Types: Inkjet, Laser, All-in-One. 
o Functions: Printing documents, 

photos, double-sided printing. 
o Maintenance basics: replacing 

ink/toner, clearing paper jams. 



• Scanners: 
o Types: Flatbed, sheet-fed, 

multifunction devices. 
o Scanning formats: PDF, JPG, PNG. 
o Adjusting resolution and settings for 

different purposes. 
• Screenshots: 

o Capturing full screen, active 
window, or selected area. 

o Using built-in tools (Snipping Tool, 
Print Screen, Snip & Sketch). 

o Practical applications: 
documentation, presentations, 
troubleshooting, emails. 

 
Skills / Practical Tasks 

• Activity 1: Print a sample document and 
adjust print settings (size, orientation, 
pages). 

• Activity 2: Scan a document or image and 
save it in PDF/JPG format. 

• Activity 3: Capture screenshots of different 
areas on the computer screen and paste 
them into a Word document. 

• Activity 4: Practice combining scanned files 
and screenshots into a single document for 
sharing. 

 
Trainer’s Notes 

• Demonstrate printer and scanner 
operations step by step. 

• Encourage trainees to check 
printer/scanner connections and settings 
before use. 

• Show shortcuts for quick screenshots. 
• Highlight common troubleshooting tips 

(paper jams, low ink, scanning errors). 
 
Assessment Criteria 

• Trainee prints a document correctly with 
desired settings. 

• Trainee scans a document and saves it in 
correct format. 

• Trainee captures and inserts screenshots 
into a document accurately. 

• Trainee demonstrates proper handling of 
printer and scanner equipment. 

Capstone Task: Create a well-organized folder system, perform ZIP, scan & print 
tasks 
 
Learning Objectives 
Trainee will be able to: 

• Apply folder and file management skills to organize office data efficiently. 
• Use compression (ZIP) to bundle multiple files. 
• Demonstrate proper use of office peripherals: scanner and printer. 
• Integrate screenshots and scanned documents into organized digital files. 



Knowledge / Content 
• Folder & File Organization: 

o Structuring folders for projects, clients, or departments. 
o Naming conventions for easy retrieval. 

• ZIP Files: 
o Creating and extracting compressed folders. 
o Reducing file size for sharing or storage. 

• Scanner & Printer Use: 
o Scanning documents to PDF or image files. 
o Printing documents with correct layout and settings. 

• Screenshots: 
o Capturing and saving screen content for documentation. 
o Combining screenshots and scanned files in a single document. 

 
Skills / Practical Tasks 

• Activity 1: Create a complete folder structure for a mock office project with 
subfolders. 

• Activity 2: Save files in multiple formats (PDF, DOCX, XLSX) and compress 
them into a ZIP folder. 

• Activity 3: Scan documents and images, organize them into folders. 
• Activity 4: Print selected documents with correct settings and orientation. 
• Activity 5: Capture screenshots and integrate them with scanned files into a 

report or project folder. 
 
Trainer’s Notes 

• Monitor trainees to ensure folder naming is logical and consistent. 
• Demonstrate scanning, printing, and ZIP processes before learners attempt 

them. 
• Encourage attention to detail when combining files for the final project. 
• Highlight common errors: wrong print orientation, ZIP extraction issues, 

disorganized folder placement. 
 
Assessment Criteria 

• Trainee creates a fully organized folder system. 
• Trainee successfully compresses and extracts files using ZIP. 
• Trainee scans and prints documents correctly. 
• Trainee captures and integrates screenshots effectively into documents. 
• Overall project demonstrates attention to detail, organization, and practical 

application of skills. 
2 M 2:  

Operating 
Systems, Email & 
Internet 
 
Objective: Develop 
the ability to 
install and 
configure 
operating 
systems, manage 
user accounts and 
security, and 
effectively use 
email, browsers, 
and online tools. 

LU 2.1: Install OS & Drivers 
 
Learning Objectives 
Trainee will be able to: 

• Understand the purpose of an operating 
system (OS) and device drivers. 

• Learn the process of installing a Windows 
OS (or other office-standard OS). 

• Install necessary drivers for hardware 
components and peripherals. 

• Ensure the system is ready for office tasks 
with functional hardware and software. 

 
Knowledge / Content 

• Operating System (OS): 

1 Hr (Th) 
7 Hrs (Pr) 



o Definition and role: managing 
hardware, software, and user 
interactions. 

o Examples: Windows 10/11, Linux, 
macOS. 

o Basic OS setup and configuration: 
region, language, user accounts. 

• Device Drivers: 
o Definition: software that allows 

hardware to communicate with OS. 
o Types: printer, scanner, graphics, 

audio, network drivers. 
o Installation methods: manual, 

automatic via OS, manufacturer 
software. 

• System Readiness: 
o Checking hardware compatibility 

before installation. 
o Updating OS and drivers after 

installation. 
o Troubleshooting common 

installation issues. 
 
Skills / Practical Tasks 

• Activity 1: Boot a PC from installation media 
and perform OS installation. 

• Activity 2: Configure basic OS settings (time 
zone, language, user accounts). 

• Activity 3: Identify missing drivers and 
install them manually or using auto-update 
tools. 

• Activity 4: Test hardware functionality after 
driver installation (keyboard, mouse, 
printer, network). 

 
Trainer’s Notes 

• Demonstrate OS installation in a controlled 
environment first. 

• Stress importance of backing up data 
before installation. 

• Highlight differences between automatic 
and manual driver installation. 

• Encourage learners to troubleshoot errors 
with guided support. 

 
Assessment Criteria 

• Trainee successfully installs the OS on a 
test machine. 

• Trainee installs essential hardware drivers 
correctly. 

• Trainee configures basic OS settings 
appropriately. 

• Trainee verifies hardware functionality after 
installation. 
 
 



LU 2.2: Create User Accounts & Configure Defender 
 
Learning Objectives 
Trainee will be able to: 

• Understand the importance of user 
accounts and permissions in an office 
environment. 

• Learn to create and manage multiple user 
accounts on Windows OS. 

• Configure Windows Defender (or equivalent 
antivirus) to protect the system. 

• Implement basic security measures for 
safe computing. 

 
Knowledge / Content 

• User Accounts: 
o Types: Administrator, Standard, 

Guest. 
o Purpose: controlling access, 

protecting data, and maintaining 
system integrity. 

o User account management: create, 
modify, delete, password settings. 

• Windows Defender / Antivirus: 
o Role: real-time protection against 

malware, spyware, and viruses. 
o Basic settings: scanning schedules, 

exclusions, updates. 
o Monitoring security reports and 

resolving threats. 
• Office Security Practices: 

o Strong passwords and multi-factor 
authentication. 

o Avoiding suspicious downloads and 
email attachments. 

o Regular system updates for OS and 
software. 

 
Skills / Practical Tasks 

• Activity 1: Create multiple user accounts 
with different access levels. 

• Activity 2: Set or reset passwords for user 
accounts. 

• Activity 3: Configure Windows Defender 
settings (full scan, real-time protection, 
scheduled scan). 

• Activity 4: Simulate resolving a detected 
threat or malware warning. 

 
Trainer’s Notes 

• Explain why different account types are 
important for office security. 

• Demonstrate Windows Defender features 
step by step. 

• Emphasize safe computing habits alongside 
technical skills. 



• Encourage trainees to explore account 
settings and security dashboards. 

 
Assessment Criteria 

• Trainee creates and configures user 
accounts correctly. 

• Trainee sets secure passwords and 
understands account permissions. 

• Trainee configures Windows Defender with 
appropriate settings. 

• Trainee demonstrates awareness of basic 
security best practices. 

 
LU 2.3: Email, Browsing & Downloads, Knowledge 
of other Email Clients 
 
Learning Objectives 
Trainee will be able to: 

• Understand the basics of email 
communication and etiquette. 

• Learn to set up, send, receive, and manage 
emails. 

• Use web browsers efficiently for research 
and office tasks. 

• Download files safely and manage 
downloaded content. 

• Gain awareness of alternative email clients 
and their features (e.g., Outlook, 
Thunderbird, Gmail). 

 
Knowledge / Content 

• Email Basics: 
o Components: Inbox, Sent, Drafts, CC, 

BCC, Attachments. 
o Composing professional emails: 

subject line, body, signature, 
attachments. 

o Email etiquette: clarity, conciseness, 
polite language. 

• Web Browsing: 
o Popular browsers: Chrome, Edge, 

Firefox. 
o Search engines and effective search 

techniques. 
o Bookmarking, history, and managing 

tabs. 
• Downloads: 

o Safe download practices: verifying 
sources, file types. 

o Organizing downloaded files in 
folders. 

• Other Email Clients: 
o Microsoft Outlook: integration with 

calendars, tasks, contacts. 
o Mozilla Thunderbird: open-source 

features and add-ons. 



o Gmail Web & App: labels, filters, and 
priority inbox. 

 
Skills / Practical Tasks 

• Activity 1: Compose and send a professional 
email with CC/BCC and attachment. 

• Activity 2: Search for a topic online using 
advanced search operators. 

• Activity 3: Download a file safely, verify it, 
and save in an organized folder. 

• Activity 4: Explore basic features of another 
email client (e.g., Outlook or Thunderbird) 
and send a test email. 

 
Trainer’s Notes 

• Emphasize clarity, conciseness, and 
professionalism in email communication. 

• Demonstrate safe browsing and 
downloading practices to avoid malware. 

• Compare different email clients, 
highlighting pros and cons. 

• Encourage trainees to explore features like 
filters, labels, and calendar integration. 

 
Assessment Criteria 

• Trainee composes and sends an email 
following professional etiquette. 

• Trainee demonstrates effective browsing 
and safe downloading. 

• Trainee organizes downloaded files 
appropriately. 

• Trainee shows basic knowledge of at least 
one alternative email client. 

Capstone Task: Install OS from USB, configure peripheral devices, internet & email 
setup 
 
Learning Objectives 
Trainee will be able to: 

• Apply OS installation and configuration skills on a test machine. 
• Connect and configure peripheral devices (printer, scanner, USB devices). 
• Set up internet access, email accounts, and basic office applications. 
• Ensure a fully functional workstation ready for office tasks. 

 
Knowledge / Content 

• OS Installation & Setup: 
o Booting from USB or installation media. 
o Configuring system settings: language, region, time, user accounts. 
o Installing essential drivers and updates. 

• Peripheral Devices: 
o Connecting and testing printer, scanner, and other devices. 
o Ensuring correct driver installation for hardware functionality. 

• Internet & Email Setup: 
o Configuring network settings and Wi-Fi connectivity. 
o Setting up email accounts (Gmail, Outlook, or other clients). 
o Testing sending/receiving emails and attaching files. 

 



Skills / Practical Tasks 
• Activity 1: Install OS on a test PC and configure basic settings. 
• Activity 2: Install drivers for connected peripherals and verify functionality. 
• Activity 3: Set up an internet connection and test access to websites. 
• Activity 4: Configure an email account and send a test email with attachment. 
• Activity 5: Verify workstation readiness for office productivity tasks. 

 
Trainer’s Notes 

• Ensure trainees follow step-by-step procedures and take notes during the 
process. 

• Emphasize the importance of checking hardware compatibility before OS 
installation. 

• Highlight troubleshooting tips for network, driver, and email setup issues. 
• Encourage trainees to simulate real-world office setup scenarios. 

 
Assessment Criteria 

• Trainee installs OS and configures system settings successfully. 
• Trainee connects and verifies peripheral devices correctly. 
• Trainee sets up internet access and email account accurately. 
• Workstation is fully functional and ready for office tasks. 
• Trainee demonstrates understanding of setup process and troubleshooting 

basics. 
3 M 3:  

MS Word & 
Document 
Processing, 
Google Docs 
 
Objective: Acquire 
skills to create, 
edit, format, and 
secure 
professional 
documents using 
MS Word and 
Google Docs, 
including tables, 
references, and 
page setup. 

LU 3.1: Word Navigation, Editing, Formatting 
 
Learning Objectives 
Trainee will be able to: 

• Navigate Microsoft Word interface 
effectively. 

• Perform basic editing tasks including cut, 
copy, paste, undo/redo. 

• Apply formatting to text, paragraphs, and 
documents for professional presentation. 

• Use styles, bullets, numbering, and 
alignment features for structured 
documents. 

 
Knowledge / Content 

• Word Interface Overview: 
o Ribbon, tabs, groups, and Quick 

Access Toolbar. 
o Document window, status bar, and 

navigation pane. 
• Editing Tools: 

o Cut, Copy, Paste, Undo, Redo. 
o Find & Replace, Select All, Spell 

Check. 
• Formatting Tools: 

o Font types, sizes, styles (bold, italic, 
underline). 

o Paragraph alignment, line spacing, 
indentation. 

o Bullets, numbering, and lists. 
o Using headers, footers, page 

numbers. 
• Best Practices: 

1 Hr (Th) 
7 Hrs (Pr) 



o Consistency in formatting for 
professional documents. 

o Using styles for headings and 
subheadings. 

 
Skills / Practical Tasks 

• Activity 1: Open a sample document and 
navigate through tabs and menus. 

• Activity 2: Edit text using cut, copy, paste, 
undo, and redo. 

• Activity 3: Format a document with different 
fonts, styles, and paragraph alignment. 

• Activity 4: Apply bullets, numbering, and 
headings to organize content. 

• Activity 5: Insert headers, footers, and page 
numbers. 

 
Trainer’s Notes 

• Demonstrate each feature step by step on 
projector/screen. 

• Encourage trainees to practice shortcuts 
for efficiency. 

• Emphasize clarity and readability in 
formatting. 

• Highlight common mistakes like 
inconsistent font usage or misaligned 
paragraphs. 

 
Assessment Criteria 

• Trainee navigates Word interface 
confidently. 

• Trainee edits and formats text accurately. 
• Trainee applies bullets, numbering, and 

headings correctly. 
• Document demonstrates professional 

formatting and consistency. 
 
LU 3.2: Tables, Sections, References 
 
Learning Objectives 
Trainee will be able to: 

• Create and format tables to organize data 
in Word documents. 

• Use sections to manage page layouts and 
different formatting styles. 

• Insert and manage references such as 
footnotes, endnotes, captions, and citations. 

• Apply these tools to produce professional, 
structured documents. 

 
Knowledge / Content 

• Tables in Word: 
o Creating tables: Insert Table, Draw 

Table, Quick Tables. 
o Formatting tables: borders, shading, 

alignment, and cell merging. 



o Sorting and calculating data in 
tables. 

• Sections: 
o Purpose: Different page layouts in 

the same document. 
o Section breaks: Next Page, 

Continuous, Odd/Even Page. 
o Applying headers/footers to specific 

sections. 
• References: 

o Footnotes and Endnotes: Purpose 
and insertion. 

o Captions for images, charts, and 
tables. 

o Citations and Bibliography using 
Word reference tools. 

 
Skills / Practical Tasks 

• Activity 1: Create a table for sample data 
and format it professionally. 

• Activity 2: Insert section breaks to apply 
different layouts to parts of a document. 

• Activity 3: Add headers and footers to 
specific sections. 

• Activity 4: Insert footnotes, endnotes, and 
captions in a sample report. 

• Activity 5: Add citations and generate a 
bibliography using Word reference tools. 

 
Trainer’s Notes 

• Demonstrate each feature using real-world 
examples such as reports, proposals, or 
invoices. 

• Emphasize the importance of organized 
tables and consistent references. 

• Encourage trainees to experiment with 
table designs and section layouts. 

• Highlight shortcuts for inserting references 
and formatting tables efficiently. 

 
Assessment Criteria 

• Trainee creates and formats tables 
correctly. 

• Trainee applies section breaks and 
manages headers/footers accurately. 

• Trainee inserts footnotes, endnotes, 
captions, and citations correctly. 

• Document is structured professionally and 
demonstrates proper use of tables, 
sections, and references. 

 
 
 
 
 
 



LU 3.3: Page Setup, Security 
 
Learning Objectives 
Trainee will be able to: 

• Configure page setup options including 
margins, orientation, size, and layout. 

• Apply headers, footers, and page 
numbering appropriately. 

• Understand document security features in 
Word and PDF. 

• Protect documents with passwords and 
restrict editing for professional use. 

 
Knowledge / Content 

• Page Setup: 
o Adjusting margins, orientation 

(portrait/landscape), and paper size. 
o Setting page breaks and line 

spacing. 
o Using multiple columns and layout 

options for reports and newsletters. 
• Headers, Footers, and Page Numbers: 

o Inserting and formatting 
headers/footers. 

o Adding page numbers, document 
titles, or dates. 

o Applying different headers/footers 
to sections. 

• Document Security: 
o Password-protecting Word and PDF 

documents. 
o Restricting editing or formatting 

changes. 
o Understanding permissions and 

read-only options. 
 
Skills / Practical Tasks 

• Activity 1: Configure a sample document 
with specific page setup requirements. 

• Activity 2: Insert and customize headers, 
footers, and page numbers. 

• Activity 3: Apply password protection and 
restrict editing in a Word document. 

• Activity 4: Save a Word document as a PDF 
and apply security options. 

 
Trainer’s Notes 

• Demonstrate page setup differences for 
reports, letters, and presentations. 

• Explain why document security is important 
in office environments. 

• Encourage trainees to experiment with 
headers/footers for multi-section 
documents. 

• Highlight best practices for strong 
passwords and restricted permissions. 



Assessment Criteria 
• Trainee configures page setup accurately 

for given requirements. 
• Trainee inserts headers, footers, and page 

numbers correctly. 
• Trainee applies password protection and 

editing restrictions effectively. 
• Document security and layout are 

maintained in both Word and PDF formats. 
Capstone Task: Prepare a formatted, printable multi-page official document 
 
Learning Objectives 
Trainee will be able to: 

• Apply advanced Word skills to create a professional, multi-page document. 
• Format pages with proper margins, orientation, headers, footers, and page 

numbers. 
• Insert tables, sections, references, and images as needed. 
• Apply document security features to protect content from unauthorized 

editing or access. 
 
Knowledge / Content 

• Multi-Page Document Preparation: 
o Page setup: margins, orientation, size, columns. 
o Organizing content with sections and page breaks. 
o Formatting consistency across multiple pages. 

• Document Security: 
o Password protection and read-only permissions. 
o Saving documents securely as Word or PDF. 
o Ensuring sensitive information is protected before sharing. 

• Professional Presentation: 
o Proper use of tables, references, and headers/footers for formal 

documents. 
o Combining images, charts, and text in a cohesive layout. 

 
Skills / Practical Tasks 

• Activity 1: Create a multi-page document with structured headings and 
sections. 

• Activity 2: Insert and format tables, references, and images. 
• Activity 3: Apply headers, footers, and page numbers across all pages. 
• Activity 4: Protect the document with password and editing restrictions. 
• Activity 5: Save and export the document as a secure PDF for printing or 

sharing. 
 
Trainer’s Notes 

• Demonstrate each step for consistency and clarity across multi-page 
documents. 

• Emphasize professional presentation and attention to detail. 
• Encourage trainees to double-check formatting and security settings. 
• Provide examples of official documents like reports, proposals, or memos for 

reference. 
 
Assessment Criteria 

• Trainee creates a fully formatted, professional multi-page document. 
• Headers, footers, page numbers, and tables are applied correctly. 
• Document is password-protected and/or has editing restrictions. 
• Document is ready for printing or secure sharing. 



• Trainee demonstrates proper workflow and attention to formatting details. 
4 M 4:  

Excel, PowerPoint 
& Collaboration, 
Google Docs 
 
Objective: Build 
proficiency in 
Excel for data 
management and 
visualization, 
create impactful 
presentations in 
PowerPoint, and 
collaborate 
effectively using 
Google and online 
meeting tools. 

LU 4.1: Excel Data Entry, Formatting, Functions, 
Charts, Pivot Table 
 
Learning Objectives 
Trainee will be able to: 

• Navigate Microsoft Excel interface 
efficiently. 

• Enter and organize data in spreadsheets. 
• Apply formatting to cells, rows, columns, 

and worksheets for clarity. 
• Use basic and intermediate functions 

(SUM, AVERAGE, COUNT, IF). 
• Create charts and pivot tables to 

visualize and summarize data effectively. 
 
Knowledge / Content 

• Excel Interface: 
o Ribbon, tabs, groups, Quick 

Access Toolbar. 
o Worksheets, cells, columns, 

rows, and workbooks. 
• Data Entry & Formatting: 

o Entering text, numbers, dates. 
o Cell formatting: font, alignment, 

borders, colors, number formats. 
o Conditional formatting for data 

visualization. 
• Functions & Formulas: 

o Basic: SUM, AVERAGE, COUNT. 
o Logical: IF, AND, OR. 
o Cell references: relative, 

absolute, mixed. 
• Charts: 

o Types: Column, Bar, Line, Pie. 
o Formatting charts for clarity and 

presentation. 
• Pivot Tables: 

o Creating pivot tables to 
summarize large datasets. 

o Filtering, sorting, and grouping 
data. 

o Using pivot charts to visualize 
summaries. 

 
Skills / Practical Tasks 

• Activity 1: Enter sample data and format 
cells for readability. 

• Activity 2: Apply formulas and functions 
to calculate totals, averages, and 
conditional results. 

• Activity 3: Create charts representing 
dataset trends. 

• Activity 4: Generate pivot tables to 
summarize sales or office data. 

1 Hr (Th) 
7 Hrs (Pr) 



• Activity 5: Customize chart and pivot 
table formatting for professional 
presentation. 

 
Trainer’s Notes 

• Demonstrate data entry and formula 
creation step by step. 

• Highlight common mistakes like 
incorrect references or misaligned data. 

• Encourage trainees to explore different 
chart types for the same dataset. 

• Explain how pivot tables save time and 
improve data analysis in offices. 

 
Assessment Criteria 

• Trainee enters and formats data 
accurately. 

• Trainee applies formulas and functions 
correctly. 

• Trainee creates charts that reflect data 
trends clearly. 

• Trainee builds pivot tables and 
summarizes data effectively. 

• Excel workbook demonstrates 
organization, readability, and 
professional presentation. 

 
LU 4.2: PowerPoint Slides, Animations 
 
Learning Objectives 
Trainee will be able to: 

• Navigate the Microsoft PowerPoint 
interface efficiently. 

• Create, edit, and format slides for 
professional presentations. 

• Apply slide layouts, themes, and design 
consistency. 

• Use animations and transitions to 
enhance slide delivery. 

• Integrate multimedia elements like 
images, audio, and video. 

 
Knowledge / Content 

• PowerPoint Interface: 
o Ribbon, tabs, groups, Quick 

Access Toolbar. 
o Slide pane, notes section, and 

slide sorter. 
• Slide Creation & Formatting: 

o Slide layouts and master slides 
for consistent design. 

o Adding and formatting text, 
shapes, and images. 

o Applying themes, backgrounds, 
and color schemes. 

• Animations & Transitions: 



o Entrance, exit, emphasis, and 
motion path animations. 

o Slide transitions and timing for 
professional flow. 

o Animation pane for sequencing 
and managing multiple effects. 

• Multimedia Integration: 
o Inserting images, audio, video, 

and charts. 
o Resizing, cropping, and 

formatting media. 
o Ensuring compatibility across 

different devices. 
 
Skills / Practical Tasks 

• Activity 1: Create a 5-slide presentation 
with titles, text, and images. 

• Activity 2: Apply consistent theme and 
layout using slide master. 

• Activity 3: Add animations to text and 
images for emphasis. 

• Activity 4: Apply slide transitions and 
adjust timing for smooth flow. 

• Activity 5: Integrate multimedia elements 
and check presentation playback. 

 
Trainer’s Notes 

• Demonstrate slide creation and 
formatting step by step. 

• Encourage trainees to focus on clarity, 
readability, and professional appearance. 

• Highlight the appropriate use of 
animations—avoid overuse. 

• Show examples of effective business and 
educational presentations. 

 
Assessment Criteria 

• Trainee creates a professional, well-
structured presentation. 

• Trainee applies consistent themes, 
layouts, and formatting. 

• Animations and transitions are used 
effectively to enhance communication. 

• Multimedia elements are integrated 
correctly and function as expected. 

• Presentation demonstrates clarity, 
professionalism, and engagement. 

 
LU 4.3: Google Forms, Google Meet, Zoom, and 
Microsoft Teams for Online Meetings 
 
Learning Objectives 
Trainee will be able to: 

• Understand the purpose and applications 
of online collaboration and meeting 
tools. 



• Create and manage Google Forms for 
surveys, quizzes, and data collection. 

• Schedule, host, and participate in online 
meetings using Google Meet, Zoom, and 
Microsoft Teams. 

• Apply best practices for professional 
online communication. 

 
Knowledge / Content 

• Google Forms: 
o Creating forms for surveys, 

feedback, and registration. 
o Adding different question types: 

multiple choice, short answer, 
checkboxes. 

o Sharing, collecting responses, 
and analyzing data. 

• Online Meeting Tools: 
o Google Meet: Scheduling 

meetings via Google Calendar, 
joining, screen sharing, chat, and 
recording. 

o Zoom: Meeting creation, breakout 
rooms, screen sharing, virtual 
backgrounds, recording. 

o Microsoft Teams: Scheduling and 
joining meetings, chat, file 
sharing, collaboration within 
Teams channels. 

• Professional Online Etiquette: 
o Muting/unmuting, using video 

appropriately, chat participation. 
o Time management and 

punctuality. 
o Presentation and sharing 

files/screens effectively. 
 
Skills / Practical Tasks 

• Activity 1: Create a Google Form with at 
least 5 questions and collect responses. 

• Activity 2: Schedule and host a test 
meeting in Google Meet and share the 
link with peers. 

• Activity 3: Conduct a Zoom meeting, 
including screen sharing and chat 
participation. 

• Activity 4: Use Microsoft Teams to 
schedule a meeting, share files, and 
collaborate with teammates. 

• Activity 5: Discuss online meeting 
etiquette and simulate professional 
interactions. 

 
 
 
 



Trainer’s Notes 
• Demonstrate the setup and key features 

of each platform with step-by-step 
instructions. 

• Emphasize differences and advantages 
of each tool in various office contexts. 

• Encourage trainees to practice hosting 
and participating in meetings to gain 
confidence. 

• Highlight professional behavior and 
troubleshooting tips for connectivity 
issues. 

 
Assessment Criteria 

• Trainee creates and manages a Google 
Form correctly. 

• Trainee schedules, hosts, and 
participates in online meetings on all 
three platforms. 

• Trainee demonstrates effective use of 
screen sharing, chat, and file 
collaboration. 

• Trainee applies professional online 
meeting etiquette. 

Capstone Task: Create an Excel report, PowerPoint presentation & host a Google 
Meet meeting 
 
Learning Objectives 
Trainee will be able to: 

• Apply Excel skills to organize, analyze, and present data in a report. 
• Create a professional PowerPoint presentation summarizing key findings. 
• Host an online meeting using Google Meet to present the report and slides. 
• Demonstrate effective office workflow, communication, and collaboration. 

 
 
Knowledge / Content 

• Excel Reporting: 
o Summarizing data with formulas, charts, and pivot tables. 
o Formatting for clarity and professionalism. 

• PowerPoint Presentation: 
o Presenting data and insights clearly with visuals and animations. 
o Maintaining consistency in slide design and layout. 

• Online Meeting Hosting: 
o Scheduling, joining, and presenting in Google Meet. 
o Sharing slides, reports, and screen content effectively. 
o Facilitating discussions and Q&A sessions professionally. 

 
Skills / Practical Tasks 

• Activity 1: Create an Excel report with sample data including tables, formulas, 
and charts. 

• Activity 2: Prepare a PowerPoint presentation summarizing the Excel report 
findings. 

• Activity 3: Schedule and host a Google Meet session to present the report and 
slides. 

• Activity 4: Demonstrate screen sharing, chat interaction, and professional 
presentation etiquette. 



• Activity 5: Collect feedback or responses from attendees during the meeting. 
 
Trainer’s Notes 

• Ensure trainees understand the integration of Excel, PowerPoint, and online 
meetings for real-world office tasks. 

• Emphasize professional presentation, clarity of data, and interactive 
engagement during the meeting. 

• Demonstrate best practices for hosting online meetings and handling 
technical issues. 

• Encourage trainees to rehearse both report preparation and presentation for 
smooth execution. 

 
Assessment Criteria 

• Trainee creates a complete, well-formatted Excel report. 
• Trainee prepares a professional PowerPoint presentation aligned with the 

report. 
• Trainee hosts and manages an online meeting effectively on Google Meet. 
• Trainee demonstrates professionalism, clarity, and interactive 

communication. 
• Overall task showcases integrated office skills and readiness for workplace 

scenarios. 
5 M 5.1:  

MS Access, 
Freelancing & 
Assessment 
 
Objective: Learn 
to manage 
databases using 
MS Access, 
perform queries 
and reporting, and 
explore 
freelancing 
opportunities for 
applying digital 
skills in the job 
market. 
 

LU 5.1.1: Create Tables, Forms, Reports in Access 
 
Learning Objectives 
Trainee will be able to: 

• Understand the basics of Microsoft 
Access and relational databases. 

• Create and manage tables to store 
structured data. 

• Design forms for user-friendly data 
entry. 

• Generate reports to summarize and 
present data professionally. 

 
Knowledge / Content 

• Microsoft Access Overview: 
o Database structure: Tables, 

Queries, Forms, Reports. 
o Advantages of using a database 

over spreadsheets. 
• Tables: 

o Creating tables with fields, data 
types, and primary keys. 

o Input validation and data integrity. 
o Relationships between tables 

(one-to-one, one-to-many). 
• Forms: 

o Designing forms for simplified 
data entry. 

o Customizing layout, controls, and 
input validation. 

• Reports: 
o Generating reports to display data 

from tables and queries. 
o Formatting reports with headers, 

footers, and grouping options. 

1 Hr (Th) 
5 Hrs (Pr) 

 
 
 



o Exporting reports as PDF or 
printing for office use. 

 
Skills / Practical Tasks 

• Activity 1: Create a sample table with 
appropriate fields and data types. 

• Activity 2: Set primary keys and define 
relationships between tables. 

• Activity 3: Design a user-friendly data 
entry form for the table. 

• Activity 4: Generate a report from the 
table, format it, and export as PDF. 

• Activity 5: Test data entry via form and 
verify correct display in reports. 

 
Trainer’s Notes 

• Demonstrate table creation, 
relationships, forms, and reports step by 
step. 

• Emphasize maintaining data integrity and 
consistency. 

• Encourage trainees to explore form 
customization options for better usability. 

• Highlight practical scenarios like 
inventory management or employee 
records. 

 
Assessment Criteria 

• Trainee creates tables with correct fields, 
data types, and primary keys. 

• Trainee designs functional and user-
friendly forms. 

• Trainee generates accurate and well-
formatted reports. 

• Database demonstrates proper 
relationships and data integrity. 

 
LU 5.1.2: Data Entry & Query Handling 
 
Learning Objectives 
Trainee will be able to: 

• Enter and update data efficiently in 
Microsoft Access tables. 

• Understand and apply queries to retrieve, 
filter, and sort data. 

• Use criteria and operators to refine query 
results. 

• Generate meaningful insights from 
database queries. 

 
Knowledge / Content 

• Data Entry: 
o Using tables and forms for 

accurate data input. 
o Validation rules and error 

prevention during entry. 



o Updating, deleting, and 
maintaining records. 

• Queries: 
o Types of queries: Select, Action 

(Update, Delete, Append), 
Parameter. 

o Filtering, sorting, and criteria 
application. 

o Using logical operators (AND, OR, 
NOT) for precise results. 

o Joining tables in queries to 
combine related data. 

• Practical Use Cases: 
o Employee records, inventory 

management, client databases. 
o Generating subsets of data for 

reports or analysis. 
 
Skills / Practical Tasks 

• Activity 1: Enter sample data into existing 
tables using forms. 

• Activity 2: Update and delete specific 
records to maintain database accuracy. 

• Activity 3: Create basic select queries to 
retrieve specific data. 

• Activity 4: Apply filters, sorting, and 
criteria in queries. 

• Activity 5: Combine tables using joins and 
create queries that summarize data. 

 
Trainer’s Notes 

• Demonstrate correct data entry and 
updating techniques to avoid errors. 

• Emphasize the importance of query 
design for accurate data retrieval. 

• Encourage trainees to test query results 
and verify accuracy. 

• Provide examples of real-world 
scenarios requiring data filtering and 
reporting. 

 
Assessment Criteria 

• Trainee enters, updates, and maintains 
data accurately. 

• Trainee creates queries with correct 
filtering, sorting, and criteria. 

• Trainee demonstrates understanding of 
joins and multi-table queries. 

• Queries produce correct and meaningful 
results for analysis or reporting. 

 
LU 5.1.3: Freelancing Basics (Fiverr, Upwork) & 
Online Jobs 
 
Learning Objectives 
Trainee will be able to: 



• Understand the concept of freelancing 
and online job opportunities. 

• Explore popular platforms like Fiverr and 
Upwork for office and IT tasks. 

• Learn the process of creating a 
freelancer profile and offering services. 

• Identify skills in demand for digital and 
administrative tasks online. 

 
Knowledge / Content 

• Freelancing Overview: 
o Definition and benefits of 

freelancing: flexibility, multiple 
income streams. 

o Key considerations: portfolio, 
ratings, communication, 
deadlines. 

• Fiverr: 
o Creating a seller account, setting 

up gigs, pricing services. 
o Understanding Fiverr levels and 

rating system. 
o Delivering services and handling 

revisions. 
• Upwork: 

o Creating a client-oriented profile, 
proposal writing. 

o Bidding on projects and 
understanding Upwork fees. 

o Communication and milestone 
management. 

• Other Online Jobs: 
o Remote data entry, virtual 

assistance, social media 
management. 

o Online surveys, transcription, and 
microtasks. 

• Best Practices: 
o Professional communication, time 

management, and quality delivery. 
o Protecting personal information 

and avoiding scams. 
 
Skills / Practical Tasks 

• Activity 1: Explore Fiverr and Upwork 
websites; identify top-rated profiles and 
gigs. 

• Activity 2: Create a sample freelancer 
profile highlighting office or IT skills. 

• Activity 3: Draft a mock proposal for an 
online project. 

• Activity 4: Discuss how to set competitive 
pricing and manage client expectations. 

• Activity 5: Identify at least 3 online job 
opportunities matching trainee skills. 

 



Trainer’s Notes 
• Highlight real examples of successful 

freelancers and services. 
• Emphasize professionalism, 

communication, and ethical practices. 
• Demonstrate how to navigate freelancing 

platforms safely. 
• Encourage trainees to consider 

freelancing as a career supplement or 
primary income. 

 
Assessment Criteria 

• Trainee explains the concept of 
freelancing and online jobs clearly. 

• Trainee creates a professional sample 
profile on Fiverr or Upwork. 

• Trainee drafts an effective project 
proposal. 

• Trainee identifies suitable freelancing 
opportunities matching their skills. 

• Trainee demonstrates understanding of 
best practices and platform safety. 

M 5.2: 
Entrepreneurship 
Session 
 
Objective: 
Understand the 
fundamentals of 
entrepreneurship 
by exploring idea 
generation, 
business 
planning, 
financing, and 
strategies to 
overcome 
challenges in 
starting and 
running a 
business. 

LU 5.2.1: Introduction to Entrepreneurship 
 
Learning Objectives 
Trainee will be able to: 

• Define entrepreneurship and explain its 
importance in today’s economy. 

• Identify characteristics of successful 
entrepreneurs. 

• Recognize opportunities where 
entrepreneurial thinking can be applied. 

 
Knowledge / Content 
Entrepreneurship is the process of identifying, 
developing, and managing a business idea to 
create value and generate profit. Entrepreneurs 
are not just business owners — they are 
problem-solvers who turn ideas into real 
solutions. 
Why Entrepreneurship Matters: 

• Creates jobs and income. 
• Brings innovation and new solutions to 

the market. 
• Supports community and national 

economic growth. 
• Empowers individuals to become 

independent. 
Characteristics of Successful Entrepreneurs: 

• Creativity and innovation. 
• Risk-taking (calculated, not careless). 
• Resilience and persistence. 
• Communication and leadership skills. 
• Problem-solving mindset. 

Examples of Entrepreneurship: 
• Starting a digital marketing agency. 

1 Hr  
(Th/Pr) 

 



• Launching an e-commerce store. 
• Providing freelancing services as a full-

time business. 
• Creating a new product or service to 

solve a local problem. 
 
Skills / Practical Tasks 

• Activity 1 (Discussion): Ask trainees to 
name a local entrepreneur they admire 
and why. 

• Activity 2 (Brainstorming): In groups, 
trainees list at least 3 business ideas that 
solve everyday problems. 

• Activity 3 (Case Study): Trainer presents 
a short story of a successful startup 
(local or global). Trainees identify the 
entrepreneur’s key traits. 

 
Trainer’s Notes 

• Keep examples local and relatable (e.g., 
Pakistani startups, freelancers who 
scaled into agencies). 

• Stress that entrepreneurship does not 
always require large investments — 
ideas and persistence are more 
important. 

• Use simple analogies: an entrepreneur is 
like a farmer planting seeds, nurturing 
them, and waiting for them to grow. 

• Encourage trainees to think about how 
they themselves can apply 
entrepreneurial thinking in freelancing or 
small businesses. 

 
Assessment Criteria 

• Trainee defines entrepreneurship in their 
own words. 

• Trainee lists at least 3 characteristics of 
successful entrepreneurs. 

• Trainee suggests at least 1 potential 
business idea. 

 
LU 5.2.2: Types of Entrepreneurships 
Learning Objectives 
Trainee will be able to: 

• Identify different types of 
entrepreneurship. 

• Explain the characteristics of each type 
with examples. 

• Recognize which type of 
entrepreneurship suits different business 
ideas. 

 
Knowledge / Content 
Entrepreneurship comes in many forms 



depending on the goals, resources, and mindset 
of the entrepreneur. 
Types of Entrepreneurship: 

1. Small Business Entrepreneurship 
o Local shops, freelancers, 

restaurants, small startups. 
o Focused on survival, income, and 

community support. 
o Example: A family-owned clothing 

shop. 
2. Scalable Startup Entrepreneurship 

o Begins small but designed to 
grow quickly and attract 
investors. 

o Risky but can create global 
companies. 

o Example: Careem, Airlift, or 
Silicon Valley startups. 

3. Social Entrepreneurship 
o Focuses on solving 

social/environmental problems 
while also sustaining financially. 

o Example: NGOs that sell products 
to fund community work, Edhi 
Foundation’s service model. 

4. Corporate Entrepreneurship 
(Intrapreneurship) 

o Employees acting like 
entrepreneurs within big 
companies. 

o Innovating new products/services 
inside an existing organization. 

o Example: Google allowing 
employees to develop new ideas. 

5. Digital Entrepreneurship 
o Using the internet to run 

businesses (freelancing, e-
commerce, digital marketing). 

o Example: Online clothing store, 
Fiverr/Upwork freelancers 
scaling into agencies. 

 
Skills / Practical Tasks 

• Activity 1 (Classification Game): Trainer 
gives business examples, trainees decide 
which entrepreneurship type they belong 
to. 

• Activity 2 (Group Brainstorm): Each 
group chooses a business idea and 
identifies which entrepreneurship type it 
fits. 

• Activity 3 (Case Study): Review a 
successful startup (local or global) and 
identify its entrepreneurship type. 

 
 



 
Trainer’s Notes 

• Use local examples of entrepreneurs that 
trainees can relate to. 

• Highlight that no type is “better” — it 
depends on personal goals, resources, 
and risk tolerance. 

• Connect to freelancing: freelancers often 
start as small business entrepreneurs 
and may grow into digital or scalable 
startups. 

• Keep discussion interactive — encourage 
trainees to debate which type of 
entrepreneurship best suits their own 
ideas. 

 
Assessment Criteria 

• Trainee lists at least 3 types of 
entrepreneurship. 

• Trainee matches business examples to 
correct entrepreneurship types. 

• Trainee explains which entrepreneurship 
type fits their own business idea. 

 
LU 5.2.3: Business Idea Generation 
Learning Objectives 
Trainee will be able to: 

• Explain the importance of generating 
creative and practical business ideas. 

• Apply methods for brainstorming and 
identifying business opportunities. 

• Evaluate ideas based on feasibility, 
market demand, and resources. 

• Develop at least one potential business 
idea individually or in groups. 

 
Knowledge / Content 
Every successful business starts with an idea. 
Good ideas come from observing problems, 
identifying needs, and finding innovative 
solutions. 
Sources of Business Ideas: 

• Personal Skills & Interests: Turning 
hobbies or expertise into business (e.g., 
graphic design, baking). 

• Market Gaps: Identifying 
products/services missing in the 
community. 

• Trends & Technology: Using new tools or 
platforms to create solutions (e.g., social 
media marketing). 

• Problems Around You: Every problem is a 
potential business opportunity. 

Methods of Idea Generation: 
1. Brainstorming: Write down as many 

ideas as possible, no judgment. 



2. Mind Mapping: Start with a central 
concept and expand with related ideas. 

3. SCAMPER Technique: Substitute, 
Combine, Adapt, Modify, Put to another 
use, Eliminate, Reverse. 

4. Observation & Research: Watch what 
people need or complain about. 

Evaluating Ideas: 
• Feasibility: Can you realistically start it? 
• Demand: Do people want it? 
• Resources: Do you have time, skills, or 

money for it? 
• Profitability: Will it make money or 

sustain itself? 
 
Skills / Practical Tasks 

• Activity 1 (Brainstorming Session): 
Trainees list 5 possible business ideas 
individually. 

• Activity 2 (Group Work): In groups, 
combine ideas and shortlist 2 strong 
ones. 

• Activity 3 (Mind Mapping): Pick one idea 
and expand it using a mind map. 

• Activity 4 (Evaluation): Groups present 
their idea and explain why it is feasible 
and in demand. 

 
Trainer’s Notes 

• Encourage creativity — no idea is “too 
small” at the start. 

• Use local, relatable examples: home-
based food businesses, tuition services, 
online stores. 

• Guide trainees to think of both digital and 
traditional businesses. 

• Stress that successful entrepreneurs 
often start small and improve their ideas 
over time. 

• Remind them: even if an idea fails, the 
learning process is valuable. 

 
Assessment Criteria 

• Trainee generates at least 3 business 
ideas. 

• Trainee applies an idea-generation 
method (brainstorming/mind mapping). 

• Trainee explains why one idea is feasible 
and meets a market need. 

 
LU 5.2.4: Business Planning and Strategy 
 
Learning Objectives 
Trainee will be able to: 

• Explain the importance of business 
planning for entrepreneurs. 



• Identify the key components of a simple 
business plan. 

• Understand basic strategies for 
launching and growing a business. 

• Develop a mini business plan for a 
selected idea. 

 
Knowledge / Content 
A business plan is a written roadmap that 
outlines how a business will operate, earn, and 
grow. It helps entrepreneurs stay focused and 
attract partners or investors. 
Importance of Business Planning: 

• Provides clarity on goals and direction. 
• Helps identify risks and opportunities. 
• Attracts investors or lenders. 
• Guides daily operations and decision-

making. 
Key Components of a Business Plan: 

1. Executive Summary: Short overview of 
the business idea. 

2. Business Description: What 
product/service will you offer? Who are 
the customers? 

3. Market Research: Target market, 
competitors, demand trends. 

4. Marketing & Sales Strategy: How will you 
attract and retain customers? 

5. Operations Plan: Resources, suppliers, 
technology, and team. 

6. Financial Plan: Startup costs, pricing, 
revenue, and profit projections. 

Business Strategy Basics: 
• Market Entry Strategy: How to launch 

(small-scale test, partnerships, online 
presence). 

• Growth Strategy: Expanding customers, 
new products, scaling operations. 

• Competitive Strategy: Differentiation 
(unique value), cost leadership 
(affordable), or niche focus. 

 
 
 
Skills / Practical Tasks 

• Activity 1 (Case Study): Trainer shows a 
short business plan sample (1-page) and 
explains sections. 

• Activity 2 (Mini Plan Drafting): Trainees 
create a 1-page business plan for a 
business idea (group or individual). 

• Activity 3 (Strategy Mapping): Groups 
identify how their business will enter the 
market and grow. 



• Activity 4 (Presentation): Groups present 
their business plans and get peer/trainer 
feedback. 

 
Trainer’s Notes 

• Keep it simple — trainees do not need a 
20-page business plan. A 1–2 page draft 
is enough to start. 

• Relate strategies to local businesses 
(e.g., how a food stall expands into a 
restaurant). 

• Stress adaptability: strategies should be 
flexible because markets change. 

• Use visual tools like Business Model 
Canvas if possible. 

• Encourage teamwork: business planning 
is often best done collaboratively. 

 
Assessment Criteria 

• Trainee identifies at least 3 components 
of a business plan. 

• Trainee prepares a mini business plan 
with clear goals, market info, and 
strategy. 

• Trainee presents a realistic and practical 
strategy for growth. 

 
LU 5.2.5: Financing Business 
 
Learning Objectives 
Trainee will be able to: 

• Explain why financing is important for 
starting and running a business. 

• Identify different sources of business 
financing. 

• Understand the difference between debt 
and equity financing. 

• Create a simple financial plan for a 
business idea. 

 
Knowledge / Content 
Every business needs money (capital) to start, 
operate, and grow. Financing refers to the ways 
entrepreneurs obtain and manage funds. 
Why Financing is Important: 

• Covers startup costs (equipment, 
licenses, marketing). 

• Supports daily operations (salaries, bills, 
raw materials). 

• Enables growth (expansion, new 
products, more staff). 

Sources of Business Financing: 
1. Personal Savings: Most common for 

small startups. 
2. Family and Friends: Informal loans or 

investments. 



3. Bank Loans: Formal borrowing with 
interest. 

4. Microfinance Institutions: Small loans for 
small businesses. 

5. Government Schemes: e.g., NAVTTC seed 
money programs. 

6. Investors/Equity: Giving up part 
ownership in exchange for funding. 

7. Crowdfunding: Collecting money from 
many people online. 

Debt vs. Equity Financing: 
• Debt: Borrowing money (loans) that must 

be repaid with interest. 
• Equity: Selling part ownership to 

investors in exchange for capital. 
 
Skills / Practical Tasks 

• Activity 1 (Brainstorm): Trainees list 
possible financing options for a small 
local business (e.g., bakery, e-commerce 
store). 

• Activity 2 (Financial Plan Draft): Trainees 
create a simple startup cost sheet (what 
money is needed and where it comes 
from). 

• Activity 3 (Case Study Discussion): 
Trainer presents an example of a 
business that grew with small financing 
(e.g., local startup using microfinance). 

• Activity 4 (Role-Play): One trainee acts as 
an entrepreneur pitching to a lender, 
another as a bank officer/investor. 

 
Trainer’s Notes 

• Emphasize starting small and realistic — 
not every business needs big loans. 

• Warn trainees about over-borrowing — 
debt can become a burden if not planned. 

• Encourage them to explore government 
and microfinance programs available 
locally. 

• Use real examples from Pakistan: small 
shops, freelancers, and startups that 
scaled gradually. 

• Show how financing links back to 
business planning and strategy. 

 
Assessment Criteria 

• Trainee lists at least 3 sources of 
financing. 

• Trainee explains the difference between 
debt and equity financing. 

• Trainee prepares a simple financing plan 
for a business idea. 

 



LU 5.2.6: Entrepreneurship Challenges and 
Possible Solutions 
 
Learning Objectives 
Trainee will be able to: 

• Identify common challenges faced by 
entrepreneurs. 

• Explain how these challenges affect 
business success. 

• Propose practical solutions to overcome 
entrepreneurial challenges. 

• Build resilience and problem-solving 
skills as future entrepreneurs. 

 
Knowledge / Content 
Starting and running a business is rewarding but 
also comes with challenges. Successful 
entrepreneurs anticipate problems and prepare 
solutions. 
Common Entrepreneurship Challenges: 

1. Lack of Capital: Not enough funds to start 
or expand. 

o Solution: Start small, seek 
microfinance, reinvest profits. 

2. Market Competition: Too many 
competitors offering similar products. 

o Solution: Differentiate with unique 
value, better service, or niche 
focus. 

3. Limited Skills/Knowledge: Not knowing 
how to manage finances, marketing, or 
operations. 

o Solution: Continuous learning, 
training programs, mentorship. 

4. Finding Customers: Difficulty in building a 
customer base. 

o Solution: Use digital marketing, 
referrals, social media, quality 
service. 

5. Time Management: Balancing multiple 
roles (sales, marketing, operations). 

o Solution: Prioritize tasks, delegate 
when possible, use digital tools. 

6. Risk & Failure: Fear of losing money or 
business not working out. 

o Solution: Start with low-risk 
ideas, learn from failures, adapt 
quickly. 

 
Skills / Practical Tasks 

• Activity 1 (Group Discussion): Trainees 
share what challenges they think 
entrepreneurs face in their community. 

• Activity 2 (Problem-Solution Mapping): 
Each group selects one challenge and 
writes possible solutions. 



• Activity 3 (Case Study): Trainer shares a 
story of an entrepreneur who overcame 
difficulties (local startup/freelancer). 

• Activity 4 (Role-Play): One trainee 
presents a challenge, others suggest 
solutions as if they were a business 
mentor panel. 

 
Trainer’s Notes 

• Keep discussion realistic — many 
challenges are common to all 
entrepreneurs, not just beginners. 

• Encourage resilience and adaptability: 
failure is not the end, but a step toward 
learning. 

• Share local success stories of 
businesses that overcame early 
struggles. 

• Stress networking and mentorship as 
important tools for solving challenges. 

• Motivate trainees by reinforcing: “Every 
problem has a solution if you stay 
persistent.” 

 
Assessment Criteria 

• Trainee identifies at least 3 
entrepreneurship challenges. 

• Trainee suggests practical solutions for 
at least 2 challenges. 

• Trainee demonstrates problem-solving 
skills in group discussions or role-play. 

M 5.3: 
Environment 
Session 
 
Objective: Build 
awareness of 
environmental 
issues, hazards, 
and climate 
change while 
learning 
sustainable 
practices and 
ways individuals 
can contribute to 
environmental 
protection. 

LU 5.3.1: Introduction to Environmental Issues 
 
Learning Objectives 
Trainee will be able to: 

• Define environmental issues and explain 
why they matter for communities and 
businesses. 

• Identify common local and global 
environmental problems. 

• Recognize the role individuals and 
entrepreneurs can play in reducing 
environmental impact. 

 
Knowledge / Content 
The environment includes air, water, land, 
plants, and animals that support life. Human 
activities, especially business and industrial 
growth, can damage the environment if not 
managed responsibly. 
Major Environmental Issues: 

1. Pollution: Air (smoke, traffic), water 
(waste dumping), land (plastic waste). 

2. Climate Change: Rising temperatures, 
extreme weather, melting glaciers. 
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3. Deforestation: Cutting down trees leading 
to loss of biodiversity. 

4. Waste Management: Excess plastic, e-
waste, and poor recycling. 

5. Resource Depletion: Overuse of water, 
energy, and minerals. 

Why It Matters for Entrepreneurs and 
Businesses: 

• Customers prefer eco-friendly 
businesses. 

• Reducing waste and saving energy 
lowers costs. 

• Businesses have a responsibility toward 
the community. 

• Green practices can create new business 
opportunities (eco-products, recycling). 

 
Skills / Practical Tasks 

• Activity 1 (Brainstorm): Trainees list 
environmental problems they see in their 
community. 

• Activity 2 (Video/Images): Trainer shows 
short clips or pictures of environmental 
issues; trainees identify the problem. 

• Activity 3 (Discussion): Groups suggest 
how small businesses can contribute to 
solving one environmental issue. 

• Activity 4 (Reflection): Each trainee 
writes one personal habit they can 
change to reduce their environmental 
impact. 

 
Trainer’s Notes 

• Use local examples (plastic bags, traffic 
pollution, waste in rivers). 

• Connect environment to 
entrepreneurship: eco-friendly 
businesses are a growing trend. 

• Stress that protecting the environment is 
both a social responsibility and a 
business opportunity. 

• Keep the discussion interactive — allow 
trainees to share personal experiences. 

 
Assessment Criteria 

• Trainee defines environmental issues in 
their own words. 

• Trainee identifies at least 3 common 
environmental problems. 

• Trainee proposes one solution or habit 
change to reduce environmental impact. 

 
LU 5.3.2: Types of Environmental Hazards  
 
Learning Objectives 
Trainee will be able to: 



• Define environmental hazards and 
explain their impact on people, 
businesses, and communities. 

• Identify different types of environmental 
hazards with local and global examples. 

• Recognize how businesses and 
individuals can reduce risks from these 
hazards. 

 
Knowledge / Content 
An environmental hazard is any natural or 
human-made event that negatively affects 
people, property, or the ecosystem. Hazards can 
disrupt lives, damage businesses, and harm 
health. 
Types of Environmental Hazards: 

1. Natural Hazards 
o Earthquakes, floods, droughts, 

hurricanes, landslides. 
o Example: Floods in Pakistan 

(2022) affecting agriculture and 
housing. 

2. Chemical Hazards 
o Pollution from factories, 

pesticides, toxic waste, air and 
water contamination. 

o Example: Industrial waste 
polluting rivers. 

3. Biological Hazards 
o Diseases, bacteria, viruses, or 

pests that threaten health. 
o Example: COVID-19 pandemic as a 

biological hazard. 
4. Physical Hazards 

o Unsafe conditions such as noise 
pollution, radiation, poor 
infrastructure. 

o Example: Construction sites with 
dust and noise. 

5. Human-Made Hazards 
o Deforestation, overpopulation, 

poor waste management, 
accidents from unsafe practices. 

o Example: Plastic pollution from 
single-use bags and bottles. 

 
Skills / Practical Tasks 

• Activity 1 (Matching Game): Trainer gives 
examples of hazards, trainees classify 
them into types. 

• Activity 2 (Group Brainstorm): Trainees 
identify hazards that are most common in 
their community. 

• Activity 3 (Problem-Solution): Each group 
picks one hazard and suggests a 
business or community solution. 



• Activity 4 (Reflection): Trainees discuss 
how hazards might impact small 
businesses. 

 
Trainer’s Notes 

• Use simple, clear language — avoid 
making hazards sound too technical. 

• Show visuals or news headlines of 
recent hazards for real-world 
connection. 

• Emphasize that hazards are not just 
natural disasters — everyday pollution 
and waste are also hazards. 

• Link discussion back to 
entrepreneurship: eco-friendly 
businesses can reduce hazards and 
create opportunities. 

 
Assessment Criteria 

• Trainee lists at least 3 types of 
environmental hazards. 

• Trainee classifies given examples into 
correct hazard categories. 

• Trainee proposes at least one solution to 
reduce or manage a hazard.  

 
LU 5.3.3: The Impact of Human Activity on the 
Environment 
 
Learning Objectives 
Trainee will be able to: 

• Explain how human activities affect the 
natural environment. 

• Identify both positive and negative 
impacts of human behavior on 
ecosystems. 

• Recognize the role of responsible 
practices in reducing environmental 
damage. 

 
Knowledge / Content 
Human activities have a direct impact on the air, 
water, land, and biodiversity around us. While 
development and industry improve living 
standards, they can also create serious 
environmental problems if unmanaged. 
Negative Impacts of Human Activity: 

1. Deforestation: Clearing forests for 
agriculture, housing, and industry → loss 
of biodiversity and climate change. 

2. Pollution: Industrial waste, vehicle 
smoke, and plastic use → air, land, and 
water contamination. 

3. Overconsumption of Resources: 
Excessive use of water, energy, and 



minerals → depletion of natural 
resources. 

4. Urbanization: Expansion of cities leading 
to overcrowding, waste, and loss of 
green areas. 

5. Climate Change: Emissions from 
industries and vehicles → rising global 
temperatures, floods, droughts. 

Positive Impacts of Human Activity (when 
responsible): 

• Reforestation & Conservation: Planting 
trees, protecting wildlife. 

• Green Technology: Solar power, electric 
vehicles, eco-friendly products. 

• Recycling & Waste Reduction: Reduces 
landfill and saves resources. 

• Sustainable Businesses: Companies 
adopting eco-friendly production. 

 
Skills / Practical Tasks 

• Activity 1 (Observation): Trainees list 3 
ways humans harm the environment in 
their local area. 

• Activity 2 (Debate): Groups discuss: 
“Development vs. Environment — Can 
both grow together?” 

• Activity 3 (Positive Actions): Each trainee 
suggests one eco-friendly business idea. 

• Activity 4 (Case Study): Trainer presents 
an example of a company using 
sustainable practices (e.g., a brand using 
recycled packaging). 

 
Trainer’s Notes 

• Use local issues such as plastic bag 
bans, smog in big cities, and water 
shortages to make it relatable. 

• Highlight the duality: humans can destroy 
the environment, but they can also 
protect and restore it. 

• Encourage trainees to think about how 
entrepreneurs can adopt green practices 
while still making profit. 

• Keep discussions hopeful and solution-
focused, not just problem-heavy. 

 
Assessment Criteria 

• Trainee identifies at least 3 negative 
impacts of human activities on the 
environment. 

• Trainee provides at least 1 example of a 
positive human action for sustainability. 

• Trainee suggests one eco-friendly 
practice or business idea. 

 
LU 5.3.4: Conservation and Sustainability 



 
Learning Objectives 
Trainee will be able to: 

• Define conservation and sustainability in 
simple terms. 

• Explain why conserving natural 
resources is important for future 
generations. 

• Identify sustainable practices individuals 
and businesses can adopt. 

• Demonstrate small actions that 
contribute to long-term environmental 
care. 

 
Knowledge / Content 
Conservation means protecting and wisely using 
natural resources such as water, forests, and 
energy. 
Sustainability means meeting today’s needs 
without compromising the ability of future 
generations to meet theirs. 
Why It Matters: 

• Earth’s resources are limited — if 
wasted, future generations will suffer. 

• Conservation reduces costs for 
businesses and families. 

• Sustainable practices improve health, 
community well-being, and business 
reputation. 

Examples of Conservation Practices: 
• Saving electricity by switching off unused 

lights/fans. 
• Reducing water waste in homes and 

industries. 
• Planting trees to restore ecosystems. 
• Recycling materials like paper, glass, 

plastic, and e-waste. 
Examples of Sustainability Practices: 

• Using renewable energy (solar, wind). 
• Eco-friendly packaging instead of plastic. 
• Sustainable farming (crop rotation, 

organic methods). 
• Green entrepreneurship (eco-products, 

recycling startups). 
 
Skills / Practical Tasks 

• Activity 1 (Brainstorm): Trainees list 
simple ways they can save water, energy, 
or resources daily. 

• Activity 2 (Group Work): Groups design a 
poster promoting conservation habits 
(digital or on chart paper). 

• Activity 3 (Business Angle): Trainees 
suggest one business idea that uses 
sustainability (e.g., reusable bags, solar-
powered devices). 



• Activity 4 (Reflection): Each trainee 
writes one habit they will adopt for 
conservation. 

 
Trainer’s Notes 

• Emphasize “small actions, big impact” — 
conservation starts at home. 

• Use relatable examples (e.g., solar 
panels in villages, recycling drives in 
cities). 

• Link back to entrepreneurship: 
sustainable businesses often gain more 
customer trust. 

• Encourage optimism — show how youth-
led initiatives globally and locally are 
making change. 

 
Assessment Criteria 

• Trainee defines conservation and 
sustainability. 

• Trainee lists at least 3 conservation or 
sustainability practices. 

• Trainee proposes one eco-friendly 
personal habit or business idea. 

 
LU 5.3.5: Climate Change and Its Effects 
 
Learning Objectives 
Trainee will be able to: 

• Define climate change and explain its 
causes. 

• Identify the effects of climate change at 
local and global levels. 

• Recognize the role of individuals and 
businesses in reducing climate change 
impact. 

• Propose small actions to help mitigate 
climate change. 

 
Knowledge / Content 
Climate change refers to long-term changes in 
global temperatures and weather patterns, 
mainly caused by human activities like burning 
fossil fuels, deforestation, and industrialization. 
Causes of Climate Change: 

• Greenhouse gases from industries, 
vehicles, and burning coal/oil. 

• Deforestation reducing Earth’s ability to 
absorb carbon dioxide. 

• Rapid urbanization and overconsumption 
of natural resources. 

Effects of Climate Change: 
1. Rising Temperatures: Heatwaves, 

droughts, water shortages. 
2. Extreme Weather: More frequent floods, 

hurricanes, and storms. 



3. Melting Ice & Rising Sea Levels: Threat to 
coastal areas. 

4. Impact on Agriculture: Crop failures, 
reduced food supply. 

5. Health Issues: Heat stress, spread of 
diseases, poor air quality. 

Local Context (Pakistan/Regional Examples): 
• Devastating floods (2022) destroying 

homes and crops. 
• Smog in big cities like Lahore due to 

pollution. 
• Glacial melting in the north affecting 

water supply. 
Positive Actions to Reduce Impact: 

• Planting trees and protecting forests. 
• Using renewable energy (solar panels, 

wind). 
• Energy-saving habits (public transport, 

switching off appliances). 
• Promoting eco-friendly businesses and 

sustainable products. 
 
Skills / Practical Tasks 

• Activity 1 (Discussion): Trainees list 
climate change impacts they have 
personally observed (e.g., hotter 
summers, floods). 

• Activity 2 (Group Exercise): Groups 
design a simple awareness campaign 
poster on climate change solutions. 

• Activity 3 (Case Study): Trainer shares a 
success story of a green project (e.g., 
Billion Tree Tsunami in Pakistan). 

• Activity 4 (Reflection): Each trainee 
commits to one personal step to reduce 
climate change impact. 

 
Trainer’s Notes 

• Use visual aids (charts, before-and-after 
images of floods, heatwaves). 

• Relate climate change to daily life and 
businesses — e.g., higher energy bills, 
crop losses, and business disruptions. 

• Encourage proactive thinking: climate 
change is a challenge but also an 
opportunity for green entrepreneurship. 

• Keep the tone motivational — focus on 
what can be done, not just the problems. 

 
Assessment Criteria 

• Trainee defines climate change and lists 
at least 2 causes. 

• Trainee identifies at least 3 effects of 
climate change (local or global). 

• Trainee suggests one action individuals 
or businesses can take to reduce impact. 



 
LU 5.3.6: How to Contribute to Environmental 
Protection? 
 
Learning Objectives 
Trainee will be able to: 

• Explain the role of individuals, 
businesses, and communities in 
protecting the environment. 

• Identify simple, practical steps for 
environmental protection. 

• Demonstrate how entrepreneurs can 
integrate eco-friendly practices into their 
work. 

• Commit to at least one personal action 
toward protecting the environment. 

 
Knowledge / Content 
Protecting the environment means taking steps 
to reduce harm and preserve resources for 
future generations. Everyone — from individuals 
to businesses — has a role to play. 
Ways Individuals Can Contribute: 

• Reduce, Reuse, Recycle: Avoid single-use 
plastics, recycle waste. 

• Save energy and water at home (switch 
off, fix leaks). 

• Plant trees and protect green spaces. 
• Use eco-friendly transport (public 

transport, cycling, walking). 
Ways Businesses Can Contribute: 

• Use sustainable materials and packaging. 
• Reduce waste and manage it responsibly. 
• Adopt renewable energy sources (solar, 

wind). 
• Promote green products and services 

(eco-friendly entrepreneurship). 
Ways Communities Can Contribute: 

• Organize clean-up drives, recycling 
programs. 

• Raise awareness through campaigns and 
workshops. 

• Support government policies on 
environmental protection. 

• Collaborate with NGOs and green 
organizations. 

 
Skills / Practical Tasks 

• Activity 1 (Brainstorm): Each trainee lists 
one personal habit they can change to 
protect the environment. 

• Activity 2 (Group Work): Groups create a 
checklist of eco-friendly practices for a 
small business. 

• Activity 3 (Awareness Campaign): Groups 
design a short awareness slogan or 



poster promoting environmental 
protection. 

• Activity 4 (Community Idea): Trainees 
suggest one community activity (e.g., 
clean-up day, tree plantation drive). 

 
Trainer’s Notes 

• Stress that every small step counts — 
collective actions create big change. 

• Give local, relatable examples (plastic 
bag bans, solar projects in villages). 

• Encourage students to think about how 
their future businesses can be eco-
friendly. 

• Use motivational tone: protecting the 
environment = protecting our health, 
economy, and future. 

• Connect this LU with earlier ones on 
climate change, conservation, and 
sustainability. 

 
Assessment Criteria 

• Trainee lists at least 3 ways to protect 
the environment. 

• Trainee suggests one eco-friendly 
practice for individuals and one for 
businesses. 

• Trainee commits to one personal or 
group action for environmental 
protection. 

Capstone Task: Develop a basic Access database with reports & explore freelance 
job platforms 
 
Learning Objectives 
Trainee will be able to: 

• Apply Microsoft Access skills to design a basic functional database. 
• Create tables, forms, and reports to manage sample data efficiently. 
• Explore freelancing platforms like Fiverr and Upwork to identify online job 

opportunities. 
• Combine technical and professional skills to simulate real-world office and 

freelance scenarios. 
 
Knowledge / Content 

• Database Development: 
o Table creation with appropriate fields and data types. 
o Data entry via forms and maintaining data integrity. 
o Generating reports for data presentation and analysis. 

• Freelancing Platforms: 
o Navigating Fiverr and Upwork to explore available jobs. 
o Understanding profile creation, gig/service setup, and client 

engagement. 
o Evaluating skills in demand and potential earnings. 

• Professional Integration: 
o Combining database management with freelancing skills for remote or 

office tasks. 



o Understanding project workflows, deadlines, and client 
communication. 

 
Skills / Practical Tasks 

• Activity 1: Design a basic Access database with at least one table, a data entry 
form, and a report. 

• Activity 2: Populate the database with sample data and verify correctness. 
• Activity 3: Generate and format a report from the database. 
• Activity 4: Explore Fiverr and Upwork, identify 3 potential freelance 

opportunities. 
• Activity 5: Create a mock freelancer profile and draft a sample proposal for an 

online job. 
 
Trainer’s Notes 

• Demonstrate database creation, form usage, and report generation step by 
step. 

• Guide trainees in safely navigating freelancing platforms. 
• Emphasize the importance of integrating technical and professional skills. 
• Encourage trainees to simulate real-world scenarios to reinforce learning. 

Assessment Criteria: 
• Trainee develops a functional Access database with tables, forms, and 

reports. 
• Database is populated correctly and reports are accurate. 
• Trainee demonstrates understanding of freelancing platforms and potential 

opportunities. 
• Mock profile and proposal are professionally drafted. 
• Overall project reflects integration of office skills and online freelancing 

knowledge. 
Capstone Project: Trainees will complete and present a comprehensive project 
simulating an actual office assistant’s day: 

• Create a database in MS Access to manage office records 
• Generate Excel reports and charts for monthly data 
• Draft and format official correspondence in MS Word 
• Design a brief PowerPoint for staff training 
• Host a virtual meeting using Zoom/Meet/Teams 
• Submit digital copies via email as part of workflow 

Learning Objectives 
Trainee will be able to: 

• Apply all core office software skills in an integrated, real-world scenario. 
• Demonstrate the ability to manage, analyze, and present data using MS 

Access and Excel. 
• Draft, format, and finalize professional correspondence in MS Word. 
• Create concise and visually appealing PowerPoint presentations for staff or 

training purposes. 
• Conduct and manage virtual meetings using Zoom, Google Meet, or Microsoft 

Teams. 
• Submit and share digital documents effectively as part of workflow 

management. 
 
Knowledge / Content 

• Integrated Office Workflow: 
o Using MS Access for database management and records organization. 
o Excel for data analysis, reporting, charts, and pivot tables. 
o MS Word for official documentation, letters, and reports. 



o PowerPoint for internal presentations, training materials, and
communication.

o Online meeting platforms for collaboration, presentation, and
coordination.

o Email for professional sharing, submission, and follow-up.
• Professional Practices:

o Maintaining data integrity and accuracy.
o Ensuring clarity, readability, and visual appeal in all documents.
o Managing time effectively and following structured workflows.
o Observing virtual meeting etiquette and presentation best practices.

Skills / Practical Tasks: 
• Activity 1: Create a functional database in MS Access to manage sample office

records.
• Activity 2: Generate Excel reports with formulas, charts, and pivot tables to

summarize monthly data.
• Activity 3: Draft and format an official correspondence document in MS Word,

including headers, footers, and page numbering.
• Activity 4: Design a brief PowerPoint presentation for staff training or project

briefing.
• Activity 5: Host a virtual meeting to present findings and reports using Zoom,

Google Meet, or Teams.
• Activity 6: Submit all completed digital documents via email as part of

workflow.

Trainer’s Notes 
• Guide trainees to integrate all learned skills seamlessly.
• Encourage attention to professional formatting, data accuracy, and clarity.
• Demonstrate effective use of each tool in the workflow context.
• Observe trainee performance in virtual meeting management, presentation,

and document submission.
• Provide real-world examples and simulate office scenarios for authenticity.

Assessment Criteria 
• Trainee creates a functional and well-organized Access database.
• Excel reports and charts are accurate, well-formatted, and insightful.
• MS Word documents demonstrate professional formatting and clarity.
• PowerPoint slides are visually appealing and concise.
• Trainee conducts virtual meetings effectively with professional etiquette.
• All deliverables are submitted digitally in a timely and organized manner.
• Overall performance reflects readiness to perform office assistant duties in

real-world environments.



 
 

 
 

Module 1.1: Health & Safety  
Objective: Develop awareness and practices to ensure personal and workplace safety, recognize hazards, and respond effectively to 
emergencies. 
 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 1.1.1: 
Introduction to 
Safety 

Trainee will be able to: 
• Explain why safety is important 

in every environment, including 
training rooms and workplaces. 

• Recognize that safety is a 
shared responsibility of 
everyone. 

• Follow safety instructions, 
signs, and rules effectively. 
 

Safety is the foundation of every training environment—whether you are working with 
computers, electrical equipment, or simply sitting at a desk. A safe training space 
ensures that everyone can focus on learning without distractions, injuries, or 
unnecessary risks. 
Why Safety Matters 
Even in a digital-skills classroom, accidents can happen. Something as simple as 
water near a laptop, tangled charging cables, or chairs blocking walkways can lead to 
injury or damage. Taking small precautions helps protect people, equipment, and the 
overall learning environment. 
Safety is not the responsibility of one person—it is a shared duty. Trainers, trainees, 
and support staff must work together to maintain a clean, organized, and hazard-free 
workspace. A trainee who notices a broken power socket or a loose tile should report it 
immediately. When everyone participates, the entire environment becomes safer and 
more productive. 
Following Rules, Signs & Instructions 
Safety instructions are not restrictions—they are guidelines to protect everyone. 
Examples of common safety rules include: 

• No food or drinks near computers 
• Keep cables organized and away from walking paths 
• Do not use damaged chargers or devices 
• Maintain proper posture while sitting 
• Pay attention to safety signs (Fire Exit, No Entry, Caution, etc.) 

Understanding common safety signs helps trainees behave responsibly and avoid 
danger. These signs guide movement during emergencies and prevent accidents 
before they happen. 
Digital Safety Awareness 
In digital skills training, safety also includes online safety: 

• Avoid clicking unknown links 



 
 

 
 

• Use strong passwords 
• Keep personal information secure 
• Don’t download unauthorized software 

These practices protect you from viruses, hacking, or data loss. 
Helpful Videos (Free Learning Resources) 
Safety Animation – Why Safety Matters 
A simple visual explanation of why safety is important in all environments. 
https://www.youtube.com/watch?v=FE5lbMzpZlo 
Safety Attitudes at Work 
Shows how small daily habits prevent accidents and build a safer workspace. 
https://www.youtube.com/watch?v=5_IFz7FEZ9E 
Mandatory Safety Signs Explained 
Introduces common safety signs and how to understand them quickly. 
https://www.youtube.com/watch?v=MAqpf8oh-MY 
Summary 
A safe environment helps trainees learn better, reduces accidents, and protects 
equipment. By staying alert, following rules, and taking responsibility, everyone 
contributes to a positive and secure training atmosphere. 
 

LU 1.1.2:  
Personal 
Safety 
Practices 

Trainee will be able to: 
• Describe the importance of 

personal hygiene and 
cleanliness in a workplace or 
training setting. 

• Identify appropriate clothing and 
protective items required for 
safe participation. 

• Demonstrate how to maintain a 
clean, organized, and safe 
workspace. 

Personal safety practices help trainees create a clean, comfortable, and hazard-free 
environment that supports learning and productivity. These habits protect not only the 
trainee but also classmates, trainers, and equipment in the training room. 
Importance of Personal Hygiene 
Good hygiene is essential in any shared space. It helps maintain a healthy 
environment and reduces the spread of illness. Clean hands, proper grooming, and 
avoiding unhygienic practices help everyone work confidently and comfortably. 
Simple habits such as washing hands before using equipment, keeping your face 
mask (if required) clean, and avoiding touching shared surfaces unnecessarily all 
contribute to a safer environment. 
Appropriate Clothing and Protective Items 
Wearing the right clothes is a part of personal safety: 

• Choose comfortable clothing suitable for sitting and moving around. 

https://www.youtube.com/watch?v=FE5lbMzpZlo
https://www.youtube.com/watch?v=5_IFz7FEZ9E
https://www.youtube.com/watch?v=MAqpf8oh-MY


 
 

 
 

• Avoid loose accessories (scarves, long jewelry) that may get caught in chairs, 
bags, or equipment. 

• Closed shoes are safer than open sandals, especially around electrical cords. 
• If the training requires any protective items—such as glasses or masks—use 

them consistently. 
These simple choices reduce the chances of tripping, slipping, or damaging 
equipment. 
Keeping Your Workspace Clean and Organized 
A clean workspace helps prevent accidents and improves focus. Keeping your area 
neat also makes it easier to work with computers or tools. 
Good workspace habits include: 

• Arrange cables properly to avoid tangles and tripping. 
• Keep drinks, food, or water bottles away from laptops and power sources. 
• Organize files, notebooks, and bags to avoid clutter. 
• Immediately clean up small spills or report them to the trainer. 
• Ensure your chair, table, and computer are positioned properly to maintain good 

posture. 
An organized workspace also shows professionalism and prepares you for workplace 
environments. 
Helpful Free Videos / Online Resources 
Personal Cleanliness & Hygien 
Explains why hygiene matters in shared spaces. 
https://www.youtube.com/watch?v=Z3vZ5nF4nT8  
Workplace Cleanliness & Desk Organization Tips 
Shows simple ways to keep your workspace clean and productive. 
https://www.youtube.com/watch?v=VxYw24ixe6I  
Basic Safety Practices in Offices & Labs 
Highlights safe clothing, posture, and workspace habits. 
https://www.youtube.com/watch?v=t1Qlgw-P34U  
Summary 
Personal safety begins with everyday habits—cleanliness, proper clothing, and an 
organized workspace. These practices reduce accidents, support a healthy learning 

https://www.youtube.com/watch?v=Z3vZ5nF4nT8
https://www.youtube.com/watch?v=VxYw24ixe6I
https://www.youtube.com/watch?v=t1Qlgw-P34U


 
 

 
 

environment, and help trainees build professional habits that are essential for any 
future workplace. 
 

LU 1.1.3:  
Hazard 
Awareness 

Trainee will be able to: 
• Define what a hazard is in 

workplace and training 
environments. 

• Identify common hazards such 
as slips, trips, electrical risks, 
tools, and stress. 

• Demonstrate how to report 
unsafe conditions immediately. 

Hazard awareness is a core part of maintaining a safe training or workplace 
environment. A hazard is anything that has the potential to cause harm—whether it 
affects people, equipment, or the training process. Many hazards are easy to miss 
because they blend into everyday surroundings, but understanding how to identify 
them is the first step toward preventing accidents. 
Hazards can appear in many forms. A wet floor near the entrance, wires stretched 
across the room, unstable chairs, or damaged equipment are all examples of physical 
hazards. Electrical hazards include broken plugs, exposed wiring, overloaded 
extensions, or using electronics with wet hands. Even mental stress, fatigue, or 
distractions can become hazards because they reduce focus and increase the 
chances of mistakes. When trainees learn to identify these risks early, they help 
protect themselves and everyone around them. 
Recognizing hazards begins with simple awareness. Every time you enter a 
classroom, lab, or workplace, take a moment to observe your environment. Look for 
anything that seems unsafe, out of place, broken, or unusually positioned. A small 
object on the floor, a chair sticking out in a walkway, or liquid near a power source may 
not look dangerous at first glance, but each can cause injury if ignored. Hazard 
awareness is about noticing the small things before they become big problems. 
Understanding hazards is important because it helps prevent accidents, saves time, 
and avoids damage to valuable equipment. Many incidents happen not because 
conditions were extremely dangerous, but because no one paid attention. When 
trainees are alert, responsible, and proactive, training becomes smoother, safer, and 
more professional. 
Once a hazard is identified, it must be reported immediately. Reporting a hazard is not 
complaining—it is taking responsibility. Inform the trainer or supervisor clearly and 
provide the exact location and nature of the hazard. For example, you might say, 
“There is water on the floor near the power extension,” or “This cable is damaged and 
exposed.” If possible, warn others so they stay away until the issue is resolved. 
Trainees should never attempt to fix electrical or mechanical hazards on their own 
unless trained to do so. 



 
 

 
 

To build your skills further, explore the following free videos and resources. Each 
explains hazard identification and safety in an easy-to-understand way. 
Watch this video: Introduction to Workplace Hazards (4 min) 
This video explains common hazards found in classrooms, labs, and workplaces. 
Link: https://www.youtube.com/watch?v=jrmJdx5vqRA  
Watch this video: Common Workplace Hazards Explained 
A simple guide to identifying physical, electrical, and equipment-related hazards. 
Link: https://www.youtube.com/watch?v=XBv5xqf-Wo4  
Watch this video: Electrical Safety Basics 
Introduces basic electrical risks and how to stay safe around electrical equipment. 
Link: https://www.youtube.com/watch?v=jE3Z4SpZ0Jw  
Watch this video: Slips, Trips, and Falls 
Shows how simple hazards like clutter and wet floors can cause serious injuries. 
Link: https://www.youtube.com/watch?v=JpV7PdnZTkA  
Watch this video: Stress as a Hazard 
Explains how stress and fatigue can lead to unsafe behavior and poor decisions. 
Link: https://www.youtube.com/watch?v=J3g0tF01YfQ  
Free Safety Handbook (PDF) 
This free handbook introduces basic hazard awareness concepts used in workplaces. 
Link: https://www.hse.gov.uk/pubns/indg163.pdf  
In summary, hazard awareness is about staying alert, thinking ahead, and responding 
quickly. When trainees are aware of hazards and report them responsibly, they create 
a safe, efficient, and supportive learning environment. 
 

LU 1.1.4:  
Emergency 
Preparedness 
 

Trainee will be able to: 
• Explain the importance of 

staying calm during 
emergencies. 

• Identify exits, safe areas, and 
emergency equipment in the 
training environment. 

• Follow trainer/supervisor 
guidance during emergencies. 

Emergency preparedness is the ability to respond quickly, calmly, and effectively when 
an unexpected situation occurs. In any training environment—whether it is a computer 
lab, classroom, or office—emergencies such as fire, electrical failure, medical issues, 
or equipment malfunction can happen without warning. Being prepared helps prevent 
panic, reduces harm, and ensures everyone’s safety. 
Staying calm during emergencies is the most important first step. Panic leads to 
confusion, poor decisions, and delays in evacuation. When trainees stay calm, they 
are able to think clearly, follow instructions, and move safely to designated areas. 
Calm behavior also encourages others to remain composed. 

https://www.youtube.com/watch?v=jrmJdx5vqRA
https://www.youtube.com/watch?v=XBv5xqf-Wo4
https://www.youtube.com/watch?v=jE3Z4SpZ0Jw
https://www.youtube.com/watch?v=JpV7PdnZTkA
https://www.youtube.com/watch?v=J3g0tF01YfQ
https://www.hse.gov.uk/pubns/indg163.pdf


 
 

 
 

• Demonstrate basic response 
steps in case of fire, electrical 
failure, or other incidents. 

Every training room has specific exits, safe zones, and emergency equipment such as 
fire extinguishers, alarms, and first aid kits. Trainees should take a moment each day 
to observe their surroundings and note these locations. Knowing where to go and what 
tools are available can save valuable time in a real emergency. 
During any emergency, it is critical to follow the trainer’s or supervisor’s instructions. 
They are trained in safety procedures and know the correct steps to take. Whether it’s 
evacuating the room, shutting down equipment, or assembling in a safe area, trainees 
should listen carefully and respond immediately. 
Preparedness also includes understanding how to respond to different types of 
incidents. In case of fire, trainees should avoid using lifts, move quickly toward exits, 
and never attempt to retrieve personal belongings. During electrical failures, trainees 
should stay seated, avoid touching wires or metal surfaces, and wait for instructions. If 
someone gets injured, trainees should not attempt advanced first aid but must inform 
the supervisor and call for help. 
Emergency preparedness is not just about reacting—it is about being aware, 
responsible, and proactive. A well-prepared trainee contributes to a safer training 
environment for everyone. 
Watch / Learn 
Safety in emergencies is best understood through real examples and demonstrations. 
The following free videos and resources provide clear guidance. 

1. “What to Do in an Emergency – Basic Safety Guide” 
https://www.youtube.com/watch?v=1LNDvGqVf2o  

2. “Fire Safety and Evacuation Procedures” 
https://www.youtube.com/watch?v=BLjoWjCrDqg 

3. “How to Use a Fire Extinguisher – PASS Method Explained” 
https://www.youtube.com/watch?v=lUojO1HvC8E  

4. “Electrical Safety Basics for Everyone” 
https://www.youtube.com/watch?v=Y8jzE7f2Jzk  

5. “Emergency Preparedness Training – Workplace Safety” 
https://www.youtube.com/watch?v=6k6aYlKa1tY  

6. Free course: “Emergency Preparedness Basics – Alison Online” 
https://alison.com/course/emergency-preparedness  

 

https://www.youtube.com/watch?v=1LNDvGqVf2o
https://www.youtube.com/watch?v=BLjoWjCrDqg
https://www.youtube.com/watch?v=lUojO1HvC8E
https://www.youtube.com/watch?v=Y8jzE7f2Jzk
https://www.youtube.com/watch?v=6k6aYlKa1tY
https://alison.com/course/emergency-preparedness


 
 

 
 

LU 1.1.5:  
Basic First Aid 
Awareness 

Trainee will be able to: 
• Identify the location and 

importance of the first aid kit in 
the training environment. 

• Provide simple care for minor 
injuries such as cuts, burns, or 
sprains. 

• Recognize when and how to 
seek professional medical help. 

Basic first aid awareness ensures that trainees can respond quickly and safely to 
minor injuries that may occur in a training or workplace environment. Even in computer 
labs or office-based settings, incidents such as small cuts, minor burns from 
equipment, headaches, or sprains can happen unexpectedly. Knowing how to handle 
these situations prevents complications and provides comfort until professional help 
arrives. 
The first and most important step is knowing where the first aid kit is located. Every 
training room should have a clearly labeled kit that contains items such as bandages, 
antiseptic wipes, adhesive tape, burn cream, and gloves. Trainees should familiarize 
themselves with the kit’s location on the first day of training. Understanding what is 
inside the kit helps trainees respond confidently and avoid unnecessary panic. 
Basic care for minor injuries is simple but must be done correctly. Small cuts should be 
washed gently with clean water and covered with a bandage to prevent infection. 
Minor burns can be cooled under clean running water for several minutes to reduce 
pain and swelling. Sprains require rest, elevation, and avoiding further strain. These 
small steps make a big difference in protecting the injured area and supporting quick 
recovery. 
However, trainees must also recognize when a situation requires professional medical 
assistance. If the bleeding does not stop, the burn is large or severe, the person feels 
dizziness or weakness, or the injury involves electrical shock, immediate help must be 
sought. Trainees should never attempt advanced medical procedures. Instead, they 
should notify the trainer or supervisor, who will follow the appropriate emergency 
protocol. 
Basic first aid awareness builds confidence and promotes a supportive learning 
environment. When trainees know how to respond calmly and appropriately, they help 
reduce risk, minimize harm, and maintain a safe atmosphere for everyone. 
Watch / Learn 
Below are useful, beginner-friendly videos and free resources for understanding basic 
first aid. 

1. “Basic First Aid Skills Everyone Should Know” 
https://www.youtube.com/watch?v=O0O-gwZKcYg  

2. “How to Treat Minor Cuts and Scrapes” 
https://www.youtube.com/watch?v=9J1n0bW9Y2o  

https://www.youtube.com/watch?v=O0O-gwZKcYg
https://www.youtube.com/watch?v=9J1n0bW9Y2o


 
 

 
 

 
Module 1.2: Computer & Digital Essentials 
Objective: Gain essential digital literacy by learning the basics of computers, file and folder management, cloud storage, and using 
common devices like printers and scanners. 
 

3. “First Aid for Minor Burns – Step by Step” 
https://www.youtube.com/watch?v=R3X1AHzQ9dY  

4. “First Aid for Sprains and Strains” 
https://www.youtube.com/watch?v=UqvZbFdn2KM  

5. “When to Seek Medical Help – Basic Guide” 
https://www.youtube.com/watch?v=aWl4JvPBDo4  

6. Free course: “First Aid for Beginners – Alison Online” 
https://alison.com/course/basic-first-aid  

 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 1.2.1: 
Introduction to 
Computers & 
Peripherals 

Trainee will be able to: 
• Define a computer and explain 

its basic functions. 
• Identify different types of 

computers (desktop, laptop, 
tablet). 

• Recognize common peripherals 
and their purposes. 

• Understand the role of 
computers in office and 
professional environments. 
 

A computer is an electronic machine that processes information and helps us perform 
tasks such as typing documents, browsing the internet, preparing presentations, 
storing data, and using software for office work. Computers have become essential 
tools in professional environments because they make tasks faster, more accurate, 
and more organized. Every modern workplace—from offices and banks to hospitals 
and businesses—relies on computers for communication, data management, and 
productivity. 
There are different types of computers used for different purposes. A desktop 
computer is commonly used in labs and offices because it is powerful and can run 
heavy applications. A laptop is portable, making it ideal for people who need flexibility 
while working. Tablets are lightweight devices used for reading, browsing, and quick 
tasks. Although they look different, all computers perform four main functions: 
receiving input, processing information, storing data, and producing output. 
Computers work effectively when connected with other devices called peripherals. 
Input devices such as the keyboard, mouse, webcam, and scanner allow users to 
enter information. Output devices like the monitor, speakers, and printer display 
results or produce physical copies. Some peripherals combine multiple functions, such 
as multifunction printers that print, scan, and photocopy. Understanding these devices 

https://www.youtube.com/watch?v=R3X1AHzQ9dY
https://www.youtube.com/watch?v=UqvZbFdn2KM
https://www.youtube.com/watch?v=aWl4JvPBDo4
https://alison.com/course/basic-first-aid


 
 

 
 

helps trainees handle everyday office tasks—connecting a mouse, printing documents, 
scanning IDs, or using a webcam for online meetings. 
Computers and peripherals play a central role in office operations. They help 
employees send emails, prepare reports, store important files, access online tools, and 
communicate with colleagues. Learning about these devices builds confidence, 
reduces mistakes, and prepares trainees for a modern workplace where technology is 
used daily. With this foundation, trainees become more productive, independent, and 
capable of performing professional digital tasks. 
Helpful Free Videos / Online Resources 
What Is a Computer? 
https://www.youtube.com/watch?v=I6Fbh4U75w0  
Types of Computers 
https://www.youtube.com/watch?v=bH1n0AiQK1Q  
Computer Input & Output Devices 
https://www.youtube.com/watch?v=bWmB8bRZbVA  
How Computers Are Used in Offices 
https://www.youtube.com/watch?v=im1eN2bXJ3U  
Free Online Course: Basic Computer Skills (GCF Global) 
https://edu.gcfglobal.org/en/computers  
Free Online Course: Digital Literacy Basics (Microsoft) 
https://learn.microsoft.com/en-us/training/browse/?expanded=digital-literacy  
Free Guide: Introduction to Computers (OpenLearn) 
https://www.open.edu/openlearn/science-maths-technology/introduction-
computers/content-section-0  
Summary 
Understanding what a computer is and how peripherals support it forms the base of 
digital literacy. By learning the types of computers, their basic functions, and the 
purpose of commonly used devices, trainees gain essential skills for handling office 
tasks confidently. This knowledge prepares them to work more efficiently and adapt 
easily to digital tools used in professional environments. 
 

LU 1.2.2:  Trainee will be able to: Effective folder and file management is one of the most important digital skills for any 
office or professional environment. A well-organized computer makes your work faster, 

https://www.youtube.com/watch?v=I6Fbh4U75w0
https://www.youtube.com/watch?v=bH1n0AiQK1Q
https://www.youtube.com/watch?v=bWmB8bRZbVA
https://www.youtube.com/watch?v=im1eN2bXJ3U
https://edu.gcfglobal.org/en/computers
https://learn.microsoft.com/en-us/training/browse/?expanded=digital-literacy
https://www.open.edu/openlearn/science-maths-technology/introduction-computers/content-section-0
https://www.open.edu/openlearn/science-maths-technology/introduction-computers/content-section-0


 
 

 
 

Folder 
Management, 
File Formats, 
PDF, ZIP, 
Cloud Storage 
(Google Drive/ 
OneDrive) 

• Understand folder and file 
organization principles. 

• Identify common file formats 
and their uses (e.g., DOCX, 
XLSX, PDF, JPG, PNG, ZIP). 

• Learn how to compress files 
into ZIP format. 

• Understand the basics of cloud 
storage and use Google Drive / 
OneDrive for file management. 
 

reduces mistakes, and ensures that important documents are always easy to find. 
Folder management simply means creating a clear structure—using folders, 
subfolders, and proper file names—so that everything stays in order. For example, a 
trainee may keep separate folders for assignments, images, certificates, or office 
documents. Good organization also helps prevent accidental deletion, duplication, or 
confusion when working on shared systems. 
Understanding file formats is equally important. Different formats serve different 
purposes. DOCX is used for Word documents, XLSX for spreadsheets, and PPTX for 
presentations. JPG and PNG are image formats, where JPG is best for photos and 
PNG is better for graphics with transparency. PDF is widely used for final documents 
because it keeps the layout the same on every device. ZIP files are used to compress 
large files or multiple files into a single package, making them easier to store or share. 
Learning how to create and extract ZIP files helps trainees manage storage space and 
send files more efficiently. 
Cloud storage—such as Google Drive and OneDrive—has become essential in 
modern workplaces. Cloud platforms allow you to save files online instead of only on 
your computer, so you can access them from any device. They also make it easy to 
share files with others, collaborate on documents, and keep backups in case your 
computer is damaged or lost. Basic tasks include uploading files, creating folders, 
sharing links, and organizing work just like you would on a local computer. For office 
assistants, using cloud storage is a standard digital literacy skill that improves 
teamwork and workflow. 
Helpful Free Videos / Online Resources 
Understanding File & Folder Organization 
https://www.youtube.com/watch?v=Wvvx6bRIpKg  
File Types & Formats Explained 
https://www.youtube.com/watch?v=Q-8_p7LM3a8  
How to Create ZIP Files & Extract ZIP Files 
https://www.youtube.com/watch?v=dS4nT0Y8VJk  
Google Drive Basics for Beginners 
https://www.youtube.com/watch?v=HtisSMnZy8k  
OneDrive for Beginners (Uploading, Sharing, Organizing) 
https://www.youtube.com/watch?v=ZcC1m0c1S0E  

https://www.youtube.com/watch?v=Wvvx6bRIpKg
https://www.youtube.com/watch?v=Q-8_p7LM3a8
https://www.youtube.com/watch?v=dS4nT0Y8VJk
https://www.youtube.com/watch?v=HtisSMnZy8k
https://www.youtube.com/watch?v=ZcC1m0c1S0E


 
 

 
 

Free Online Courses / Guides 
Google Workspace Learning Center – Google Drive Basics 
https://support.google.com/a/users/answer/9310243  
Microsoft OneDrive Training 
https://support.microsoft.com/en-us/office/onedrive-video-training-6b26de57-5e0b-
4b96-bfe1-5b34c039595e  
GCFLearnFree: Computer Basics & File Management 
https://edu.gcfglobal.org/en/topics/computers/ 
Summary 
Folder and file management helps trainees stay organized, work faster, and avoid 
mistakes. Knowing the purpose of common file formats like PDF, JPG, PNG, and ZIP 
is essential in any office environment. Learning how to compress files, organize 
folders, and use cloud storage platforms such as Google Drive and OneDrive prepares 
trainees for modern digital workflows. With these skills, trainees build strong digital 
foundations that support efficiency, collaboration, and professional growth. 
 

LU 1.2.3: 
Printer, Scanner, 
Screenshot 

Trainee will be able to: 
• Understand the basic functions 

of printers and scanners. 
• Learn how to operate a printer 

and scanner in an office 
environment. 

• Capture screenshots and use 
them in documents and 
presentations. 

• Recognize practical use cases 
for printing, scanning, and 
screenshots. 

Understanding Printers, Scanners & Screenshots 
Printers and scanners are essential office peripherals used for creating or capturing 
documents. 
A printer produces a physical copy of digital documents such as letters, reports, 
certificates, and photos. Common printer types include inkjet and laser printers. Office 
settings mostly use laser printers due to their speed and lower printing cost per page. 
A scanner converts physical documents into digital images or PDFs. Scanning is 
commonly used for record-keeping, emailing documents, or uploading assignments 
and forms. 
A screenshot is an image captured directly from your computer screen. Screenshots 
are helpful for creating tutorials, reporting errors, saving online information, or inserting 
visuals into documents and presentations. 
Operating Printers and Scanners 
Trainees learn how to: 

• Connect a printer (USB or Wi-Fi) and install its drivers. 
• Use basic printing settings such as page size, number of copies, and 

color/B&W. 

https://support.google.com/a/users/answer/9310243
https://support.microsoft.com/en-us/office/onedrive-video-training-6b26de57-5e0b-4b96-bfe1-5b34c039595e
https://support.microsoft.com/en-us/office/onedrive-video-training-6b26de57-5e0b-4b96-bfe1-5b34c039595e
https://edu.gcfglobal.org/en/topics/computers/


 
 

 
 

• Scan documents using built-in software or apps like Windows Scan. 
• Save scanned files in formats such as PDF, JPG, or PNG. 
• Troubleshoot common issues (low ink, paper jam, offline printer). 

Screenshot Skills: 
• Capture screenshots using PrtScn, Windows + Shift + S, or built-in tools like 

Snipping Tool. 
• Paste or save screenshots into Word, PowerPoint, or image folders. 
• Organize and label screenshots for training material or office documentation. 

Practical Applications 
In a real office environment, these functions are used for: 

• Printing letters, memos, reports, certificates, invoices. 
• Scanning documents for email submissions or digital record-keeping. 
• Using screenshots to document steps during troubleshooting or preparing 

manuals. 
• Sharing visual information quickly with colleagues or clients. 

Helpful Free Videos / Online Resources 
• How to Use a Printer (Beginner Guide) – YouTube 

https://www.youtube.com/watch?v=zl-dDq7vA3M  
• How to Scan Documents – YouTube 

https://www.youtube.com/watch?v=4C2Wn3Qps44  
• How to Take Screenshots on Windows – YouTube 

https://www.youtube.com/watch?v=LOjQ1zKq4Sg  
Free Online Resources: 

• Windows Printing & Scanning Guide 
https://support.microsoft.com/en-us/windows 

• Google Workspace: Printing & Scanning Basics 
https://support.google.com/ 

Summary 
This learning unit introduced printers, scanners, and screenshot tools commonly used 
in office environments. Trainees learned how to print documents, scan physical pages 
into digital format, and capture screenshots for reporting or documentation. By the end 
of this unit, learners should feel confident performing these essential office tasks 
efficiently. 

https://www.youtube.com/watch?v=zl-dDq7vA3M
https://www.youtube.com/watch?v=4C2Wn3Qps44
https://www.youtube.com/watch?v=LOjQ1zKq4Sg
https://support.microsoft.com/en-us/windows
https://support.google.com/


 
 

 
 

Module 2: Operating Systems, Email & Internet 
Objective: Develop the ability to install and configure operating systems, manage user accounts and security, and effectively use email, 
browsers, and online tools. 
 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 2.1:  
Install OS & 
Drivers 

Trainee will be able to: 
• Understand the purpose of an 

operating system (OS) and 
device drivers. 

• Learn the process of installing a 
Windows OS (or other office-
standard OS). 

• Install necessary drivers for 
hardware components and 
peripherals. 

• Ensure the system is ready for 
office tasks with functional 
hardware and software. 

Understanding Operating Systems & Drivers 
An operating system (OS) is the primary software that manages computer hardware, 
software, and resources. It allows users to interact with the computer and run 
applications. Common office-standard OS include Windows 10/11, Linux 
distributions, and macOS. 
Device drivers are programs that allow the OS to communicate with hardware 
components like printers, graphics cards, network adapters, and scanners. Without 
proper drivers, hardware may not function correctly. 
Installing an OS and drivers correctly ensures that your computer is fully functional and 
ready for professional or office tasks. 
Step-by-Step Practical Tasks 
Task 1: Installing Windows OS 

1. Backup all important data from your device. 
2. Create a bootable USB drive with the Windows OS installer using tools like 

Rufus. 
3. Insert the USB and restart the computer. Enter BIOS/UEFI to set USB as the 

primary boot device. 
4. Follow on-screen instructions to: 

o Select language and region. 
o Choose installation type (Upgrade or Custom). 
o Partition the drive if needed. 

5. Complete the installation and create a user account. 
Task 2: Installing Device Drivers 

1. Identify hardware devices that require drivers (sound, graphics, network, 
printer). 

2. Use the manufacturer’s website or the driver CD to download the latest 
drivers. 

3. Run the installation files and follow prompts. 



 
 

 
 

4. Restart the system if required. 
5. Verify driver installation via Device Manager: no device should show a warning 

icon. 
Task 3: Preparing the System for Office Use 

• Update Windows via Settings → Update & Security → Windows Update. 
• Install basic office software (Word, Excel, PowerPoint). 
• Connect and test peripherals such as keyboard, mouse, printer, and scanner. 
• Set up antivirus and firewall for security. 

Practical Applications 
• Ensures computers in offices are ready for daily tasks. 
• Allows smooth communication and software use. 
• Prevents hardware issues due to missing drivers. 
• Prepares systems for email, browsing, and online collaboration tools. 

Helpful Free Videos / Online Resources 
• How to Install Windows 10 / 11 – YouTube 

https://www.youtube.com/watch?v=8FJ5rZbXuzM  
• Installing Device Drivers on Windows – YouTube 

https://www.youtube.com/watch?v=2TX6m91bGkE  
• Windows 10/11 Setup Guide – Microsoft Docs 

https://support.microsoft.com/en-us/windows 
• Free Course: Computer Fundamentals – Alison 

https://alison.com/course/digital-literacy-for-computers  
Summary 
This learning unit teaches trainees the fundamentals of installing operating systems 
and drivers to make computers ready for professional use. Trainees learn to set up 
Windows OS, install essential drivers, and configure the system for office tasks. Proper 
OS and driver setup ensures all hardware functions correctly, providing a smooth and 
secure digital workspace. 
 

LU 2.2:  Create 
User Accounts 
& Configure 
Defender 

Trainee will be able to: 
• Understand the importance of 

user accounts and permissions 
in an office environment. 

Understanding User Accounts & System Security 
User accounts help organize computer access and protect sensitive information. In 
office environments, different users may require different levels of access. For 
example: 

https://www.youtube.com/watch?v=8FJ5rZbXuzM
https://www.youtube.com/watch?v=2TX6m91bGkE
https://support.microsoft.com/en-us/windows
https://alison.com/course/digital-literacy-for-computers


 
 

 
 

• Learn to create and manage 
multiple user accounts on 
Windows OS. 

• Configure Windows Defender 
(or equivalent antivirus) to 
protect the system. 

• Implement basic security 
measures for safe computing. 

• Administrator accounts can install software, change settings, and manage 
other users. 

• Standard accounts are limited to basic tasks like using applications and 
browsing files. 

Proper user account management ensures that only authorized individuals can make 
critical changes, reducing security risks and protecting data. 
Windows Defender is a built-in antivirus and security tool that helps protect the 
system from viruses, malware, and phishing attacks. Configuring Defender correctly is 
crucial for maintaining a safe and stable office environment. 
Step-by-Step Practical Tasks 
Task 1: Creating & Managing User Accounts 

1. Open Settings → Accounts → Family & other users. 
2. Click Add someone else to this PC. 
3. Choose to add a Microsoft account or a local account. 
4. Assign account type: 

o Administrator → full access 
o Standard → limited access 

5. Set a strong password and security questions. 
6. Verify account creation by switching users or logging in. 

Tips for Office Environments: 
• Create individual accounts for each staff member. 
• Avoid sharing admin passwords. 
• Use descriptive names for clarity (e.g., John.Smith). 

Task 2: Configuring Windows Defender 
1. Open Settings → Update & Security → Windows Security → Virus & threat 

protection. 
2. Ensure Real-time protection is ON. 
3. Run a quick scan to check for threats. 
4. Update virus definitions regularly. 
5. Configure Ransomware protection for sensitive folders. 
6. Review and adjust firewall settings for added security. 

Best Practices: 
• Schedule regular scans. 



 
 

 
 

• Avoid downloading unknown files or clicking suspicious links. 
• Keep Windows and antivirus software updated. 

Practical Applications 
• Protects office systems from malware and unauthorized access. 
• Ensures data integrity and privacy for employees and clients. 
• Allows safe multitasking by providing separate accounts for different users. 
• Reduces risk of accidental system changes by limiting standard account 

permissions. 
Helpful Free Videos / Online Resources 

• How to Create User Accounts on Windows 10/11 – YouTube 
https://www.youtube.com/watch?v=J8TmT8i8F6E  

• Windows Defender Tutorial – YouTube 
https://www.youtube.com/watch?v=a8x85jUbG1Y  

• Windows Security & Defender Guide – Microsoft Docs 
https://support.microsoft.com/en-us/windows 

• Free Course: Digital Literacy – Microsoft Learn 
https://learn.microsoft.com/en-us/training/paths/digital-literacy/  

Summary 
This learning unit equips trainees with the skills to create and manage user accounts 
and configure Windows Defender for safe computing. By properly managing accounts 
and security settings, trainees ensure office systems are protected, data is secure, and 
users can work efficiently in a controlled, professional environment. 
 

LU 2.3:  
Email, Browsing 
& Downloads, 
Knowledge of 
other Email 
Clients 

Trainee will be able to: 
• Understand the basics of email 

communication and etiquette. 
• Learn to set up, send, receive, 

and manage emails. 
• Use web browsers efficiently for 

research and office tasks. 
• Download files safely and 

manage downloaded content. 

Email is a primary tool for professional communication, allowing fast and documented 
messaging. Effective email use includes composing clear messages, using proper 
etiquette, attaching files correctly, and organizing emails into folders. 
Web browsers are tools to access information on the internet. Browsers like Chrome, 
Edge, or Firefox allow users to search for documents, access web-based 
applications, and download resources. Safe browsing practices and understanding 
how to manage downloads prevent malware infections and maintain system efficiency. 
Other email clients such as Microsoft Outlook, Mozilla Thunderbird, and Gmail 
provide additional features like calendar integration, task management, offline access, 

https://www.youtube.com/watch?v=J8TmT8i8F6E
https://www.youtube.com/watch?v=a8x85jUbG1Y
https://support.microsoft.com/en-us/windows
https://learn.microsoft.com/en-us/training/paths/digital-literacy/


 
 

 
 

• Gain awareness of alternative 
email clients and their features 
(e.g., Outlook, Thunderbird, 
Gmail). 

and enhanced security. Awareness of these clients helps trainees adapt to different 
professional environments. 
Step-by-Step Practical Tasks 
Task 1: Setting Up & Managing Email 

1. Create an email account on Gmail, Outlook, or another provider. 
2. Send an email with proper subject line, body text, and attachment. 
3. Reply, forward, and organize emails into folders. 
4. Apply email etiquette: 

o Use professional greetings and closings. 
o Keep messages concise and clear. 
o Avoid excessive use of CC/BCC. 

Task 2: Browsing & Safe Downloads 
1. Open a browser (Chrome, Edge, or Firefox). 
2. Search for information relevant to office tasks using keywords. 
3. Download files safely: 

o Only download from trusted websites. 
o Check file type and scan for viruses. 
o Organize downloads into folders for easy access. 

4. Use bookmarks and browser history efficiently to navigate frequently used sites. 
Task 3: Exploring Other Email Clients 

1. Install or access alternative email clients like Outlook or Thunderbird. 
2. Compare features such as: 

o Calendar and task integration. 
o Offline email access. 
o Enhanced security and spam filtering. 

3. Choose the client best suited for your professional needs. 
Practical Applications 

• Communicate with colleagues, clients, and management efficiently. 
• Perform online research and access cloud resources safely. 
• Download and manage files in an organized manner. 
• Adapt to different email clients depending on office or project requirements. 

Helpful Free Videos / Online Resources 



 
 

 
 

 
Module 3: MS Word & Document Processing, Google Docs 
Objective: Acquire skills to create, edit, format, and secure professional documents using MS Word and Google Docs, including tables, 
references, and page setup. 
 

• How to Use Gmail – YouTube 
https://www.youtube.com/watch?v=fMPNnsY-7eQ  

• Microsoft Outlook Tutorial – YouTube 
https://www.youtube.com/watch?v=WkYzR7H9J9I  

• Safe Browsing & Download Practices – YouTube 
https://www.youtube.com/watch?v=6y8gJtVQ1N0  

• Free Course: Email and Internet Basics – Alison 
https://alison.com/course/digital-literacy-for-e-mail-and-internet  

• Free Course: Web Browsing Essentials – Microsoft Learn 
https://learn.microsoft.com/en-us/training/modules/browse-web  

Summary 
This learning unit teaches trainees how to effectively use email, browsers, and 
downloads while understanding alternative email clients. By following safe practices 
and proper communication etiquette, trainees can perform professional digital tasks 
efficiently, maintain system security, and adapt to various office environments. 
 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 3.1:  
Word 
Navigation, 
Editing, 
Formatting 

Trainee will be able to: 
• Navigate Microsoft Word 

interface effectively. 
• Perform basic editing tasks 

including cut, copy, paste, 
undo/redo. 

• Apply formatting to text, 
paragraphs, and documents for 
professional presentation. 

Understanding MS Word & Document Editing 
Microsoft Word is a widely used word processor that allows users to create, edit, and 
format documents for professional, academic, and personal purposes. It provides tools 
to structure content, apply consistent formatting, and enhance readability. 
Basic editing skills such as cut, copy, paste, undo, and redo are essential for 
efficiently modifying text. Formatting tools—including font styles, sizes, colors, 
paragraph alignment, line spacing, bullets, and numbering—help present 
information clearly and professionally. 
Structured documents using styles allow consistent headings, subheadings, and body 
text, making large documents easier to read and navigate. 
Step-by-Step Practical Tasks 

https://www.youtube.com/watch?v=fMPNnsY-7eQ
https://www.youtube.com/watch?v=WkYzR7H9J9I
https://www.youtube.com/watch?v=6y8gJtVQ1N0
https://alison.com/course/digital-literacy-for-e-mail-and-internet
https://learn.microsoft.com/en-us/training/modules/browse-web


 
 

 
 

• Use styles, bullets, numbering, 
and alignment features for 
structured documents. 
 

Task 1: Navigating the Word Interface 
1. Open Microsoft Word or Google Docs. 
2. Familiarize yourself with the ribbon menu, including Home, Insert, Layout, 

References, and Review tabs. 
3. Locate common features: font selection, text size, alignment, and paragraph 

spacing. 
4. Explore document views: Print Layout, Web Layout, and Read Mode. 

Task 2: Editing Documents 
1. Type sample text. 
2. Use cut, copy, paste to move or duplicate content. 
3. Apply undo/redo to correct mistakes. 
4. Use Find and Replace for quick text changes. 

Task 3: Formatting Documents 
1. Apply bold, italics, underline, and font color to highlight text. 
2. Adjust paragraph alignment (left, center, right, justify) and line spacing. 
3. Create numbered lists and bulleted lists. 
4. Use Styles for headings, subheadings, and normal text. 

Practical Applications 
• Preparing professional letters, reports, and proposals. 
• Structuring multi-page documents for readability. 
• Enhancing presentation with formatting, lists, and headings. 
• Applying skills in both MS Word and Google Docs environments. 

Helpful Free Videos / Online Resources 
• Microsoft Word Basics – YouTube 

https://www.youtube.com/watch?v=Q3bqBz3GfXs  
• Word Formatting Tips for Beginners – YouTube 

https://www.youtube.com/watch?v=9X3R-zlQebM  
• Google Docs Tutorial – YouTube 

https://www.youtube.com/watch?v=eG7lAZR8jDk  
• Free Course: Microsoft Word 2016 – Alison 

https://alison.com/course/diploma-in-microsoft-word-2016  
• Free Resource: Google Docs Learning Center 

https://support.google.com/docs/ 
  Summary 

https://www.youtube.com/watch?v=Q3bqBz3GfXs
https://www.youtube.com/watch?v=9X3R-zlQebM
https://www.youtube.com/watch?v=eG7lAZR8jDk
https://alison.com/course/diploma-in-microsoft-word-2016
https://support.google.com/docs/


 
 

 
 

This learning unit teaches trainees to navigate Microsoft Word, edit text efficiently, and 
apply professional formatting. Using styles, lists, and alignment features, trainees can 
create clear, structured, and polished documents suitable for office, academic, or 
professional use. These skills are transferable to Google Docs, enhancing versatility in 
document processing tasks. 
 

LU 3.2:  
Tables, 
Sections, 
References 

Trainee will be able to: 
• Create and format tables to 

organize data in Word 
documents. 

• Use sections to manage page 
layouts and different formatting 
styles. 

• Insert and manage references 
such as footnotes, endnotes, 
captions, and citations. 

• Apply these tools to produce 
professional, structured 
documents. 

Understanding Tables, Sections & References 
Tables are a key feature in Word that allow users to organize text, numbers, and other 
content into rows and columns. Proper use of tables improves readability and data 
presentation. 
Sections enable different parts of a document to have unique formatting, such as 
varying headers, footers, page orientation, or margins. This is particularly useful for 
reports, manuals, or multi-chapter documents. 
References like footnotes, endnotes, captions, and citations help document sources, 
add explanations, and maintain professionalism. Properly managing references is 
essential in academic, business, and technical documents. 
Step-by-Step Practical Tasks 
Task 1: Creating & Formatting Tables 

1. Go to Insert → Table and select the desired number of rows and columns. 
2. Enter data into table cells. 
3. Adjust table properties: 

o Column width and row height 
o Text alignment and cell margins 
o Table borders and shading for clarity 

4. Apply table styles for a professional look. 
Task 2: Using Sections 

1. Place the cursor where a new section is needed. 
2. Go to Layout → Breaks → Section Breaks. 
3. Choose Next Page, Continuous, or other options based on need. 
4. Modify headers, footers, page orientation, or margins in each section 

independently. 
Task 3: Managing References 

1. Footnotes & Endnotes: 



 
 

 
 

o Place cursor at reference point → References → Insert 
Footnote/Endnote 

o Type your note and let Word number automatically. 
2. Captions for Figures & Tables: 

o Select object → References → Insert Caption 
o Add label (e.g., Table, Figure) and numbering. 

3. Citations & Bibliography: 
o References → Insert Citation → Add New Source 
o Generate a bibliography automatically using Word’s citation tools. 

Practical Applications 
• Organizing data in reports, invoices, or research papers. 
• Applying different layouts or formatting styles in multi-section documents. 
• Properly citing sources and labeling tables/figures for professional or academic 

purposes. 
• Enhancing document readability and credibility. 

Helpful Free Videos / Online Resources 
• Microsoft Word Tables Tutorial – YouTube 

https://www.youtube.com/watch?v=n5GokNIXD0U  
• Word Sections & Page Layout Tips – YouTube 

https://www.youtube.com/watch?v=jf04RwIczhw  
• Footnotes, Endnotes & Citations in Word – YouTube 

https://www.youtube.com/watch?v=3X9OB5yrkMk  
• Free Course: Microsoft Word Intermediate – Alison 

https://alison.com/course/microsoft-word-intermediate  
• Free Guide: Google Docs – Tables, Headers, References 

https://support.google.com/docs/ 
  Summary 
This learning unit equips trainees to use tables, sections, and references effectively in 
Word and Google Docs. By mastering these tools, trainees can produce well-
organized, professional, and academically or business-ready documents that are 
structured, clear, and visually consistent. 
 

https://www.youtube.com/watch?v=n5GokNIXD0U
https://www.youtube.com/watch?v=jf04RwIczhw
https://www.youtube.com/watch?v=3X9OB5yrkMk
https://alison.com/course/microsoft-word-intermediate
https://support.google.com/docs/


 
 

 
 

LU 3.3:  
Page Setup, 
Security 

Trainee will be able to: 
• Configure page setup options 

including margins, orientation, 
size, and layout. 

• Apply headers, footers, and 
page numbering appropriately. 

• Understand document security 
features in Word and PDF. 

• Protect documents with 
passwords and restrict editing 
for professional use. 

Understanding Page Setup & Document Security 
Proper page setup ensures that documents are visually consistent, professional, and 
suitable for printing or digital sharing. Configuring margins, orientation, size, and 
layout allows content to fit the page appropriately, improving readability and 
presentation. 
Headers and footers provide consistent information across pages, such as document 
titles, dates, page numbers, or author names. Page numbering helps organize multi-
page documents and is essential in reports, manuals, and formal submissions. 
Document security protects sensitive information. Word and PDF files allow password 
protection, restricting editing, and limiting access, ensuring that only authorized 
personnel can view or modify documents. This is crucial for professional, academic, or 
confidential materials. 
Step-by-Step Practical Tasks 
Task 1: Configuring Page Setup 

1. Go to Layout → Margins and select predefined or custom margins. 
2. Set orientation: Portrait or Landscape. 
3. Adjust paper size according to standards (A4, Letter, etc.). 
4. Use Layout → Columns for multi-column documents if needed. 

Task 2: Adding Headers, Footers & Page Numbers 
1. Go to Insert → Header/Footer and select a style. 
2. Add text such as document title, author, or date. 
3. Insert page numbers in header, footer, or margin. 
4. Use different headers/footers for sections if required. 

Task 3: Securing Documents 
1. Word Security Options: 

o File → Info → Protect Document → Encrypt with Password 
o Restrict editing: Restrict Editing → Limit formatting & editing 

2. PDF Security: 
o Export Word document as PDF: File → Save As → PDF 
o Use PDF tools (Adobe Acrobat, online PDF editors) to add password or 

restrict editing. 
3. Ensure strong, memorable passwords and share only with authorized 

recipients. 



 
 

 
 

 
Module 4: Excel, PowerPoint & Collaboration, Google Docs 
Objective: Build proficiency in Excel for data management and visualization, create impactful presentations in PowerPoint, and collaborate 
effectively using Google and online meeting tools. 
 
 
 
 

Practical Applications 
• Prepare professional reports, manuals, and official documents with proper 

formatting. 
• Ensure multi-page documents are organized with consistent headers, footers, 

and page numbers. 
• Protect sensitive documents from unauthorized access or editing. 
• Maintain confidentiality and professionalism in office and academic 

environments. 
Helpful Free Videos / Online Resources 

• Microsoft Word Page Setup Tutorial – YouTube 
https://www.youtube.com/watch?v=JqQ_5KzTY8Q  

• Adding Headers, Footers & Page Numbers in Word – YouTube 
https://www.youtube.com/watch?v=5_zOgF_j4xM  

• Word Document Security & Password Protection – YouTube 
https://www.youtube.com/watch?v=Xd9pIDSTFHU  

• Free Course: Microsoft Word Advanced – Alison 
https://alison.com/course/microsoft-word-advanced  

• Free Guide: Google Docs Page Setup & Security 
https://support.google.com/docs/ 

  Summary 
This learning unit equips trainees with skills to set up professional page layouts, add 
headers, footers, and page numbers, and secure documents against unauthorized 
access. By mastering these tools, trainees ensure that documents are well-formatted, 
professional, and protected, suitable for both print and digital distribution. 
 

https://www.youtube.com/watch?v=JqQ_5KzTY8Q
https://www.youtube.com/watch?v=5_zOgF_j4xM
https://www.youtube.com/watch?v=Xd9pIDSTFHU
https://alison.com/course/microsoft-word-advanced
https://support.google.com/docs/


 
 

 
 

 
Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 4.1:  
Excel Data 
Entry, 
Formatting, 
Functions, 
Charts, Pivot 
Table 

Trainee will be able to: 
• Navigate Microsoft Excel 

interface efficiently. 
• Enter and organize data in 

spreadsheets. 
• Apply formatting to cells, rows, 

columns, and worksheets for 
clarity. 

• Use basic and intermediate 
functions (SUM, AVERAGE, 
COUNT, IF). 

• Create charts and pivot tables 
to visualize and summarize 
data effectively. 
 

Understanding Excel for Data Management 
Excel is a powerful tool for organizing, analyzing, and presenting data. Proper data 
entry ensures accuracy and ease of analysis. Formatting cells, rows, columns, and 
worksheets makes data readable and professional. Functions like SUM, AVERAGE, 
COUNT, and IF allow trainees to perform calculations quickly and gain insights from 
data. Charts and pivot tables help visualize trends, compare values, and summarize 
complex datasets efficiently. 
Step-by-Step Practical Tasks 
Task 1: Data Entry and Organization 

1. Open Excel and select a new workbook. 
2. Enter data in rows and columns, keeping headers clear and concise. 
3. Use Freeze Panes to keep headers visible while scrolling: View → Freeze 

Panes. 
4. Sort and filter data to organize information efficiently: Data → Sort & Filter. 

Task 2: Formatting Worksheets 
1. Apply cell formatting: font type, size, color, and alignment. 
2. Format numbers, dates, and currency using the Number Format options. 
3. Use borders and shading to distinguish headers and sections. 
4. Adjust column width and row height for readability. 

Task 3: Using Functions 
1. SUM: =SUM(A2:A10) – adds values in selected cells. 
2. AVERAGE: =AVERAGE(B2:B10) – calculates average. 
3. COUNT: =COUNT(C2:C10) – counts numeric entries. 
4. IF: =IF(D2>50,"Pass","Fail") – conditional logic for decisions. 

Task 4: Creating Charts 
1. Select the data range and go to Insert → Charts. 
2. Choose chart type: Column, Line, Pie, Bar, etc. 
3. Customize chart elements: titles, axis labels, colors, and legends. 

Task 5: Pivot Tables 
1. Select your data range → Insert → PivotTable. 
2. Drag fields to Rows, Columns, Values, and Filters areas. 



 
 

 
 

3. Summarize and analyze data dynamically without altering the original dataset. 
 Practical Applications 

• Organize office data such as sales, inventory, attendance, or budgets. 
• Generate reports and summaries using functions and pivot tables. 
• Visualize trends, comparisons, and patterns with charts for presentations or 

decision-making. 
• Maintain professional, clean, and accurate spreadsheets suitable for business 

or academic use. 
Helpful Free Videos / Online Resources 

• Excel Data Entry & Formatting Basics – YouTube 
https://www.youtube.com/watch?v=rwbho0CgEAE 

• Excel Functions Tutorial (SUM, AVERAGE, COUNT, IF) – YouTube 
https://www.youtube.com/watch?v=9NUjHBNWe9M 

• Creating Charts in Excel – YouTube 
https://www.youtube.com/watch?v=5w0KEjbtbSk  

• Pivot Table Tutorial for Beginners – YouTube 
https://www.youtube.com/watch?v=9NUjHBNWe9M 

• Free Course: Microsoft Excel – Excel for Beginners – Alison 
https://alison.com/course/microsoft-excel-for-beginners  

• Google Sheets Basics – Free Guide 
https://support.google.com/docs/ 

Summary 
This learning unit equips trainees with essential Excel skills for data entry, formatting, 
functions, charts, and pivot tables. Mastering these tools allows trainees to organize, 
analyze, and visualize data efficiently, producing professional spreadsheets suitable 
for office, academic, and business environments. 
 

LU 4.2:  
PowerPoint 
Slides, 
Animations 

Trainee will be able to: 
• Navigate the Microsoft 

PowerPoint interface efficiently. 
• Create, edit, and format slides 

for professional presentations. 

Understanding PowerPoint for Professional Presentations 
Microsoft PowerPoint is a powerful tool for creating professional, visually appealing 
presentations. Good slide design improves audience engagement, clarity, and 
retention of information. Applying layouts, themes, and design consistency ensures 
that presentations look polished and maintain a professional appearance. Animations 

https://www.youtube.com/watch?v=rwbho0CgEAE
https://www.youtube.com/watch?v=9NUjHBNWe9M
https://www.youtube.com/watch?v=5w0KEjbtbSk
https://www.youtube.com/watch?v=9NUjHBNWe9M
https://alison.com/course/microsoft-excel-for-beginners
https://support.google.com/docs/


 
 

 
 

• Apply slide layouts, themes, 
and design consistency. 

• Use animations and transitions 
to enhance slide delivery. 

• Integrate multimedia elements 
like images, audio, and video. 

and transitions add dynamics and can emphasize important points, while multimedia 
elements like images, audio, and video enrich content delivery. 
Step-by-Step Practical Tasks 
Task 1: Navigating PowerPoint 

1. Open PowerPoint and familiarize yourself with the Ribbon, Slide Pane, and 
Notes Section. 

2. Learn to switch between Normal, Slide Sorter, and Reading View. 
3. Customize the Quick Access Toolbar for commonly used commands. 

Task 2: Creating and Formatting Slides 
1. Use Home → New Slide to add slides. 
2. Choose appropriate slide layouts (Title, Title & Content, Two Content, Blank). 
3. Apply Themes under Design → Themes for a consistent look. 
4. Format text with font type, size, color, and alignment. 
5. Adjust background styles or use images as slide backgrounds. 

Task 3: Using Animations & Transitions 
1. Select an object (text, shape, or image) → Animations → Add Animation. 
2. Choose entrance, emphasis, or exit animations. 
3. Apply transition effects between slides: Transitions → Choose Effect. 
4. Adjust duration and timing for smooth presentation flow. 

Task 4: Integrating Multimedia 
1. Insert images: Insert → Pictures → From File or Online. 
2. Add audio: Insert → Audio → Audio on My PC or Record Audio. 
3. Add video: Insert → Video → Online Video or Video on My PC. 
4. Resize, move, and format multimedia elements for visual balance. 

Practical Applications 
• Prepare impactful presentations for office meetings, academic lectures, and 

business pitches. 
• Maintain visual consistency and professionalism across slides. 
• Enhance engagement using animations, transitions, and multimedia. 
• Deliver information clearly, emphasizing key points and supporting visuals. 

Helpful Free Videos / Online Resources 
• PowerPoint Basics & Slide Design – YouTube 

https://www.youtube.com/watch?v=XF34-Wu6qWU 

https://www.youtube.com/watch?v=XF34-Wu6qWU


 
 

 
 

• PowerPoint Animations & Transitions Tutorial – YouTube 
https://www.youtube.com/watch?v=rvvGsa6vxgk  

• Inserting Multimedia in PowerPoint – YouTube 
https://www.youtube.com/watch?v=rglkF5kFPOk  

• Free Course: Microsoft PowerPoint – Alison 
https://alison.com/course/diploma-in-powerpoint  

• Google Slides Basics – Free Guide 
https://support.google.com/docs/ 

Summary 
This learning unit equips trainees with the skills to create, format, and deliver 
professional presentations using PowerPoint. By mastering slide layouts, themes, 
animations, transitions, and multimedia integration, trainees can produce visually 
engaging and organized presentations suitable for workplace, academic, or business 
settings. 
 

LU 4.3:  
Google Forms, 
Google Meet, 
Zoom, and 
Microsoft Teams 
for Online 
Meetings 

Trainee will be able to: 
• Understand the purpose and 

applications of online 
collaboration and meeting tools. 

• Create and manage Google 
Forms for surveys, quizzes, and 
data collection. 

• Schedule, host, and participate 
in online meetings using Google 
Meet, Zoom, and Microsoft 
Teams. 

• Apply best practices for 
professional online 
communication. 

Understanding Online Collaboration Tools 
Online collaboration and meeting tools are essential for modern workplaces, remote 
learning, and virtual teamwork. They allow individuals and teams to communicate, 
share information, collect data, and collaborate in real time, regardless of location. 
Google Forms helps gather structured data, surveys, or quizzes efficiently, while 
Google Meet, Zoom, and Microsoft Teams enable virtual meetings, discussions, and 
presentations. Understanding these tools ensures professional, smooth, and effective 
online communication. 
Step-by-Step Practical Tasks 
Task 1: Google Forms 

1. Open Google Forms: forms.google.com. 
2. Create a new form and give it a title and description. 
3. Add different question types: Multiple choice, Short answer, Paragraph, 

Checkbox, Dropdown. 
4. Enable required fields, quiz features, or section breaks. 
5. Share the form via link, email, or embed in websites. 
6. Analyze responses in Responses → Summary or export to Google Sheets. 

Task 2: Scheduling and Hosting Online Meetings 

https://www.youtube.com/watch?v=rvvGsa6vxgk
https://www.youtube.com/watch?v=rglkF5kFPOk
https://alison.com/course/diploma-in-powerpoint
https://support.google.com/docs/


 
 

 
 

1. Google Meet: 
o Schedule via Google Calendar → Add Meet link. 
o Join, share screen, mute/unmute, use chat and participant management. 

2. Zoom: 
o Schedule or start instant meetings via Zoom app or web. 
o Use waiting room, screen sharing, breakout rooms, and recording. 

3. Microsoft Teams: 
o Schedule meetings via Teams calendar or Outlook. 
o Manage participants, chat, share files, and collaborate during calls. 

Task 3: Best Practices for Online Meetings 
• Test audio, video, and internet connectivity before joining. 
• Use professional usernames and profile images. 
• Mute microphones when not speaking to reduce noise. 
• Share documents and screens clearly; highlight important points. 
• Record meetings when necessary for reference or absent participants. 

Practical Applications 
• Conduct virtual office meetings, client calls, and team collaborations efficiently. 
• Collect survey responses, quizzes, and feedback using Google Forms. 
• Share documents, present reports, and collaborate in real time. 
• Maintain professional communication standards during remote work. 

Helpful Free Videos / Online Resources 
• Google Forms Tutorial for Beginners – YouTube 

https://www.youtube.com/watch?v=E3E3hO9QZ0Q  
• Google Meet Basics & Tips – YouTube 

https://www.youtube.com/watch?v=evBv_OlY3rI  
• Zoom Tutorial for Beginners – YouTube 

https://www.youtube.com/watch?v=2gVft59MgGQ  
• Microsoft Teams Tutorial for Beginners – YouTube 

https://www.youtube.com/watch?v=Y5JxKkQKQJ0  
• Free Course: Google Forms & Sheets – Coursera 

https://www.coursera.org/learn/google-forms  
• Free Guide: Online Meetings Best Practices – Microsoft Support 

https://support.microsoft.com/en-us/teams 

https://www.youtube.com/watch?v=E3E3hO9QZ0Q
https://www.youtube.com/watch?v=evBv_OlY3rI
https://www.youtube.com/watch?v=2gVft59MgGQ
https://www.youtube.com/watch?v=Y5JxKkQKQJ0
https://www.coursera.org/learn/google-forms
https://support.microsoft.com/en-us/teams


 
 

 
 

 
Module 5.1: MS Access, Freelancing & Assessment 
Objective: Learn to manage databases using MS Access, perform queries and reporting, and explore freelancing opportunities for applying 
digital skills in the job market. 
 

Summary 
This learning unit equips trainees with the knowledge and skills to use online 
collaboration tools effectively. By mastering Google Forms for data collection and 
Google Meet, Zoom, and Microsoft Teams for meetings, trainees can communicate 
professionally, manage remote teamwork, and maintain productivity in virtual 
environments. 
 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 5.1.1:  
Create Tables, 
Forms, 
Reports in 
Access 

Trainee will be able to: 
• Understand the basics of 

Microsoft Access and relational 
databases. 

• Create and manage tables to 
store structured data. 

• Design forms for user-friendly 
data entry. 

• Generate reports to summarize 
and present data professionally. 

Understanding Microsoft Access 
Microsoft Access is a database management system that allows users to store, 
manage, and analyze structured data efficiently. Access is widely used in offices to 
track records, manage inventories, handle customer data, and generate reports. 
Understanding tables, forms, and reports helps trainees organize data 
systematically, reduce errors, and create professional outputs that can support 
decision-making and reporting. 
Step-by-Step Practical Tasks 
Task 1: Creating Tables 

1. Open Microsoft Access → Blank Database → Name and save your file. 
2. Go to Create → Table. 
3. Add fields (columns) with appropriate data types: Text, Number, Date/Time, 

Currency. 
4. Set Primary Key to uniquely identify records. 
5. Enter sample data to test table structure. 

Task 2: Designing Forms 
1. Go to Create → Form. 
2. Choose Form Layout or Design View. 
3. Add fields from tables for data entry. 
4. Customize form layout, colors, and labels for clarity. 



 
 

 
 

5. Test the form by entering sample data to ensure proper functionality. 
Task 3: Generating Reports 

1. Go to Create → Report. 
2. Select the table or query to base the report on. 
3. Customize report layout: group, sort, and filter data. 
4. Add headings, labels, and formatting for professional presentation. 
5. Preview and export reports to PDF or print as needed. 

Practical Applications 
• Maintain office databases such as employee records, inventory lists, or client 

information. 
• Use forms for accurate and easy data entry without exposing the underlying 

tables. 
• Generate structured reports to present information to management or clients. 
• Improve efficiency and professionalism in office tasks involving data. 

Helpful Free Videos / Online Resources 
• Microsoft Access Basics – YouTube 

https://www.youtube.com/watch?v=5lS6pNY14oU  
• Access Forms Tutorial – YouTube 

https://www.youtube.com/watch?v=FvH5YxG9x4s  
• Access Reports Tutorial – YouTube 

https://www.youtube.com/watch?v=EG4h25iUhko  
• Free Course: Microsoft Access – Alison 

https://alison.com/course/microsoft-access-2016  
• Free Guide: Introduction to Databases – Microsoft Support 

https://support.microsoft.com/en-us/office/introduction-to-access-databases-
0b4f2b70-1c16-4ff6-b3e4-5078a87f3d3f  

Summary 
This learning unit introduces trainees to Microsoft Access, enabling them to create 
structured tables, user-friendly forms, and professional reports. Mastery of these tools 
allows efficient data management, accurate reporting, and improved productivity in 
office or business environments. 
 

LU 5.1.2:  Trainee will be able to: Understanding Data Entry and Queries in Access 

https://www.youtube.com/watch?v=5lS6pNY14oU
https://www.youtube.com/watch?v=FvH5YxG9x4s
https://www.youtube.com/watch?v=EG4h25iUhko
https://alison.com/course/microsoft-access-2016
https://support.microsoft.com/en-us/office/introduction-to-access-databases-0b4f2b70-1c16-4ff6-b3e4-5078a87f3d3f
https://support.microsoft.com/en-us/office/introduction-to-access-databases-0b4f2b70-1c16-4ff6-b3e4-5078a87f3d3f


 
 

 
 

Data Entry & 
Query 
Handling 

• Enter and update data 
efficiently in Microsoft Access 
tables. 

• Understand and apply queries 
to retrieve, filter, and sort data. 

• Use criteria and operators to 
refine query results. 

• Generate meaningful insights 
from database queries. 

Efficient data entry and query handling are fundamental skills for managing databases. 
Microsoft Access allows users to store large amounts of structured information in 
tables, while queries enable retrieval, filtering, and sorting of this data for analysis. By 
mastering these functions, trainees can quickly access the information they need, 
generate insights, and support decision-making in professional environments. 
Step-by-Step Practical Tasks 
Task 1: Efficient Data Entry 

1. Open your Access database and navigate to the relevant table. 
2. Use datasheet view or forms to enter new records. 
3. Edit existing entries carefully to maintain accuracy. 
4. Utilize copy-paste, auto-fill, and tab navigation for speed. 
5. Validate data for consistency and completeness. 

Task 2: Creating and Using Queries 
1. Go to Create → Query Design. 
2. Select the table(s) you want to query. 
3. Add fields to the query grid. 
4. Apply criteria to filter data (e.g., =, >, <, LIKE). 
5. Sort results by one or more fields (ascending/descending). 
6. Run the query to view filtered results. 

Task 3: Advanced Query Techniques 
1. Use wildcards for partial matches (e.g., “A*” for all names starting with A). 
2. Combine criteria using AND/OR operators to refine searches. 
3. Use calculated fields to perform simple calculations within queries. 
4. Save queries for repeated use. 

Practical Applications 
• Maintain accurate client, employee, or inventory records. 
• Retrieve information quickly for reporting or analysis. 
• Generate insights such as totals, averages, and trends from database queries. 
• Support business decisions and improve efficiency in office workflows. 

Helpful Free Videos / Online Resources 
• Microsoft Access Data Entry Tutorial – YouTube 

https://www.youtube.com/watch?v=5v9q6IBgM9Y  

https://www.youtube.com/watch?v=5v9q6IBgM9Y


 
 

 
 

• Access Queries Basics – YouTube 
https://www.youtube.com/watch?v=KZfF0fF9V5E  

• Access Query Criteria & Operators – YouTube 
https://www.youtube.com/watch?v=lUo90FZw-QQ  

• Free Course: Microsoft Access – Alison 
https://alison.com/course/microsoft-access-2016  

• Free Guide: Introduction to Queries in Access – Microsoft Support 
https://support.microsoft.com/en-us/office/create-a-simple-select-query-
9f992f2f-51c4-4b6c-bb36-0d7760df3c82  

Summary 
This learning unit equips trainees with the ability to enter data accurately and use 
queries to extract meaningful information from Microsoft Access databases. By 
efficiently managing and analyzing data, trainees can improve productivity, generate 
reports, and support informed decision-making in professional settings. 
 

LU 5.1.3:  
Freelancing 
Basics (Fiverr, 
Upwork) & 
Online Jobs 

Trainee will be able to: 
• Understand the concept of 

freelancing and online job 
opportunities. 

• Explore popular platforms like 
Fiverr and Upwork for office and 
IT tasks. 

• Learn the process of creating a 
freelancer profile and offering 
services. 

• Identify skills in demand for 
digital and administrative tasks 
online. 

Understanding Freelancing and Online Jobs 
Freelancing is working independently for clients on projects rather than as a full-time 
employee. Online freelancing allows professionals to offer skills globally, manage 
schedules, and earn income remotely. Platforms like Fiverr and Upwork connect 
freelancers with clients needing services such as data entry, MS Office tasks, graphic 
design, digital marketing, and more. Understanding these platforms, creating an 
effective profile, and knowing the skills in demand are essential for success in the 
online job market. 
Step-by-Step Practical Tasks 
Task 1: Exploring Freelancing Platforms 

1. Visit Fiverr (www.fiverr.com) and Upwork (www.upwork.com). 
2. Explore categories for digital, administrative, and IT services. 
3. Observe how freelancers present their skills, portfolio, and pricing. 
4. Identify the most in-demand services for your skillset. 

Task 2: Creating a Freelancer Profile 
1. Sign up with an email or social account. 
2. Complete profile details: name, professional photo, bio, and skills. 
3. Add portfolio samples or examples of previous work. 

https://www.youtube.com/watch?v=KZfF0fF9V5E
https://www.youtube.com/watch?v=lUo90FZw-QQ
https://alison.com/course/microsoft-access-2016
https://support.microsoft.com/en-us/office/create-a-simple-select-query-9f992f2f-51c4-4b6c-bb36-0d7760df3c82
https://support.microsoft.com/en-us/office/create-a-simple-select-query-9f992f2f-51c4-4b6c-bb36-0d7760df3c82
http://www.fiverr.com/
http://www.upwork.com/


 
 

 
 

 
Module 5.2: Entrepreneurship Session 
Objective: Understand the fundamentals of entrepreneurship by exploring idea generation, business planning, financing, and strategies 
to overcome challenges in starting and running a business. 

4. Set services (Gigs on Fiverr) with clear descriptions and pricing. 
5. Highlight your strengths, specialties, and unique selling points. 

Task 3: Understanding Online Work Requirements 
1. Communication: Respond promptly and professionally to clients. 
2. Deadlines: Deliver projects on time to build trust and ratings. 
3. Quality: Ensure work meets client expectations to earn positive reviews. 
4. Payment: Understand platform payment methods and withdrawal procedures. 

Practical Applications 
• Earn income by completing digital or administrative tasks online. 
• Build a professional online portfolio and reputation. 
• Apply office and IT skills in real-world freelance projects. 
• Explore global work opportunities without geographic limitations. 

Helpful Free Videos / Online Resources 
• Introduction to Freelancing – YouTube 

https://www.youtube.com/watch?v=5kqzHf1ICxU  
• How to Start on Fiverr – YouTube 

https://www.youtube.com/watch?v=G6DKD3hKjVY  
• Upwork Beginner’s Guide – YouTube 

https://www.youtube.com/watch?v=VjRBRoX3l8E  
• Free Course: Fiverr Freelancing for Beginners – Alison 

https://alison.com/course/fiverr-freelancing  
• Free Guide: How to Get Started on Upwork – Upwork Help 

https://www.upwork.com/resources/start-freelancing  
Summary 
This learning unit introduces trainees to the world of online freelancing and remote 
work. By exploring platforms like Fiverr and Upwork, creating a professional profile, 
and understanding client expectations, trainees can begin earning income, build a 
portfolio, and apply their digital skills in real-world projects. 
 

https://www.youtube.com/watch?v=5kqzHf1ICxU
https://www.youtube.com/watch?v=G6DKD3hKjVY
https://www.youtube.com/watch?v=VjRBRoX3l8E
https://alison.com/course/fiverr-freelancing
https://www.upwork.com/resources/start-freelancing


 
 

 
 

 
Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 5.2.1: 
Introduction to 
Entrepreneurs
hip 
 
 

Trainee will be able to: 
• Define entrepreneurship and 

explain its importance in today’s 
economy. 

• Identify characteristics of 
successful entrepreneurs. 

• Recognize opportunities where 
entrepreneurial thinking can be 
applied. 

Entrepreneurship is the process of identifying opportunities, taking initiative, and 
creating value through innovative solutions, products, or services. This unit introduces 
trainees to the entrepreneurial mindset, its role in economic development, and how 
individuals can apply entrepreneurial thinking across various fields—including creative 
industries like graphic design, digital marketing, and tech. 
What is Entrepreneurship? 
• Entrepreneurship involves starting or managing a business to solve problems or 
meet market needs. 
• It includes risk-taking, innovation, and resource management. 
• Entrepreneurs drive job creation, economic growth, and social development. 
Why Entrepreneurship Matters Today 
• The global economy values innovation and self-employment. 
• Digital tools have made it easier to start and scale businesses. 
• Freelancers, designers, marketers, and IT professionals often grow into 
entrepreneurs. 
Characteristics of Successful Entrepreneurs 

1. Creativity & Innovation 
Ability to think differently and develop unique solutions. 

2. Risk-Taking Ability 
Willingness to step into uncertainty with confidence. 

3. Persistence & Resilience 
Staying motivated despite challenges or failures. 

4. Strong Communication 
Clear communication with clients, partners, investors, and customers. 

5. Problem-Solving Skills 
Understanding user needs and developing practical solutions. 

6. Leadership & Decision Making 
Ability to lead teams and make timely, effective decisions. 

Recognizing Opportunities 
Entrepreneurship begins with identifying gaps in the market or problems that need 
solving. 



 
 

 
 

Sources of Opportunity 
• Customer pain points 
• Emerging trends (e.g., digital services, e-commerce) 
• Technology and automation 
• Niche markets (e.g., logo design for small businesses) 
• Local community needs 
How to Spot Business Ideas 
• Observe everyday problems 
• Analyze interests and strengths 
• Explore platforms like Fiverr, Upwork, or Daraz to see trending services 
• Conduct basic market research (surveys, social media insights) 
Tips for Developing an Entrepreneurial Mindset 
• Think long-term and take proactive steps. 
• Be open to learning new skills or adapting to change. 
• Network with professionals, mentors, and peers. 
• Embrace experimentation—test ideas on a small scale first. 
Watch / Learn 
• “What is Entrepreneurship?” – Short Explanation 
https://www.youtube.com/watch?v=QEOQzIUbkYw  
• “Top Traits of Successful Entrepreneurs” 
https://www.youtube.com/watch?v=kQw5qH9V8AE  
• “How to Find a Business Idea (Beginner Friendly)” 
https://www.youtube.com/watch?v=bFaoK2GJr5U  
• “Entrepreneurial Mindset for Beginners – Free Course” 
https://www.coursera.org/learn/entrepreneurship-mindset  
 

LU 5.2.2:  
Types of 
Entrepreneurs
hips 

Trainee will be able to: 
• Identify different types of 

entrepreneurship. 
• Explain the characteristics of 

each type with examples. 

Entrepreneurship comes in many forms, depending on the size of the business, the 
goals of the entrepreneur, available resources, and market needs. Understanding 
these types helps trainees choose the right path for their skills and ideas. 
1. Small Business Entrepreneurship 
What it is: 
Businesses started to support a family or local community. These are not built to 
become very large companies. 

https://www.youtube.com/watch?v=QEOQzIUbkYw
https://www.youtube.com/watch?v=kQw5qH9V8AE
https://www.youtube.com/watch?v=bFaoK2GJr5U
https://www.coursera.org/learn/entrepreneurship-mindset


 
 

 
 

• Recognize which type of 
entrepreneurship suits different 
business ideas. 

Examples: 
• Local shops 
• Freelance graphic designers 
• Small digital marketing agencies 
• Beauty salons 
• Repair shops 
Characteristics: 
• Low to medium investment 
• Run by owner and a small team 
• Focus on stable income, not massive expansion 
2. Scalable Startup Entrepreneurship 
What it is: 
Businesses created with the intention to grow fast, attract investors, and scale globally. 
Examples: 
• Software companies 
• Apps like Careem or Airbnb 
• Tech startups 
Characteristics: 
• Innovation-based 
• Requires investment (venture capital) 
• High risk, high reward 
• Rapid expansion mindset 
3. Social Entrepreneurship 
What it is: 
Businesses built to solve social, environmental, or community problems. 
Examples: 
• NGOs offering sustainable solutions 
• Startups providing education access 
• Eco-friendly product companies 
Characteristics: 
• Purpose-driven 
• Focus on societal impact instead of only profit 
• Often supported by grants or donations 



 
 

 
 

4. Large Company Entrepreneurship 
What it is: 
Large companies create new products, enter new markets, or innovate like startups. 
Examples: 
• Google launching new tools 
• PepsiCo introducing new product lines 
• Jazz or Telenor launching new digital services 
Characteristics: 
• Big resources and teams 
• Driven by competition and changing markets 
• Structured innovation processes 
5. Innovative Entrepreneurship 
What it is: 
Entrepreneurs who introduce completely new ideas or technologies. 
Examples: 
• Inventors 
• Tech innovators 
• Designers creating unique product solutions 
Characteristics: 
• Creative, forward-thinking 
• High risk but high potential 
• Focus on invention and disruption 
6. Hustler Entrepreneurship 
What it is: 
Entrepreneurs who start small and work extremely hard to grow step by step. 
Examples: 
• A freelancer growing into an agency 
• A small shop turning into a chain 
• A digital designer building a brand over years 
Characteristics: 
• Determination 
• Gradual growth 
• High personal effort 



 
 

 
 

Which Type Suits You? 
Depending on the business idea, one model may be a better fit: 
Business Idea Best Type of Entrepreneurship 
Freelance graphic design Small business / Hustler 
Launching a mobile app Scalable startup 
Selling eco-friendly 
products Social / Small business 

Opening a fast-food chain Small or large company 
entrepreneurship 

Creating a unique tech 
tool Innovative entrepreneurship 

Watch / Learn 
• Types of Entrepreneurship Explained Simply 
https://www.youtube.com/watch?v=0x85Zl-pjC0  
• Small Business vs Startup – What’s the Difference? 
https://www.youtube.com/watch?v=O-1ZfU2RrX4  
• Understanding Social Entrepreneurship 
https://www.youtube.com/watch?v=TxD8qKjJjgo  
 

LU 5.2.3:  
Business Idea 
Generation 

Trainee will be able to: 
• Explain the importance of 

generating creative and 
practical business ideas. 

• Apply methods for 
brainstorming and identifying 
business opportunities. 

• Evaluate ideas based on 
feasibility, market demand, and 
resources. 

• Develop at least one potential 
business idea individually or in 
groups. 

Generating business ideas is the first and most important step in entrepreneurship. A 
strong idea is practical, meets a need, and can realistically be executed with available 
resources. In this unit, learners explore creative methods to generate, evaluate, and 
refine business ideas. 
1. Why Business Idea Generation Matters 
A successful business starts with a clear, useful, and marketable idea. 
Good idea generation helps you: 
• Identify real-world needs 
• Create solutions people are willing to pay for 
• Reduce business failure risks 
• Plan a practical pathway for starting a business 
2. Methods for Business Idea Generation 
A. Brainstorming 

https://www.youtube.com/watch?v=0x85Zl-pjC0
https://www.youtube.com/watch?v=O-1ZfU2RrX4
https://www.youtube.com/watch?v=TxD8qKjJjgo


 
 

 
 

A free-thinking process where you write down all ideas without judging them. 
Tips: 
• Work individually or in groups 
• Encourage creativity 
• Avoid criticism during idea collection 
B. Problem-Solving Approach 
Look for common problems around you and design solutions. 
Examples: 
• Students want affordable design services → Start a mini design studio 
• Local businesses lack digital presence → Social media management service 
C. Market Observation 
Observe trends, consumer behavior, and unmet needs. 
Examples: 
• Rise in e-commerce → Product photography 
• Growing startups → Logo design and branding services 
D. Skills & Passion Mapping 
Generate ideas based on what you already know or enjoy. 
Example for Graphic Designers: 
• T-shirt design 
• Poster and banner printing 
• Social media branding packages 
E. SCAMPER Technique 
A structured idea-generation tool: 
• Substitute 
• Combine 
• Adapt 
• Modify 
• Put to another use 
• Eliminate 
• Rearrange 
3. Evaluating Business Ideas 
After generating ideas, evaluate them using these criteria: 
A. Feasibility 



 
 

 
 

Is it realistic? Do you have the skills, tools, and time? 
B. Market Demand 
Will people pay for it? Is there a clear audience? 
C. Competition 
Are there too many similar businesses? Can you offer something better? 
D. Resources 
Do you have the required money, equipment, and support? 
E. Profitability 
Can the idea earn enough to sustain the business? 
4. Practical Classroom Activity 
Individual Task: 
Write down 5 ideas based on your skills and passions. 
Evaluate them using the criteria above. Select 1 final idea. 
Group Task: 
In groups of 3–5, conduct a brainstorming session. 
Each member presents one idea. 
Group selects the best idea and explains why. 
5. Sample Business Ideas for Graphic Design Trainees 
• Social media content creation service 
• Logo design and brand identity packages 
• Resume and CV design studio 
• Custom t-shirt and merchandise design 
• Event poster and banner design 
• Product photography + design bundle 
• Digital marketing and design combo service 
Watch / Learn 
• How to Generate Business Ideas 
https://www.youtube.com/watch?v=HiZf6QJ-1Kc  
• Turn Your Skills Into a Business 
https://www.youtube.com/watch?v=XT2fH8n2R44  
• SCAMPER Method Explained 
https://www.youtube.com/watch?v=dJIGX0rB3J8  
 

https://www.youtube.com/watch?v=HiZf6QJ-1Kc
https://www.youtube.com/watch?v=XT2fH8n2R44
https://www.youtube.com/watch?v=dJIGX0rB3J8


 
 

 
 

LU 5.2.4: 
Business 
Planning and 
Strategy 

Trainee will be able to: 
• Explain the importance of 

business planning for 
entrepreneurs. 

• Identify the key components of 
a simple business plan. 

• Understand basic strategies for 
launching and growing a 
business. 

• Develop a mini business plan 
for a selected idea. 

A business plan is a roadmap that guides entrepreneurs from idea to execution. It 
helps clarify goals, organize resources, identify risks, and plan strategies for launching 
and growing a business. This unit provides a simple, practical approach to planning for 
beginners. 
1. Why Business Planning Is Important 
A clear business plan helps entrepreneurs: 
• Understand the business idea in detail 
• Identify customers, competitors, and market trends 
• Plan finances and resources effectively 
• Reduce risks and avoid common startup mistakes 
• Communicate the business idea to partners, investors, or clients 
A good business plan increases the chances of success and gives direction during the 
early stages. 
2. Key Components of a Simple Business Plan 
Beginners do not need a long or complicated plan. A one-page or mini business 
plan is enough to start. 
A. Business Idea Summary 
A short explanation of what your business does and why it is valuable. 
B. Target Audience 
Who will buy your product or service? 
Examples: students, small businesses, startups, local shops, etc. 
C. Problem & Solution 
Identify the problem your customers face and how your business solves it. 
Example: 
Problem: Local shops lack attractive posters. 
Solution: Affordable poster and banner design services. 
D. Products or Services Offered 
List what you will sell. 
Examples for design trainees: 
• Logo design 
• Social media posts 
• Flyers and brochures 
• Branding packages 



 
 

 
 

E. Pricing Strategy 
Decide how much you will charge. 
Common pricing models: 
• Per project 
• Per hour 
• Package-based 
F. Competitor Analysis 
Identify existing businesses offering similar services. 
Ask: 
• What do they do well? 
• What can you do differently or better? 
G. Required Resources 
List what you need to start. 
Examples: laptop, design software, internet, phone, sample portfolio. 
H. Marketing Strategy 
Explain how you will promote your business. 
Examples: 
• Facebook page 
• Instagram portfolio 
• WhatsApp marketing 
• Fiverr/Upwork gig optimization 
I. Financial Plan 
Basic estimates: 
• Start-up costs 
• Expected monthly income 
• Expected monthly expenses 
• Profit forecast 
3. Basic Strategies for Launching & Growing a Business 
A. Start Small 
Begin with one or two services and expand gradually. 
B. Use Branding 
Create a logo, consistent colors, and a clean portfolio to build credibility. 
C. Build Customer Trust 



 
 

 
 

Deliver high-quality work, maintain communication, and meet deadlines. 
D. Offer Packages 
Examples: 
• Social media monthly package 
• Branding bundle (logo + stationery) 
Packages make services easier to sell. 
E. Use Online Platforms 
Create visibility through: 
• Facebook Page 
• Instagram 
• LinkedIn 
• Fiverr & Upwork 
F. Learn from Feedback 
Adjust your services, pricing, and workflow based on customer responses. 
4. Activity: Create a Mini Business Plan 
Step-by-Step Exercise 
Select one idea from the previous unit (5.2.3). 
Create a one-page business plan including: 

1. Business name 
2. Business idea summary 
3. Target audience 
4. Problem + solution 
5. Services to offer 
6. Pricing strategy 
7. Marketing plan 
8. Required resources 
9. 1-month growth goal 

Students can present their business plans in class for evaluation. 
Watch / Learn 
• Business Plan for Beginners – Step-by-Step Guide 
https://www.youtube.com/watch?v=Fqch5OrUPvA 
• How to Start a Small Business with No Money 
https://www.youtube.com/watch?v=ayD3lXJxGk8  

https://www.youtube.com/watch?v=Fqch5OrUPvA
https://www.youtube.com/watch?v=ayD3lXJxGk8


 
 

 
 

• Marketing Strategies for Small Businesses 
https://www.youtube.com/watch?v=wGDW5pZ1eJc  
 

LU 5.2.5: 
Financing 
Business 

Trainee will be able to: 
• Explain why financing is 

important for starting and 
running a business. 

• Identify different sources of 
business financing. 

• Understand the difference 
between debt and equity 
financing. 

• Create a simple financial plan 
for a business idea. 

Financing is one of the most important parts of starting and running a business. Even 
small businesses need money to launch products, buy equipment, market their 
services, and manage operations. This unit helps trainees understand where business 
money comes from, how to choose the right financing method, and how to plan basic 
financial needs. 
1. Why Financing Is Important 
Every business—big or small—needs money for: 
• Purchasing tools, equipment, or raw materials 
• Renting or setting up a workspace 
• Marketing and advertising 
• Paying bills and operational costs 
• Hiring people or outsourcing work 
• Expanding services or products 
Without proper financing, even a good business idea can fail. Proper financial planning 
ensures stability and growth. 
2. Sources of Business Financing 
There are many ways to finance a business. Trainees should choose based on the 
size, stage, and nature of their business. 
A. Personal Savings 
• Most common and safest for beginners 
• No need to repay anyone 
• Good for small design or service-based startups 
B. Family & Friends 
• Borrowing small amounts 
• Usually interest-free 
• Requires trust and clear agreements 
C. Bank Loans 
• Larger financing option 
• Must repay with interest 
• Requires documents, guarantees, or business record 

https://www.youtube.com/watch?v=wGDW5pZ1eJc


 
 

 
 

D. Microfinance Institutions (MFIs) 
Examples: Akhuwat, Khushhali Microfinance, NRSP 
• Easy to access 
• Small loans for small businesses 
• Lower requirements than banks 
E. Government Grants / Schemes 
Examples (Pakistan-based): 
• Kamyab Jawan Program 
• NAVTTC entrepreneurship support 
• SMEDA programs 
These often offer low-interest or interest-free loans. 
F. Crowdfunding 
• Raising money online through platforms 
• Useful for creative or social projects 
G. Angel Investors or Venture Capital 
• Investors provide money in exchange for business shares 
• Usually for technology or high-growth startups 
3. Debt Financing vs Equity Financing 
Understanding the difference helps entrepreneurs choose wisely. 
A. Debt Financing 
You borrow money and return it later with interest. 
Examples: bank loans, microfinance, borrowing from family. 
Pros: 
• Full ownership stays with you 
• Predictable repayment schedule 
Cons: 
• Must repay even if business is slow 
• May require collateral or documents 
B. Equity Financing 
You give a share of your business to someone who invests money. 
Pros: 
• No loan repayment 
• Investor may provide guidance and connections 



 
 

 
 

Cons: 
• You share profits 
• You lose some control over decisions 
Beginners often start with personal savings, small loans, or grants rather than 
giving up ownership. 
4. Creating a Simple Financial Plan 
A mini financial plan helps estimate how much money is needed to start and operate 
the business. 
Step 1: Calculate Start-up Costs 
List everything needed to begin. 
Example for a graphic design startup: 
• Laptop 
• Design software / subscriptions 
• Internet 
• Branding materials (logo, business card) 
Step 2: Estimate Monthly Operating Costs 
• Internet bill 
• Electricity 
• Marketing budget 
• Software renewal 
• Transport 
Step 3: Estimate Monthly Revenue 
Predict how much you will earn from services. 
Example: 
• 5 logo design projects × Rs. 3,000 = Rs. 15,000 
• 10 social media posts × Rs. 500 = Rs. 5,000 
Step 4: Calculate Profit 
Profit = Total Revenue – Total Expenses 
This helps determine if your business is financially viable. 
Step 5: Identify Funding Sources 
Choose whether you will use: 
• Personal savings 
• Small loan 



 
 

 
 

• Microfinance 
• Family support 
A simple financial plan keeps your business realistic and manageable. 
Watch / Learn 
• Financing for Small Businesses – Basics Explained 
https://www.youtube.com/watch?v=IeV1CkX7Kjg  
• Business Funding Options for Beginners 
https://www.youtube.com/watch?v=YpM3Aa9KqNE  
• Debt vs Equity Financing – Simple Explanation 
https://www.youtube.com/watch?v=9mVjA0RduCM  
• How to Create a Simple Financial Plan for Your Startup 
https://www.youtube.com/watch?v=5kUl5lAe-Rc  
 

LU 5.2.6: 
Entrepreneurshi
p Challenges 
and Possible 
Solutions 

Trainee will be able to: 
• Identify common challenges 

faced by entrepreneurs. 
• Explain how these challenges 

affect business success. 
• Propose practical solutions to 

overcome entrepreneurial 
challenges. 

• Build resilience and problem-
solving skills as future 
entrepreneurs. 

Entrepreneurship is exciting, but it also comes with challenges that can affect the 
growth and success of a business. New entrepreneurs often face issues related to 
finance, competition, marketing, customer management, and personal stress. 
Understanding these challenges early helps trainees prepare better and develop 
strong problem-solving skills. This unit focuses on common entrepreneurial challenges 
and offers practical strategies to overcome them. 
1. Common Challenges Faced by Entrepreneurs 
A. Lack of Capital (Insufficient Funds) 
Many businesses struggle because they do not have enough money to start, run, or 
grow their operations. 
B. High Competition 
New businesses face strong competition from established brands and other startups 
offering similar products or services. 
C. Limited Market Knowledge 
Entrepreneurs may not fully understand their target audience, market needs, or 
industry trends. 
D. Poor Time Management 
Balancing marketing, finance, operations, and customer management can overwhelm 
beginners. 
E. Difficulty in Getting Customers 

https://www.youtube.com/watch?v=IeV1CkX7Kjg
https://www.youtube.com/watch?v=YpM3Aa9KqNE
https://www.youtube.com/watch?v=9mVjA0RduCM
https://www.youtube.com/watch?v=5kUl5lAe-Rc


 
 

 
 

Attracting customers, building trust, and convincing people to try a new business is 
often challenging. 
F. Lack of Business Skills 
Skills such as marketing, budgeting, branding, and communication are essential but 
not always well-developed in new entrepreneurs. 
G. Fear of Failure & Stress 
Entrepreneurs often experience self-doubt, pressure, and stress due to risks and 
uncertainty. 
2. How These Challenges Affect Business Success 
These challenges can create obstacles such as: 
• Slow business growth 
• Financial losses 
• Poor customer retention 
• Low motivation and burnout 
• Poor decision-making 
• Weak business performance 
• Eventually, business failure if not handled properly 
Recognizing the impact helps entrepreneurs take these challenges seriously and plan 
ahead. 
3. Practical Solutions to Overcome Entrepreneurial Challenges 
A. Managing Limited Funds 
• Start small—grow step by step 
• Use low-cost tools (e.g., Canva, free marketing platforms) 
• Apply for microfinance or government grants 
• Track income and expenses regularly 
B. Handling Competition 
• Offer unique value (better design, better quality, faster delivery) 
• Study competitors to learn what they offer and how to improve 
• Focus on a niche instead of trying to serve everyone 
C. Improving Market Understanding 
• Conduct surveys or polls 
• Engage with potential customers online 



 
 

 
 

• Research similar businesses and successful strategies 
• Test ideas before launching full-scale services 
D. Strengthening Time Management 
• Use daily schedules or productivity apps 
• Set priorities (important vs urgent tasks) 
• Divide tasks into smaller, manageable steps 
E. Attracting and Keeping Customers 
• Use social media marketing 
• Offer promotions or discounts for first-time buyers 
• Provide excellent customer service 
• Ask satisfied clients for reviews or referrals 
F. Building Business Skills 
• Take short online courses 
• Learn from mentors or successful entrepreneurs 
• Practice communication and negotiation regularly 
G. Overcoming Fear & Stress 
• Set realistic goals 
• Celebrate small achievements 
• Talk to mentors or peers for guidance 
• Build resilience by learning from setbacks instead of quitting 
4. Building an Entrepreneurial Mindset 
An entrepreneur must develop qualities such as: 
• Persistence 
• Problem-solving skills 
• Adaptability 
• Creativity 
• Confidence 
• Discipline 
These traits help in facing challenges and finding solutions effectively. 
Watch / Learn 
• Top 10 Challenges Entrepreneurs Face and How to Overcome Them 
https://www.youtube.com/watch?v=RXK8VxBlnZg  

https://www.youtube.com/watch?v=RXK8VxBlnZg


 
 

 
 

 
Module 5.3: Environment Session 
Objective: Build awareness of environmental issues, hazards, and climate change while learning sustainable practices and ways 
individuals can contribute to environmental protection. 
 

• How to Deal with Fear of Failure as an Entrepreneur 
https://www.youtube.com/watch?v=VYJx6Qlnk6E  
• Time Management Tips for Entrepreneurs 
https://www.youtube.com/watch?v=8VdG8e0T5Kk  
• Understanding Your Market – Basics for Beginners 
https://www.youtube.com/watch?v=W4G7Pnh-k5U  
• Free Course: “Entrepreneurial Mindset” – Coursera 
https://www.coursera.org/learn/entrepreneurial-mindset 
 

Learning Unit Learning Outcomes Handouts/ Learning Materials 
LU 5.3.1: 
Introduction to 
Environmental 
Issues 

Trainee will be able to: 
• Define environmental issues 

and explain why they matter for 
communities and businesses. 

• Identify common local and 
global environmental problems. 

• Recognize the role individuals 
and entrepreneurs can play in 
reducing environmental impact. 
 

Environmental awareness is an essential part of creating safe, healthy, and 
sustainable communities. In this module, trainees learn how environmental issues 
affect daily life, workplaces, and long-term well-being. Understanding these issues 
encourages responsible behavior and supports environmentally friendly practices at 
home, in training environments, and in future jobs. 
Why Environmental Issues Matter 
Environmental issues influence the quality of air we breathe, the water we drink, and 
the spaces where we live and work. When pollution increases or natural resources are 
misused, communities face more health risks, unsafe surroundings, and reduced 
productivity. 
Simple examples include smoke from vehicles, open garbage dumping, unsafe 
drinking water, and cutting down trees. These problems do not just harm nature; they 
directly affect people’s health, comfort, and economic stability. 
For businesses and entrepreneurs, being environmentally responsible builds trust and 
shows commitment to sustainability, which is increasingly valued by customers. 
Common Local and Global Environmental Problems 
Local issues often include: 

https://www.youtube.com/watch?v=VYJx6Qlnk6E
https://www.youtube.com/watch?v=8VdG8e0T5Kk
https://www.youtube.com/watch?v=W4G7Pnh-k5U
https://www.coursera.org/learn/entrepreneurial-mindset


 
 

 
 

• Improper waste disposal and littering 
• Air pollution from traffic and factories 
• Contaminated drinking water 
• Noise pollution in crowded areas 
• Loss of trees and green spaces 
Global issues include: 
• Climate change and global warming 
• Melting glaciers and rising sea levels 
• Ocean pollution, especially plastic waste 
• Wildlife habitat destruction 
• Decreasing biodiversity 
Recognizing these issues helps trainees understand how individual actions can 
contribute to larger environmental challenges. 
Role of Individuals and Entrepreneurs 
Everyone can help reduce environmental impact through simple daily habits. Trainees 
can conserve electricity, reduce plastic use, sort waste, reuse materials, and avoid 
burning trash. Entrepreneurs can adopt sustainable materials, reduce waste in 
production, save energy, and use eco-friendly packaging. 
Small actions, when repeated consistently, lead to meaningful environmental 
improvements. 
Helpful Free Videos / Online Resources 
What Are Environmental Issues? 
Basic introduction to common environmental problems. 
https://www.youtube.com/watch?v=KuyrKTSQh2s  
Local & Global Environmental Challenges 
Helps learners understand environmental issues at different levels. 
https://www.youtube.com/watch?v=ZTruW2u8xxE  
Simple Eco-Friendly Habits 
Practical tips for reducing environmental impact in daily life. 
https://www.youtube.com/watch?v=PZL2xJeJ1M4  
Summary 
Environmental issues affect health, safety, and economic well-being. By learning how 
local and global problems are connected, trainees develop awareness and 

https://www.youtube.com/watch?v=KuyrKTSQh2s
https://www.youtube.com/watch?v=ZTruW2u8xxE
https://www.youtube.com/watch?v=PZL2xJeJ1M4


 
 

 
 

responsibility. Small habits—such as saving energy, reducing waste, and choosing 
reusable materials—help protect the environment and promote sustainable living. This 
learning unit prepares trainees to make environmentally conscious decisions in both 
personal and professional settings. 
 

LU 5.3.2:  
Types of 
Environmental 
Hazards 

Trainee will be able to: 
• Define environmental hazards 

and explain their impact on 
people, businesses, and 
communities. 

• Identify different types of 
environmental hazards with 
local and global examples. 

• Recognize how businesses and 
individuals can reduce risks 
from these hazards. 

Environmental hazards are conditions in the environment that can harm people, 
property, or the natural ecosystem. Understanding these hazards helps trainees stay 
safe, make informed decisions, and support healthier communities. Both individuals 
and businesses play an important role in reducing risks and preventing damage 
caused by environmental hazards. 
What Are Environmental Hazards? 
Environmental hazards are events or conditions that negatively affect human health, 
surroundings, or economic activity. These hazards can be natural—like floods or 
earthquakes—or human-made—such as chemical pollution or waste mismanagement. 
Their impact can range from health issues and damaged infrastructure to long-term 
environmental degradation. 
Businesses must also understand these hazards because they affect operations, 
supply chains, and community reputation. Awareness prepares organizations to adopt 
safe, sustainable practices. 
Types of Environmental Hazards 
1. Natural Hazards 
These hazards occur naturally and often affect large populations. 
Examples include: 
• Floods and heavy rainfall 
• Earthquakes 
• Landslides in hilly areas 
• Heatwaves and extreme temperatures 
• Storms and droughts 
These hazards can damage property, interrupt daily life, and affect local economies. 
2. Biological Hazards 
These involve organisms or substances that threaten human health. 
Examples include: 
• Contaminated water or food 



 
 

 
 

• Viruses and bacteria causing diseases 
• Improper waste disposal attracting insects or animals 
Such hazards spread quickly in crowded or unsanitary areas. 
3. Chemical Hazards 
These arise from industrial processes, household chemicals, or agricultural activities. 
Examples include: 
• Air pollution from vehicles or factories 
• Chemical spills and leakage 
• Pesticides and fertilizers 
• Improper handling of cleaning products 
Chemical hazards can cause long-term health problems if not managed properly. 
4. Physical Hazards 
These are environmental conditions that pose a risk without necessarily touching the 
body. 
Examples include: 
• Excessive noise from machinery or traffic 
• Radiation 
• Unsafe building conditions 
• Poor lighting or ventilation 
Physical hazards affect comfort, safety, and productivity. 
5. Human-Made or Anthropogenic Hazards 
These hazards result directly from human actions. 
Examples include: 
• Industrial waste and pollution 
• Deforestation 
• Open garbage dumping 
• Overuse of natural resources 
Such hazards damage ecosystems and contribute to climate change. 
Reducing the Risks 
Individuals and businesses can reduce environmental hazard risks through simple and 
responsible actions: 
• Proper waste disposal and recycling 
• Using eco-friendly materials 



 
 

 
 

• Planting trees and protecting green spaces 
• Conserving water and energy 
• Following safety guidelines and using protective equipment in workplaces 
• Regular maintenance of machinery and electrical systems 
These preventive measures protect health, reduce economic losses, and build safer 
communities. 
Helpful Free Videos / Online Resources 
Types of Environmental Hazards Explained 
Breaks down natural, chemical, and biological hazards in simple terms. 
https://www.youtube.com/watch?v=2u8ZtS2pP5k  
Natural vs Human-Made Hazards 
A clear explanation with practical examples. 
https://www.youtube.com/watch?v=G1f2qkG5VxY  
Reducing Environmental Risks 
Tips for minimizing hazards at individual and community levels. 
https://www.youtube.com/watch?v=Jfr8c1dslZs  
Summary 
Environmental hazards come in many forms—natural, biological, chemical, physical, 
and human-made. They affect health, safety, and economic stability. By recognizing 
these hazards and adopting preventive measures, trainees can protect themselves 
and contribute to safer, more resilient communities. Businesses that understand and 
manage these risks operate more responsibly and sustainably. 
 

LU 5.3.3:  
The Impact of 
Human Activity 
on the 
Environment 

Trainee will be able to: 
• Explain how human activities 

affect the natural environment. 
• Identify both positive and 

negative impacts of human 
behavior on ecosystems. 

• Recognize the role of 
responsible practices in 
reducing environmental 
damage. 

Human activities influence the natural environment every day—sometimes in positive 
ways, but often with harmful consequences. Understanding these impacts helps 
trainees become more responsible citizens and professionals who can contribute to a 
cleaner, safer future. 
How Human Activities Affect the Environment 
The environment is shaped by how people use land, water, energy, and other natural 
resources. Everyday actions—such as transportation, farming, construction, and waste 
disposal—directly affect air quality, soil health, forests, and wildlife. 
When these activities are not managed properly, they cause pollution, climate change, 
and the loss of natural habitats. 

https://www.youtube.com/watch?v=2u8ZtS2pP5k
https://www.youtube.com/watch?v=G1f2qkG5VxY
https://www.youtube.com/watch?v=Jfr8c1dslZs


 
 

 
 

At the same time, humans also have the power to improve the environment through 
sustainable choices, conservation efforts, and responsible resource use. 
Negative Impacts of Human Activity 
Certain practices harm natural ecosystems and create long-term environmental 
problems. Examples include: 
1. Pollution 
• Factory smoke and vehicle emissions cause air pollution. 
• Plastic waste pollutes rivers and oceans. 
• Chemicals from farms contaminate soil and water. 
2. Deforestation 
Cutting trees for construction, fuel, or agriculture leads to: 
• Loss of wildlife habitats 
• Increased risk of floods and soil erosion 
• Reduced oxygen production and higher carbon levels 
3. Overuse of Natural Resources 
Excessive use of water, minerals, fuel, and land reduces future availability and harms 
ecosystems. 
4. Climate Change 
Human activities—especially burning fossil fuels—release greenhouse gases that trap 
heat and raise global temperatures, causing unpredictable weather patterns. 
5. Improper Waste Disposal 
Throwing garbage in open areas, drains, or water bodies spreads disease, pollutes 
soil, and affects community health. 
Positive Impacts of Human Activity 
Not all human actions harm the environment. Many responsible practices help protect 
and restore ecosystems, such as: 
1. Recycling and Waste Management 
Recycling materials reduces pollution and saves natural resources. 
2. Afforestation and Tree Plantation 
Planting trees improves air quality and supports wildlife. 
3. Renewable Energy Use 
Using solar panels, wind energy, and energy-efficient appliances reduces carbon 
emissions. 



 
 

 
 

4. Conservation Efforts 
Protecting forests, water bodies, and wildlife ensures environmental balance. 
5. Sustainable Agriculture 
Using organic methods and reducing chemicals improves soil health and reduces 
water contamination. 
Role of Responsible Practices 
Small, everyday decisions can significantly reduce environmental damage. Individuals, 
families, and businesses can contribute by: 
• Reducing plastic use 
• Conserving electricity and water 
• Recycling household and workplace waste 
• Following eco-friendly transportation (carpooling, walking, cycling) 
• Supporting green products and policies 
• Maintaining cleanliness in local communities 
Responsible behavior builds a healthier environment and sets an example for future 
generations. 
Helpful Free Videos / Online Resources 
How Human Activities Affect the Environment 
Explains major human actions that damage the environment. 
https://www.youtube.com/watch?v=JNfHh0YHM7Q  
Positive Human Impact on the Environment 
Shows how people can improve ecosystems through sustainable actions. 
https://www.youtube.com/watch?v=0Puv0Pss33M 
Simple Ways to Protect the Environment 
Practical, everyday steps for individuals and communities. 
https://www.youtube.com/watch?v=LVlKpRNSk8s  
Summary 
Human activities have both positive and negative effects on the environment. While 
pollution, deforestation, and waste mismanagement cause serious damage, 
responsible practices—like recycling, using renewable energy, and planting trees—
help restore and protect ecosystems. By understanding their impact, trainees can 
make better choices that contribute to a sustainable and healthy environment. 
 

https://www.youtube.com/watch?v=JNfHh0YHM7Q
https://www.youtube.com/watch?v=0Puv0Pss33M
https://www.youtube.com/watch?v=LVlKpRNSk8s


 
 

 
 

LU 5.3.4: 
Conservation 
and 
Sustainability 

Trainee will be able to: 
• Define conservation and 

sustainability in simple terms. 
• Explain why conserving natural 

resources is important for future 
generations. 

• Identify sustainable practices 
individuals and businesses can 
adopt. 

• Demonstrate small actions that 
contribute to long-term 
environmental care. 

 

Conservation and sustainability are at the heart of protecting our environment. These 
concepts guide how individuals, communities, and businesses can use resources 
wisely so that future generations can enjoy clean air, safe water, and a healthy planet. 
By understanding simple conservation methods and adopting sustainable habits, 
trainees can contribute to long-term environmental well-being. 
What Are Conservation and Sustainability? 
Conservation 
Conservation means protecting and using natural resources carefully. This 
includes water, forests, soil, air, and wildlife. The goal is to avoid waste and prevent 
permanent damage to the environment. 
Sustainability 
Sustainability means meeting today’s needs without harming the ability of future 
generations to meet theirs. It involves choosing methods and materials that do not 
destroy or exhaust natural resources. 
Both concepts help ensure environmental balance and long-term survival for plants, 
animals, and humans. 
Why Conservation Matters for Future Generations 
Future generations depend on the decisions we make today. Overuse of water, cutting 
too many trees, pollution, and wasteful lifestyles put pressure on the earth’s resources. 
If these resources run out or become damaged beyond repair, future communities will 
struggle to live healthy, safe, and productive lives. 
Conserving resources today means: 
• Protecting clean drinking water 
• Reducing air pollution and climate change 
• Keeping soil healthy for farming 
• Preserving forests and wildlife habitats 
• Ensuring energy resources last longer 
Sustainable actions today create a better world tomorrow. 
Sustainable Practices for Individuals and Businesses 
Sustainable Actions for Individuals 
Simple everyday habits make a big difference: 
• Turn off lights, fans, and appliances when not in use. 
• Use energy-efficient bulbs and devices. 



 
 

 
 

• Reduce water waste by fixing leaks and using water wisely. 
• Carry reusable bags, bottles, and containers. 
• Recycle paper, plastic, and metal waste. 
• Plant trees and participate in community clean-up drives. 
• Use public transport, walk, or cycle when possible. 
Sustainable Practices for Businesses 
Businesses also play a major role in environmental protection: 
• Adopt energy-efficient machines and renewable energy sources. 
• Reduce paper usage through digital documentation. 
• Properly dispose of industrial waste and follow environmental rules. 
• Use sustainable packaging (recyclable, biodegradable). 
• Encourage employees to follow green practices. 
• Support tree-planting and conservation initiatives. 
When individuals and businesses work together, sustainability becomes achievable 
and impactful. 
Small Actions That Make a Big Difference 
Even simple steps can create long-term positive change: 
• Unplug chargers when not in use. 
• Reuse old items creatively instead of throwing them away. 
• Compost organic kitchen waste. 
• Collect rainwater for plants or cleaning. 
• Choose products with eco-friendly labels. 
• Share awareness with friends and family. 
These everyday practices build a culture of environmental responsibility. 
Helpful Free Videos / Online Resources 
Conservation and Sustainability Explained 
A simple video explaining key concepts with examples. 
https://www.youtube.com/watch?v=1t_WJsEcyFM  
Easy Sustainable Living Tips 
Practical habits for reducing waste and saving resources. 
https://www.youtube.com/watch?v=g4U3sq4JbOs  
How Individuals and Businesses Can Help the Planet 

https://www.youtube.com/watch?v=1t_WJsEcyFM
https://www.youtube.com/watch?v=g4U3sq4JbOs


 
 

 
 

Shows actions everyone can take to protect natural resources. 
https://www.youtube.com/watch?v=xWZ4A-t1J1k  
Summary 
Conservation and sustainability ensure that natural resources are protected for future 
generations. By adopting simple, responsible habits—such as saving water, reducing 
waste, recycling, and using energy wisely—individuals and businesses can make a 
lasting positive impact. These small steps build a sustainable environment that 
supports healthy communities and a thriving planet. 
 

LU 5.3.5:  
Climate Change 
and Its Effects 

Trainee will be able to: 
• Define climate change and 

explain its causes. 
• Identify the effects of climate 

change at local and global 
levels. 

• Recognize the role of 
individuals and businesses in 
reducing climate change 
impact. 

• Propose small actions to help 
mitigate climate change. 

Understanding Climate Change 
Climate change refers to long-term changes in the Earth’s temperature and weather 
patterns. While some natural changes occur over time, today’s rapid climate change is 
mainly caused by human activities. Burning fuel, cutting trees, and releasing gases 
from industries and vehicles trap heat in the atmosphere, causing the planet to warm 
faster than it should. 
Causes of Climate Change 

• Burning fossil fuels (petrol, diesel, coal, natural gas) 
• Deforestation and land clearing 
• Industrial emissions and smoke from factories 
• Agricultural activities that release methane 
• Poor waste management and burning garbage 

These actions increase greenhouse gases in the air, leading to a rise in global 
temperature. 
Effects of Climate Change (Global and Local) 
Climate change affects every country, including Pakistan. Some of the major impacts 
include: 
Global impacts: 

• Rising temperatures around the world 
• Melting glaciers and increasing sea levels 
• More frequent storms, floods, heatwaves, and droughts 

Local impacts in Pakistan: 
• Intense heatwaves, especially in major cities 
• Erratic monsoon patterns and heavy flooding 

https://www.youtube.com/watch?v=xWZ4A-t1J1k


 
 

 
 

• Water shortages affecting homes and agriculture 
• Lower crop yield due to temperature changes 
• Health issues like heatstroke and respiratory problems 

These effects disrupt daily life, hurt businesses, and put communities at risk. 
Reducing Climate Change Risks 
Both individuals and organizations can play an important role in reducing climate 
change effects. 
Individual actions: 

• Save electricity by turning off fans and lights 
• Reduce plastic use and avoid burning waste 
• Plant trees and protect green areas 
• Use public transport or walk for short distances 

Business actions: 
• Use energy-efficient appliances 
• Manage waste properly and recycle where possible 
• Reduce paper use and adopt digital systems 
• Support environmental protection initiatives 

Small actions, when practiced consistently, help lower greenhouse gases and protect 
the planet. 
Helpful Free Videos / Online Resources 
Climate Change for Beginners 
Simple explanation of causes and effects. 
https://www.youtube.com/watch?v=3CM_KkDuzGQ 
How Human Activities Affect Climate 
Shows real examples of climate-related changes. 
https://www.youtube.com/watch?v=Vut14-lqRpo  
Local Impacts of Climate Change in South Asia 
Explains climate effects in countries like Pakistan. 
https://www.youtube.com/watch?v=zAuvvKcQ2Zk  
Summary 
Climate change is a global issue with serious local consequences. Understanding its 
causes and impacts helps trainees make responsible choices. By adopting simple 
daily habits—saving energy, reducing waste, and supporting greener practices—

https://www.youtube.com/watch?v=3CM_KkDuzGQ
https://www.youtube.com/watch?v=Vut14-lqRpo
https://www.youtube.com/watch?v=zAuvvKcQ2Zk


 
 

 
 

individuals and organizations can significantly reduce environmental damage and 
contribute to a healthier planet. 
 

LU 5.3.6:  
How to 
Contribute to 
Environmental 
Protection? 

Trainee will be able to: 
• Explain the role of individuals, 

businesses, and communities in 
protecting the environment. 

• Identify simple, practical steps 
for environmental protection. 

• Demonstrate how 
entrepreneurs can integrate 
eco-friendly practices into their 
work. 

• Commit to at least one personal 
action toward protecting the 
environment. 

Understanding Environmental Protection 
Environmental protection means taking steps to preserve natural resources, reduce 
pollution, and keep the environment healthy for future generations. Every person, 
business, and community has a role in reducing damage to the environment. By 
making conscious choices, we can protect water, air, land, and living organisms from 
harm. 
Roles of Individuals, Businesses, and Communities 
Individuals can make daily lifestyle choices that reduce pollution and waste. 
Businesses can run operations responsibly and adopt eco-friendly practices. 
Communities can work together to protect shared spaces and raise awareness. 
Each level of action contributes to long-term environmental sustainability. 
Simple Practical Steps for Environmental Protection 
Everyone—students, workers, entrepreneurs—can take small actions such as: 

• Saving electricity by switching off lights, fans, and unused appliances 
• Reducing, reusing, and recycling materials 
• Using cloth bags instead of plastic 
• Avoiding burning garbage and disposing of waste properly 
• Conserving water by fixing leaks and using water carefully 
• Planting trees and protecting plants in the neighborhood 

These habits help reduce pollution and support cleaner, healthier environments. 
Eco-Friendly Practices for Entrepreneurs 
Entrepreneurs can integrate sustainable practices into their businesses by: 

• Choosing energy-efficient equipment 
• Reducing paper use through digital systems 
• Offering products made from recycled or eco-friendly materials 
• Managing waste properly and avoiding harmful chemicals 
• Encouraging customers to adopt green habits 
• Designing services that support environmental care (e.g., repair shops, 

recycling services, organic products) 



 
 

 
 

 

Environment-friendly businesses build trust, reduce costs, and contribute to community 
well-being. 
Helpful Free Videos / Online Resources 
Simple Ways to Protect the Environment 
Shows easy actions individuals can take daily. 
https://www.youtube.com/watch?v=OqHp03RRTDs 
Eco-Friendly Business Ideas 
Explains how entrepreneurs can support sustainability. 
https://www.youtube.com/watch?v=3h4i7w5U6Ew  
Community Efforts for Environmental Care 
Highlights how groups can work together to protect the environment. 
https://www.youtube.com/watch?v=m3-yT2KwlBA  
Summary 
Environmental protection begins with simple everyday choices. Individuals, 
businesses, and communities all play important roles in creating a cleaner and safer 
environment. By saving resources, reducing waste, and adopting eco-friendly habits, 
trainees can contribute to long-term sustainability. Even one small personal 
commitment—such as reducing plastic use or saving energy—can make a meaningful 
difference. 
 

https://www.youtube.com/watch?v=OqHp03RRTDs
https://www.youtube.com/watch?v=3h4i7w5U6Ew
https://www.youtube.com/watch?v=m3-yT2KwlBA


7. Trainer Qualification Level: 
Category Qualification/Criteria 
Academic Qualification DAE/Bachelor's Degree in IT, Computer 

Science, Computer Engineering or related 
field 

Experience Minimum 2–3 years teaching or industry 
experience in IT tools & office management 

Technical Skills Proficiency in MS Office, Google 
Workspace, Windows OS, Email, Internet, 
Zoom, Google Meet, Microsoft Teams 

Instructional Skills Knowledge of Competency-Based Training 
(CBT) & Assessment; ability to deliver skill-
oriented training 

 
8. Assessment Structure: 
Since this training is fast-track & skill-oriented, therefore special mode of assessment is 
recommended as under: 
 
Component Marks Passing Criteria 
Theory (MCQs + Short Questions) 30 50% (15 marks) 
Practical (Capstone Tasks) 70 60% (42 marks) 
Total 100 To be eligible for the Certificate of 

Competency in Digital Literacy/IT Office 
Assistant, trainees must maintain at least 
75% attendance and successfully pass both 
the theory and practical components of the 
assessment. 

 
9. Recommended Books & Readings: 

• MOS Study Guide Series (Word, Excel, PowerPoint, Access) – Microsoft Press 
• Digital Literacy Curriculum – Microsoft 
• Google Workspace Learning Center (https://workspace.google.com/learning-center)  
• Microsoft Office Support & Tutorials (https://support.microsoft.com/)  
• GCFGlobal IT Skills Lessons (https://edu.gcfglobal.org/) 

  
10. Recommended Software: 

• Microsoft Office Suite (2016 or above)/Google Suits 
• Windows 10/11 
• Zoom, Google Classroom, Google Meet, Microsoft Teams 
• Antivirus (Windows Defender, Avast) 
• Adobe Reader, WinRAR 
• Typing Tutor (Typing Master, Key Blaze etc.) 

 
11. Online Resources: 

• Microsoft Office Training Center (https://support.microsoft.com/en-us/training)  
• Microsoft Digital Literacy Curriculum (https://www.microsoft.com/en-

us/digitalliteracy/home)  
• TechBoomers – Digital Skills for Beginners (https://techboomers.com/) 
• OfficeSkills.org (https://officeskills.org/) 
• Alison – Office Assistant Skills Course (https://alison.com/course/office-assistant-

skills) 
• TypingClub – Free Typing Practice (https://www.typingclub.com/) 
• AI Assistants (ChatGPT, DeepSeek etc.) 

 

https://workspace.google.com/learning-center
https://support.microsoft.com/
https://edu.gcfglobal.org/
https://support.microsoft.com/en-us/training
https://www.microsoft.com/en-us/digitalliteracy/home
https://www.microsoft.com/en-us/digitalliteracy/home
https://techboomers.com/
https://officeskills.org/
https://alison.com/course/office-assistant-skills
https://alison.com/course/office-assistant-skills
https://www.typingclub.com/


Project Management Unit 

Khyber Pakhtunkhwa Rural Economic Transformation Project 

P&D Department, Government of Khyber Pakhtunkhwa 

 
 

1 
 

KP-RETP – Component 2: Classroom SECAP Evaluation Checklist 

Purpose: 
To ensure that classroom-based skills and entrepreneurship trainings 
under KP-RETP are conducted in an environmentally safe, socially 
inclusive, and climate-resilient manner, in line with the Social, 
Environmental, and Climate Assessment Procedures (SECAP). 

 

 

 

Evaluator: _______________________ 
Training Centre / Location: _______________________ 
Trainer: _______________________ 
Date: _______________________ 
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Category  Evaluation Points       Status Remarks /Recommendation 
Yes NO 

Social 
Safeguards 

Is the training inclusive 
(equal access for 
women, youth, and 
vulnerable groups)? 

   

Does the classroom 
environment ensure 
safety and dignity for all 
participants (no 
harassment, 
discrimination, or child 
Labor)? 

   

 Are Gender 
considerations 
integrated into 
examples, discussions, 
and materials? 

   

Is the Grievance Redress 
Mechanism (GRM) 
process, along with the 
relevant contact 
number, clearly 
displayed in the 
classroom 

   

Are the Facilities and 
activities being 
accessible and inclusive 
for specially-abled 
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(persons with 
disabilities) 

Environmental 
Safeguards 

 Is the classroom clean, 
ventilated, and free 
from pollution or 
hazardous materials? 

   

Is there proper waste 
management (bins, no 
littering) 

  
 

 Are materials used in 
practical sessions 
environmentally safe 
(non-toxic paints, safe 
disposal of wastes)? 

   

 Are lights, fans, and 
equipment turned off 
when not in use (energy 
conservation)? 

   

Climate 
Resilience 

Are trainees oriented on 
how their skills link with 
climate-friendly 
practices (e.g., 
renewable energy, 
efficient production, 
recycling)? 

   

Are trainers integrating 
climate-smart examples 
in teaching content? 

   

Are basic health and 
safety measures 
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Overall remarks/ recommendations  
 
 
 
 
 
 
 
Name  Designation Signature  Date 
    

 

available (first aid kit, 
safe exits, fire safety)? 
Is the trainer using 
protective gear or 
demonstrating safe tool 
use (where relevant)? 

   

Institutional 
Aspects 

 Is SECAP awareness 
shared with trainees (via 
short briefing, posters, 
or examples)? 

   

Are trainees encouraged 
to report unsafe, unfair, 
or environmentally 
harmful practices? 

   

Overall 
Compliance  Overall SECAP 

compliance observed 

☐ High      
☐ Medium 
 ☐ Low 

 




